
SVEIN LUND:

Mu unna Linux-girjjáš
Sámegiel veršuvdna 0.5S - 07.09.2005

(Jurdda lea ahte pingvinas galgá leat gákti, jus muhtin dáiddár váldá hástálusa.)

Fuom: 
Dát lea ain dušše mu heajus sámegiella, ii oktage leat vel lohkan
korrektuvrra.   
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OVDASÁTNI
Mu unna Linuxgirjjáš / Mi vesle Linuxbok lea dihtorgeavaheami vuođđogirji. Dat lea
čállon operatiivavuogádaga Linux ovddas, muhto stuora oasit heive maiddái sidjiide geat
geavahit eará operatiivavuogádagaid. 

Dás gávnnat sihke oppalaš dihtoroahpu, beroškeahttá vuogádagas, dieđuid
operatiivavuogádaga Linux ja Skuvlalinux-prošeavtta birra ja čilgehusaid ja hárjehusaid
iešguđet geavaheaddjiprográmmain. 

Skuvlalinux lea vuosttažettiin ráhkaduvvon fierpmádaga várás, skuvllain ja
ásahusain. Dát girji lea čállon sin várás geat barget iešheanalaš dihtoriin dahje dihtoriin mat
leat čadnon fierpmádahkii. Sidjiide, geat hálidit diehtit eambbo dan birra mo ásahit
fierpmádaga, mii čujuhit eará instrukšuvnnaide, vuosttážettiin „IKT driftshandbok“, maid
sáhttá viežžat dán čujuhusas: http://www.skolelinux.org/no.

Dán girjji ovdamanni lea Mu unna dihtorgirjjáš, mii bođii vuosttaš veršuvnnas
1999:s  ja sáddejuvvui kopioriginálan sámi skuvllaide. Nubbi veršuvdna, mii oalle muddui lei
rievdaduvvon ja viiddiduvvon, almmuhuvvui interneahta bokte 2002:s.
(http://home.online.no/~sveilund/skole/dihtor.htm)
Dát girjjážat ledje dušše Windowsa várás, muhto nuppi veršuvnnas čállen ovdasánis: "Dađe
bahábut eat leat ollen dán háve addit nu ollu veahki sidjiide geat háliidit geavahit
operatiivavuogádaga Linux, muhto sávvat ahte dat boahtá boahtte veršuvnnas." Ja dás dat
viimmat boahtá.

Girji almmuhuvvo sihke (davvi)sámegillii ja (ođđa)dárogillii. Dan guovtti veršuvnnas
leat measta seamma sisdoallu, lea dušše veahá heivehuvvon bihtát mat erenoamážit gusket
sámegiella geavaheapmái.

MO GEAVAHIT GIRJJÁŽA?
Girjjáš sáhttá geavahit skuvllas - vuođđoskuvllas, joatkkaskuvllas ja rávesolbmuidoahpus
dahjege go oahppá iehčanassii.

Girjjáš lea organiserejuvvon systemáhtalaččat. Álggus gávnnat oppalaš dieđuid
dihtorgálvvuid ja operatiivavuogádagaid birra, de Linuxa vuođđodoaimmaid ja
čállinbeavdebirrasa KDE, ovdal go oahpásmuvvat muhtin prográmmaiguin maid sáhtát
geavahit Linuxas ee. teakstgieđahallamii, rehkenastimii, sárgomii ja interneahtagulahallamii. 

Ii leat jurdda ahte galggat lohkat visot álggu rájes loahpa rádjái, it ge bargat buot
bargobihtáid. Geahča sisdoallolisttu ja mana kapihttaliidda maid don dárbbašat. Teavsttas
šaddat dávjá gávdnat čujuhusaid eará kapihtaliidda, nu ahte sáhtát njuiket ovddos maŋos
teavsttas dárbbu mielde. Jus it leat geavahan Linuxa ovdal, berret dattetge geahčadit 7. ja 8.
kapihtaliid ovdal go manat muhtin geavaheaddjiprográmmii. 

Eanaš kapihtaliin gávnnat bargobihtáid teavsttas. Ii leat jurdda ahte galggat bargat
visot, dát lea ávžžuhusat maid gaskkas geavaheaddji, oahppi ja oahpaheaddji sáhttá válljet
dárbbu mielde. 

Teavsttas leat muhtin sánit čállon buoiddes bustávaiguin. Dát čujuhit juogo fáluide
maid válljet, dieđuide mat bohtet ovdan šerbmii dahje tekstii maid galggat čállit.

Čuođenáre siiddosaš girjái ii čága go iešguđetge prográmmaid vuđolaš doaimmaid.
Girji galgá veahkehit du bargagoahtit guđege prográmmas, nu ahte dus lea vuođđu ieš ohcat
eará doaimmaid, prográmma veahkedoaimmain, instrukšuvnnagirjjiin dahje interneahtas. 

Loahpas lea sátnelistu, mas leat sihke oppalaš dihtorsánit ja sánit mat leat
geavahuvvon jorgalettiin Linux-prográmmaid sámegillii. 
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SÁMEGIELA BIRRA
Dan rájes go dihtoráigi álggii lea leamaš čuolbma ahte dihtorprográmmat eai leat váldán
vuhtii sierra sámi bustávaid. Lea ferten installeret sierra prográmmažiid vai čállit sámegillii,
ja leat leamaš máŋga iešguđet čovdosat mat eai leat heiven oktii. 

Linux lei vuosttáš operatiivavuogádat mas lea integrerejuvvon sámegiella, nu ahte ii
dárbbaš installeret makkárge liigeprográmma1. Sáhttá válljet sámegiel boallobeavddi KDE
nammasaš čállinbeavdebirrasis. 

Linux lea dán rádjái áidná operatiivavuogádat mas lea vejolaš oažžut
čállinbeavdebirrasa ja muhtin geavaheaddjeprográmmaid fáluid ja gohččumiid sámegillii.
Skuvlalinuxprošeakta lea jorgalan KDE ja muhtin čállin-, rehkenastin- ja
gulahallanprográmmaid. Jus instálleret Skuvlalinuxa oaččut muhtin prográmmaid sámegillii,
muhto lea vejolaš ahte oaččut ođđaset jorgaleami jus installeret ođđaset KDE-veršuvnna.

GIITU
Bargadettiin girjjiin lean ávkkáštallan ollu girjjiid ja čilgehusaid mat leat interneahtas.
Gávnnat dáid gálduid ja vel earáid girjjálašvuođalisttus girjji loahpas. 

Børre Gaup, Basia Głowacka, Trond Trosterud ja Gard E. Abrahamsen leat addán
hui dehálaš fágalaš veahki ja kritihka, ja sii leat maiddái čállán muhtin kapihttaliid dahje
bihtáid álgoevttohusaid. 

Giittán Sámi fágagirječálliid ja jorgaleddjiid searvvi, mii lea juolludan munnje
stipeandda dán girjjáža čállimii.

Dás galggašin giitit sin, geat leat juolludan ruđa girjji prentemii, muhto ii oktage leat
vel dahkan dan, ja danin girji boahtá dán háve dušše fal interneahtaveršuvnnas. Sáhttá
viežžat dan pdf-formáhtas dahje OpenOffice-formáhtas (sxw), ja sii geat háliidit sáhttet
friddja ja nuvttá čálihit ja máŋget viiddáseappot, omd. skuvlageavaheapmái. Mu áidna
sávaldat dan oktavuođas lea ahte vejolaš geavaheaddjit čállet munnje ja muitalit ahte
geavahit girjji.

Lea sihkkarit ollu maid berre buoridit boahtte veršuvnnas. Jus dus leat jurdagat ja
evttohusat, sáhtát dieđihit deike: sveilund@online.no

1 Integrerejuvvon sámegiella bođii Linuxii 2002:s. Windowsii bođii easká 2004:s, prográmmapáhkain XP
Servicepack 2.
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1. MAŠIIDNAGÁLVU 
1.1. MÁŊGALÁGÁN DIHTORAT
Jus oaččut gážaldaga dieđát go mii dihtor dahje datamašiidna lea, soaittát vástidit:
"Dieđusge". Muhto geahččal dal čilget mii dat lea ja čále iežat definišuvnna dása:

________________________________________________________________________

________________________________________________________________________

Jáhkimis fuobmájit ahte ii lean nu álki. Mii eat áiggo buktit makkárge fasitvástádusa dáppe,
muhto doaivvumis dieđát eambbo dan birra go leat lohkan dán girjji.

Dihtorteknologiija lea min áiggis measta juohke sajis. Dus soaitá leat kalkulahtor. Dat lea
unna dihtoraš, mas lea boallobeavdi (tastatur / keyboard), "vuoiŋŋamaččat" (doaimmár,
prosessor) mat rehkenastet du gohččumiid mielde ja šearbma (monitor) gos oainnát bohtosa. 

Lea go dus báŋkokoarta ruhtaburssas? Dat lea maiddái čadnon datateknologiijii,
seamma lea omd. telefonkoarta, muhtin girjerádjosiid luoikkahankoarttat ja gávperáidduid
miellahttokoarta/rabáhttakoarta. Dihtorteknologiija lea mobiltelefuvnnain, digitála
govvenapparáhtain, ođđa biillain ja máŋgalágán instrumeanttain. 

Dán girjjis galgat vuosttažettiin iskat dakkár dihtora mii gohčoduvvo persovnnalaš
dihtorin, dahje eŋgelasgillii personal computer, PC. Doaba PC:in galggai álggos erohit unna
dihtoriid stuora mašiinnaid (“mainframe”) ektui, mat ledje anus industriijas, rehketdoalus ja
dutkamis. Dađistaga go dihtoroasit leat unnon ja dihtora nákca sturron, lea maiddái erohus
unnon PC:aid ja stuoramašiinnaid gaskkas.

Doaba PC lea maiddái geavahuvvon moatti mearkkášumiin. Dávjá dat čilge dihtoriid
mat leat ng. IBM-kompatibel, Macintosh.dihtoriid ektui. Muhtimat váldet mátkedihtoriid
mielde PC-doahpagii, earát fas geavahit PC dušše fal stašunára dihtoriid birra. Lea váttis
dadjat ahte muhtin definišuvdna lea riekta ja nubbi fas boastut.

PC-at sáhttet juogo leat iešheanalaš mašiinnat dahje oassin fierpmádagas.
Fierpmádagas dihtor lea unnit dahje eanet sorjevaš muhtin guovddáš dihtorii (bálvá, server).
PC:s lea dábálaččat stuora boksa, man siste lea doaimmár (proseassor), muitu, garraskearru,
diskeahttastašuvdna ja/dahje CD-stašuvdna ja koarttat maiguin gulahallat eará
ovttadagaiguin. Šearbma, boallobeavdi ja sáhppán leat čádnon dan boksii johtasiiguin.
Muhtin ođđa dihtoriin sáhttá muhtin johtasiid sádjái leat árpohis oktavuohta.

Mátkedihtoriin (sálládihtor, guoddehahtti dihtor, laptop) lea boallobeavdi ja šearbma
seamma kássas go proseassor, muitu, garraskearru jna. Sáhpána sadjái sáhttá leat eará
stivrenovttadat; nugo “trackball” dahje “trackpad”. Dattetge lea vejolaš jus háliida čatnat
maiddái mátkedihtorii sáhpána ja maiddái sierra šearpma.

Vel ođđasit molsaeaktu lea ng. giehtadihtorat (palmtop). Dain eai leat buot doaimmat
mat dábálaš PC:as lea. Unnimusaide ii čaga albma boallobeavdi, nu ahte ferte juogo čállit
boallobeavdái muhtin sákkiin dahje čállit njuolga šerbmii.

1.2. MÁŊGALÁGÁN MAŠIIDNAGÁLVUT
Mii mannat ruovttoluotta dihtora meroštallamii, man birra jearaimet álggos. 

Juo 1800-logu gaskamuttus ovddidii Charles Babbage dihtora teorehtalaš vuođu,
muhto dalle ii gávdnon teknologiija mainna čađahit teoriijaid. Son meroštalai maid dákkár
mašiidna galggai sisttisdoallat:2

2 Gáldu: http://www.ifi.uib.no/undervisning/INFO100/INFO100_H2003_03a.ppt
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- Sisa- ja olggos- ovttadat (input/output device)
- “Juoga” mii stivre mašiinna
- Vuorka masa vurket gaskabohtosa ja loahpalaš bohtosa (store)
- Ovttadat maiguin rehkenastit (mill)
- Čállinovttadat (printing device)
Dát heive bures oktii otná dihtoriiguin. Dát “juoga” masa Babbage ii gávdnan sáni, mii
gohčodit otne prográmman (software). Eará diŋggat maid Babbage namahii leat deháleamus
sisdoallu das maid mii otne gohčodit mašiidnagálvun (hardware).

Mašiidnagálvu lea visot maid sáhtát sihke oaidnit ja guoskkahit. Eará ođđaáigásaš
meroštallan lea ahte hardware lea dan masa mii sáhttit čikčet go software ii doaimma. (Mii
eat sáhte ávžžuhit geavahit dan vuogi.)  
  
 Dá leat muhtun dehálaš dihtoroasit ja dihtorbiergasat:

Makkár Sámegillii Dárogillii Eŋgelasgillii
siste: prosessor prosessor processor

muitu minne memory
rájus: garraskearru platelager / harddisk harddisk

  diskeahtta
diskett floppy disk

báddi band tape

  CD - skearru
CD - plate CD - Compact Disk3

USB USB USB-drive, pendrive
DVD DVD DVD - Digital Video Disk

sisa:

  boallobeavdi

tastatur keyboard

  sáhpán
mus mouse

stivrensággi styrespak joystick
dovddan føler sensor

  mikrofuvdna
mikrofon microphone

  digitála
govvenapparáhta

digitalt fotoapparat digital camera

  govvalohkki, skanner
bildeleser, skanner scanner

sáhcokodalohkki strekkodeleser bar code scanner
olggos:

   šearbma
skjerm monitor

   čálán
skriver printer

jietnakoarta / skájan lydkort / høyttaler sound card / loudspeaker
CNC jurssan/ várve CNC fresemaskin /dreiebenk CNC - milling machine /

lathe
sárggon plotter plotter

sisa /
olggos   modem

modem modem

3 Álggos lei dušše CD-ROM, Compact Disk - Read Only Memory, mas geavaheaddji sáhttá lohkat, muhto masa
ii sáhte vurket. Dál gávdno maid CD-R, Recordable, masa geavaheaddji sáhttá oktii vurket, ja CD-RW masa
geavaheaddji sáhttá máŋgii vurket ja sihkkut, nugo diskeahtas.
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fierpmádatkoarta nettverkskort network card
ISDN-koarta ISDN-kort ISDN-card

Bargobihttá: Dát listu ii leat ollislaš ja oba áigi ovddiduvvo ođđa mašiidnagálvvu. Dieđát go
eará mašiidnagálvvuid?

1.3. DOAIMMÁR
Doaimmár dahje prosessor lea dihtora "vuoiŋŋamasat". Dat rehkenastá ja čađaha buot
gohččumiid maid mii sáddet dihtorii. Doaimmár gohčoduvvo maiddái CPU - Central
Processing Unit. Deháleamus mihttu mii muitala doaimmára doaimma birra lea frekveansa.
Dat muitala galle operašuvnna dat sáhttá dahkat sekunddas. Doaimmára leaktu lea ovddidan
hui jođánit. 1990-logu álggos sáhtii dábálaš doaimmára frekveansa leat 25 MHz4, 2005 lea
juo dábálaš ahte ođđa dihtora doaimmáris lea 2-4 GHz. 

Leat máŋga dihtorbuvttadeaddji máilmmis, muhto eai leat nu galle fitnodaga mat
ráhkadit doaimmáriid. Dovddasepmosiid gaskkas leat Intel, Motorola ja AMD. Vuosttaš
fitnodat mii ráhkadii mikrodoaimmáriid lei Intel, ja dan namahusat, nugo 8088, 286, 386,
486 šadde muhtinlágán eahpeoffisiála standarda. 1993 rájes Intel heittii geavaheames dákkár
nummáriid ja ođđa doaimmár gohčoduvvui Pentium, mas lea juo moadde buolvva. Dál
doaimmárat earohuvvojit vuostažettiin frekveanssa mielde.
  

Go stuora doammár bargá, ovddida báhka. Danin ferte čoaskudit. Gurut bealde govas
lea Pentium II-proseassor mas lea boson. Jus dihtoris ozat doaimmára, lea vejolaš ahte
it oainne dan, dan dihte go lea čihkkon bosona duohkái, nugo olggeš bealdde govas.
(Govva: SL)

1.4. MUITU
Dihtoris leat moaddelágan muittut. Dábálaččat go hupmat muittu birra, de jurddašit
gaskabottosaš muittu, mii gohčoduvvo RAM - Random Access Memory. Dát lea vuorká mii

4 1 MHz = 1 mega-hertz = 1 000 000 svingningar sekunddas, 1 GHz = 1 000 000 000 svingningar sekunddas 
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doaibmá dušše dan botta go dihtoris lea el-rávdnji. Jus jaddadat dihtora, de visot mii lea
muittus jávká. Dán muittus lea dat, maid sáhtát oaidnit šearmmas, ja doaibmi oasit
prográmmain maid geavahat juste dál. 

Muitu mihttiduvvo megabytiin (MB), ja dađistaga velá gigabytiin (GB). Ođđa
prográmmat ja doaimmat gáibidit jamma eanet muittu. 1990-logu álggos lei dábalaš PC:s 1-2
MB RAM, 2005 lea ođđa dihtoriin dábálaččat 512 MB dahje eambbo.  

Muitu lea koarttas, mii čadno dihtorbovssa váldokortii. Go oasttát dihtora lea
dábálaččat okta muitokoarta, muhto sáhtát molsut dan dahje lásihit eará koartta, go leat 3-4
saji dasa. Jus dus omd. lea dihtor mas lea 128 MB muitu, sáhtát oastit 256 MB muitokoartta,
ja dalle dus leat oktibuot 384 MB. 

Muitokoarttat monterejuvvon dihtora váldokortii. (Govva: SL)

Earálágán muitu lea lohkanmuitu. ROM - Read Only Memory. Dát lea bistevaš muitu, mas
mii dušše fal sáhttit lohkat, eat sáhte vurket dasa.

 1.5. VUORKKÁT
Dihtora gaskabottosaš muittut leat ráhkaduvvon beallejođadasain dahje silisiumbirccuin.
Bistevaš muittut fas leat juo magnehtalaččat dahje optalaččat. 

Magnehtalaš vuorkkáin geavahuvvojit magnehtagiettit háldet magnehtalaš partihkalat
iešguđet hálttide. Váldošlájat leat báddi/kaseahtta, garraskearru ja diskeahtta.

Optihkalaš mediat geavahit laserčuovgga. Deháleamus optihkalaš vurkenmediat leat
CD ja DVD. Gávdnojit maiddái magnehtalaš – optihkalaš vurkenmediat, mas laserčuovga
reflekterejuvvo ja sojahuvvo diskka magnehtalaš gittiid dihtii.

Go ain stuorit oassi servodaga dieđuin vurkojuvvo digitálalaččat, lea stuora čuolbma
ahte dát mediat eai leat seamma bistevaččat go girjjit, mat sáhttet leat logahahtti moadde
čuođi jagi maŋis. Árvvoštallet ahte magnehtalaš mediain lea eallináigi 10-30 år, optihkalaš
mediat fas sáhttet bistit guhkit, muhtimat oaivvildit gitta čuođenáre jagi. Ii leat vel vejolaš
dadjat vissášit, go dát mediat eai leat vel gávdnon go moaddelogi jagi.

GARRASKEARRU
Garraskearru dahje harddisk lea dihtora váldovuorká. Garraskearru nákca muitala man ollu
sáhttá vurket dasa. Dat mihtiduvvo MB:in dahje GB:in. 1990-jagiid álggos lei dabalaš ahte
garraskearruin lei 30-100MB, 2005 lea dábalaččat seamma ollu GB, dahje duhát geardde
eambbo.
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Dihtoris sáhttá leat moadde garraskearru, ja lea vejolaš molsut daid. Muhtin dihtoriin
leat lođá(t), masa sáhttá bidjat garraskearru(id). Dalle molsu olles lođá, ja dat manná hui
jođánit. Dalle sáhttá omd. ovtta garraskearrus leat Linux ja nuppi garraskearrus fas
Windows. Sáhttá maiddái leat nu ahte jus ovtta dihtoris leat moadde geavaheaddji, de
juohkehaš sáhttá leat iežas garraskearru, maid sáhttá váldit mielde velá eará dihtorii. 

  
Garraskearru lođás. (Govva: SL)

DISKEAHTAT
Diskeahtat ovddiduvvojedje 1970-logus. Vuosttaš diskeahtain lei diamehter 8", dat ledje
asehaččat ja sojahahttit. Danin gohčojuvvojedje «floppy» (engelasgiella, mearkkáša
libardeaddji dahje sojahahtti). Sátni lea báhcán vaikko diskeahtat leat unnon ja eai leat šat nu
«floppy». Diskeahtat unniduvvojedje vuos 5 ¼":ii, maŋŋil 3 ½":ii, mii 1980-logu álggos lea
leamaš standardan. Guhká ledje máŋga dihtoris dattetge guokte diskeahtastašuvnna, nubbi  3
½ " diskeahtaid, nubbi fas 5 ¼" várás. Vuosttaš diskeahtain lei vurkennákca 360 KB, maŋŋil
720 KB. Dál lea standard máŋga jagi leamaš 1,44 MB. Dađistaga diskeahtat leat unnit aht
unnit geavahusas, ja muhtin ođđa dihtorain ii leat oba diskeahttastašuvdna. Erenoamážit dát
guoská mátkedihtoriidda ja Mac-dihtoriidda. Dain sáhttá baicce vurket CD:ii dahje eará
sirdehahtti mediaide. 

CD / DVD
CD-skearrut ráhkaduvvojit álggos musihka várás, maŋŋil maiddái datavurkemii. CD-
skearrus sáhttá dábálaččat vurket 600 - 800 MB, dahje seamma ollu go birrasiid 500
diskeahta. 

Álggos lei dušše CD-ROM, Compact Disk - Read Only Memory, mas geavaheaddji
sáhtii lohkat, muhto masa ii sáhttán vurket. Dál gávdno maiddái CD-R, Recordable, masa
geavaheaddji sáhttá vurket ja CD-RW, Rewriteable, masa sáhttá vurket ha sihkkut máŋgii.

DVD:s - (Digital Video Disk dahje Digital Versatile Disk) - lea vel stuorát
vurkennákca go CD, sáhttá leat moadde GB rájes gitta unnimusat 17 GB. DVD geavahuvvo
erenoamážit filmma várás. Seammalágán go CD:s, gávdno DVD-ROM, DVD-R ja DVD-
RW. DVD:s leat máŋga variántta ja iešguđetge buvttadeddjiin leat iežaset formáhta. Danin
eai álo doibmet skerrut ja mašiidnagálvu oktii. 
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EARÁ VURKENMEDIAT
Áiggi čađa leat ovddiduvvon muhtin eará vurkenmediat, mat eai leat nu ollu geavahusas go
dat mat leat namahuvvon bajábealde.   
* Árrat dihtoráiggis lei dábálaš vurket báddái, mii sulástáhtii jietnabátti. Ain geavahuvvo
báddestašuvnnat stuora datahivvodagaid sihkkárvuođamáŋgemii. 
* ZIP-drive lea stašuvdna mii čadnojuvvo dihtorii, mas vurkejuvvo njeallječiegat pláhtaide
mat leat veahá stuorit go báŋkokoarta. Dáin leat dábálaččat nákca sullii 100 MB.
* Minidiska dahje pendrive lea unna ađaš maid sáhtá bidjat dihtora USB-verráhii.
Ovdamunni lea ahte dat lea álki váldit mielde ja sáhttá čatnat dan buot dihtoriidda main lea
USB-vearrát. Nákca lea dábálaččat 100-200 MB rájes gitta 1-2 GB.
* Digitála govvenapparáhta muitokoartta sáhttá lohkat dihtoris koartalogániin dahje
adapteriin. Sáhttá maiddái vurket dihtoris dákkár kortii. Nákca lea 8 MB rájes unnimusat 2
GB rádjái.

1.6. BOALLOBEAVDI
Boallobeavddis leat dábálaččat 80 - 110 boalu maid sáhttá juohkit golmma váldojovkkui:
Čállinboalut, sierraboalut ja doaibmaboalut. Máŋga boallobeavddis leat boalut guovtti
ivnnis; dábálaččat čállinboalut čuovgadin ja sierraboalut seavdnjadin. Eanaš boalut leat
seamma sajis juohke boallobeavddis, earát sáhttet molsut saji dihtoris dihtorii. 

Mátkedihtoris (salladihtoris) lea veahá earálágan boallobeavdi ja unnit boalut go
dábálaš dihtoris.

Čállinboalut (alfanumeralaš boalut) leat riikkastandárddaid mielde. Jus áiggut čállit
sámegillii berre dus leat Norgga, Ruoŧa dahje Suoma boallobeavdi, ja dasa lassin sierra sámi
boallobeavdeprográmma. 

Dárogiel boallobeavdi, masa leat čállon sámegiel bustávat. (Govva: SL)

ČÁLLINBOALUT
Čállinboalut dahje alfanumeralaš boalut leat merkejuvvon bustávaiguin, loguiguin dahje eará
čállinmearkkaiguin. Buot čállinboalut sáhttet addit moadde iešguđetlágan mearkkaid šerbmii. 

Bustávaboaluin oaččut stuora bustáva jus čálidettiin doalát molsun-boalu
(Merkejuvvon Shift dahje govda njuolla bajásguvlui) vuollin. Jus deaddilat boalu man
namma lea Caps Lock, bohtet DUŠŠE STUORA BUSTÁVAT dassái go fas deaddilat Caps
Lock. 
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Muhtin čállinboaluin leat golbma dahje velá njeallje vejolašvuođa. Goalmmát
molsaeavttu, maid muhtin boaluin oainnát badjin ja olgešbealde boalus, oaččut go deaddilat
Alt+Ctrl oktanaga dahje AltGr ovttas dáinna boaluin.5  

Bustáva- ja lohkoboaluid olgeš bealde ja gurut bealde leat logenare eará čállinboalu,
mas leat mearkkat nugo:  + \ - < ' , .  Sámegiel boallobeavdeprográmmain sáhttá leat daid
duohken maiddái muhtin sámegiel bustávat. 

Sáhtát lohkat eambbo sámi boallobeavdeprográmma birra kapihtaliin 8.2. (KDE) ja
9.2. (teakstagieđahallan).

SIERRABOALUT
Sierraboaluid sáhttá fas juohkit moatti jovkui:
Navigerenboalut iešalddis eai váikkut tekstii, daiguin sáhttá sirdit seavana (čállinmearkka)
šearmmas:
PgUp (Page Up) sirdá siiddu bajás dokumeanttas
PgDn (Page Down) sirdá siiddu vulos dokumeanttas
Njuollaboalut sirdá ovtta saji ain hávil bajás, vulos, olgeš dahje gurut guvlui 
End sirdá linjá lohpii
Home sirdá linjá álgui

Eará boalut sirdet dahje sihkkot teavstta:
Del sihkku teavstta olgeš guvlui
Ruovttoluottaboallu sihkku teavstta gurut guvlui (gohčoduvvo maiddái Backspace) 
Tab-boallu sirdá teavstta ovtta tabulatorbihtá ain hávil (sáhttá prográmmerejuvvot)
Gaskaboallu addá rabas saji
Enter / Return ↵ álggaha ođđa linjá, teakstabihtá / vuolggaha gohččumiid

Muhtin boalut, nu go Shift, Ctrl, Alt, AltGr, eai iešalddis daga maidege, muhto fertejit
doaibmat ovttas čállinboaluiguin dahje eará sierraboaluiguin. Máŋga prográmmas doibmet
dát boalut ovttas bustávaiguin gohččumin. Eanaš teakstagieđahallanprográmmain Ctrl+X
mearkkáša čuohppat merkejuvvon teavstta ja Ctrl+V mearkkáša liibmet sisa. (Fuomaš ahte
dát ii álo doaimma sámegiel boallobeavddis, go dalle omd. X sajis lea Č. Oažžun dihte daid
gohččumiid doaibmat, sáhttá fertet molsut dárogiel boallobeavdái.) Muhtin dáin boaluin
sáhttet maiddái ovttas ráhkadit gohččumiid, omd. Alt+Shift dahje eará kombinašuvdna, go
áigut molsut dárogiel ja sámegiel boallobeavddi gaskkas ja Alt+Ctrl+Del, go áiggut álgit
ođđasit (reboot).
  
Eará sierraboalut:
Ins, Insert vállje čállit bajil ovddeš teavstta vai hoigat dan olgešguvlui
Caps Lock vállje unna ja stuora bustávaid gaskkas. 
NumLock doaimmaha numeralaš boallobeavddi.
Print Screen govvida olles šearpma.
Pause, Break muhtin prográmmain bisseha doaimmaid

DOAIBMABOALUT
Badjin dahje gurut bealde boallobeavddis leat nuppelot F-boalu main lea erenoamáš
doaimmat guđege prográmmas. Ferte oahppat dáid doaimmaid juohke prográmmas. Máŋgga
prográmmas oaččut veahki jus deaddilat F1-boalu.

5 Muhtin dihtorat sáhttet doaibmat earáláhkái. 
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NUMERALAŠ BOALLOBEAVDI 
Dábálaš boallobeavddis leat muhtin boalut iehčanassii olgešbealde. Dat geavahuvvojit
erenoamážit lohkogieđahallamii. Muhtin dain lea maiddai siera doaimmat muhtin
prográmmain. Dát oassi boallobeavddis sáhttá doaimmahit ja jaddadit fas NumLock -
boaluin.

Mátkedihtoriin ii leat sierra numeralaš boallobeavdi, muhto sáhttá gávdnat dáid
doaimmaid jus geavaha boalu Fn, mii ii leat dábálaš boallobeavddis. Logut ja doaimmat mat
lávejit leat numeralaš boallobeavddis lea mátkedihtoris dávjá merkejuvvon sierra ivnniin,
dávjá bajimusas olggešbealde boaluin. 

1.7. ŠEARBMA
Dihtoršearpmas leat máŋga čuovgi čuoggá. Šearbmagova kvalitehta lea dan duohken makkár
čuokkisčoahkku lea ja galle ivdnemolsudusat (nyansat) leat.

Čuokkisčoahkku (dg: oppløsning, eng.: resolution) lea galle čuoggá čahket serbmii.
Dat namuhuvvo na: Galle čuoggá govddodagas geardde galle čuoggá allodagas, omd.. 640 x
480 dahje 1152 x 768. Dát čuoggát gohčoduvvojiit maiddái pikselin.

Vuosttáš šearpmat ledje čáhppát/vielgadat. Maŋŋil leat šaddan eanet ja eanet ivnnit.
Ivdnelohku lea dan duohken galle bihtá geavahit čilget iešguđege čuoggá ivnni. Jus mii
geavahit  4 bihtá,  oažžut 24 = 16 ivnni, mii lea beare unni addit buore gova. 8 bihtá addet 28

= 256 ivnni, 16 bihtá 216 = 65536 ja 24 bihtá 224 = 16777216, mii lea ollu eambbo go čalbmi
sáhttá fuopmat.

Dihtoris ferte leat šearbmakoarta mii stivre šearpma, ja ferte leat oktavuohta
šearbmakoartta ja šearpma gaskkas. Jus hágat ođđa šearpma boares dihtorii, lea vejolaš
ahte fertet maiddái molsut šearbmakoartta.

Eanaš šearpmat PC:a várás leat stuorit ja klumpete ja váldet ollu saji čállinbeavddis.
Sivva dasa lea teknologiija mii geavahuvvo čájehit gova šearpmas. Mátkedihtoriin lea guhká
geavahuvvon eará teknologiija; LCD dahje golgi krystállat. Dađistaga dát teknologiija
geavahuvvo maiddái eambbo PC-aide, muhto dát šearpmat leat ain divrraseappot go dábálaš
šearpmat.

1.8. ČÁLÁN
Vuosttaš dihtorčálánat ledje matriisačálánat. Ledje čuoggát báhpiris mat oktii hábme
bustávaid ja čállosiin lei ollu heajut kvalitehta go dan mii boaresáigásaš čállinmašiinnain lei. 

Dađistaga matriisačálániid sadjái leat boahtán guokte eará šlája, mat otne vel leat
anus; bleahkkačálánat ja laserčálánat. Eanaš dálá bleahkkačálánat sáhttet čállit ivnniiguin ,
muhto laserčálánat leat dábálaččat čáhppat/vielgat. Gávdnojit ivdnelaserčálánat, muhto dat
leat ain divrasat ja govvakvalitehta ii leat seamma bures go bleahkkačálániin. 

Dađe bahábut ii leat doarvái oastit čálána ja čatnat dan dihtorii. Dárbbašat maiddái
čálánstivrran mii heive du čálánii ja du dihtora operatiivavuogádahkii. (Loga eambbo dán
birra kapihtalis 1.9.) Linuxas fertet maiddái gozihit ahte čállinprográmma lea installerejuvvon
ja doaimmahuvvon. Dábáleamus dákkár prográmma lea CUPS (Common Unix Printer
System). 

1.9. MASKINVARE JA OPERATIVSYSTEM
Buot olggoldas ovttadagat, maid sáhtát laktit dihtorii, nugo boallobeavdi, sáhppán, čálán,
skánnár dahje digitála govvenapparáhtta, stivrejuvvojit muhtin prográmmažiin mat
gohčoduvvojit stivrranin (driver). Jus galgá oažžut dáid biergasiid doaibmat, ferte leat
rievttes stivrran juste du mašiidnagálvvu ja du operatiivavuogádaga ovddas. 
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Go oasttát omd. čálána dahje skánnára, čuovvu dábálaččat stivrran, muhto ii leat
sihkkár ahte dat heive du operatiivavuogádahkii. Dávjá sáhttá dihtorgávpi háhkat stivrrana,
dahje sáhtát viežžat dan interneahtas, muhto muhtimin ii oba gávdno stivrran mii heive. Danin
ii berre oastit mašiidnagálvvu ovdal go diehtá ahte lea vejolaš oažžut rievttes stivrrana.

Jus dus juo leat mašiidnagálvu ja háliidat heivehit dan Linuxa várás, sáhtát ohcat
interneahtas nu ahte čálát mašiidnagálvu nama ja "Linux". Ferte dalle gávdnat stivrrana mii
lea páhkkejuvvon rievttes láhkái du Linux-distribušuvnna várás (deb Debian várás, rpm
muhtin eará distribušuvnnaid várás). Go leat viežžan stivrran-fiilla, sáhtát installeret dan
prográmmain Kpackage (geahča kap.7.8). Válljet dan maŋŋil rievttes stivrran-prográmmas
Kcontrol, mas válljet Ovttadagat váldofálus. (Eambbo Kcontrol birra kapihtalis.8.2.) 

Installeret ođđa biergasiid Linuxas sáhttá gáibidit veahá áiggi, gierddevašvuođa ja
instrukšuvdnalohkama.

2. DIHTORHISTORJJÁŠ
Dá leat muhtin dehálaš dáhpáhusat dihtorhistorjjás: 

1638 vuosttaš kalkulahtor, bátnejuvllaiguin
1700-logu álggus gođđinstuollu maid sáhtii stivret bábirkoarttain.
1800-logu álggus rehkenastinmašiidna ráigebáttiin
1840-talet Charles Babbage bijai dihtoriid teorehtalaš vuođu
1863 čállinmašiidna
1873 qwerty-boallobeavdi
1876 telefuvdna
1904 diode - radiobohccit
først på 1900-tallet elektromekánalaš rehkenastinmašiidna releaiguin
1930 vuosttáš binára rehkenastinmašiidna (Zuse)
1938 máŋgenmašiidna
1946 ENIAC – adnojuvvo vuosttaš dihtorin

1946:s bođii ENIAC (Electronic Numerator, Integrator and Computer). Dás ledje badjel 17000
elektronbohcci ja dettii 30 tonna. Sáhtii vurket 20 logu oktanaga. Ii sáhttán rievdadit prográmma.
Gova gáldu: http://ftp.arl.mil/~mike/comphist

Sullii 1950:s vejolaš rievdadit prográmma almma rievdadeames mašiinna («general purpose
computers»).  Dihtoriin ledje radiobohccit.

1953
Vuosttáš hivvodatbuvttaduvvon dihtor lanserejuvvon (IBM 650) Oktiibuot
vuvdojuvvojedje 1500 dákkára 1969 rádjái. 

1954 vuosttáš dihtor transistoriiguin

1954
vuosttáš norggalaš dihtor Nusse (Norsk Universell Siffermaskin, Sekvensstyrt
Elektronisk) 

1956 garraskearru
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1958 modem
1960 laser
1963 dihtorsáhppán
1964 vuosttáš teakstagieđahallanprográmma (IBM)
1960-logus Simula – vuosttáš objektaorienterejuvvon programmerengiella
1968 máŋga transistora biddjon oktii integrerejuvvon biiren 
1968 fiberoptihkka
1969 Arpanet álgá - interneahta ovdamanni
1971 operatiivavuogádat Unix
1971 vuosttáš mikrodoaimmár.
1972 vuostáš e-poasta-prográmma
1976 vuosttaš diskeahtta 
1977 Apple almmuha vuosttáš persovnnalaš dihtora
1981 operatiivavuogádat MS-DOS
1981 IBM almmuha vuosttáš PC
1980-logus šattai teakstagieđahallan dábálažžan Norgga fitnodagain.
1983 Apple (Mac): vuosttaš dihtor mii geavahii ikoniid, lásiid ja sáhpána 

1984
Microsoft Windows annonserejuvvon, muhto vuovdemassii easka moadde jagi
maŋŋil

1984 CD-ROM-skearrut
1984 GPL - General Public Licence - njuolggadusat friddja prográmmagálvui
1980-logu
gaskkamuttus

mátkedihtorat

1985 prográmma mii geavaha ikonaid, lásiid ja sáhpána. (Macintosh)
1989 operatiivavuogádat Microsoft Windows
1991 Linuxa vuosttáš siskkoš 
1991 Unicode
1992 World Wide Web
1994 vuosttáš stabiila Linux-veršuvdna
1996 Čállinbeavdebiras KDE
1999 gievrramus doaimmár 1 GHz (1 billiovnna operašuvnna sekunddas)
2001 álggahuvvui Skuvlalinux-prošeakta
2004 Skuvlalinux 1.0 almmuhuvvui

3. DIHTORA REHKENASTINVUOGIT

3.1. BIHTTÁ & BAITA  
Dihtorgielas okta 0 dahje 1 gohčoduvvo bihttán (bit) ja 8 bihtá (bits) lea okta baita (byte).
Go čállá dihtoriin lea dábálaččat juohke bustáva dahje eará mearka leamaš 1 baita, dahje
eará sániiguin muhtin kombinašuvdna gávcci nullain / ovttežiin. Nu gohčoduvvon 8-bihtá
kodatabeallaide lea ain nu, muhto nugo mii áigut čájehit kapihtalis 3.4., gávdno otne
vuogádat mii muhtin bustávaide geavaha moadde baitta.

Buotlágan dihtorvuorkkáid nákca (kapasitehta) rehkenastojuvvo baitan. 
Stuora vuorkkáin omd. stuora garraskearruin dahje CD-ROM-skearruin šaddet hirbmat
stuora logut jus galgá rehkenastit baitan. Danin mii atnit eará ovttadagaid; kilobaita (KB),
megabaita (MB) ja gigabaita (GB). Go dihtorteknologiija vuođđu lea guoktelohkovuogádat ii
ge min dábálaš logilohkovuogádat (Geahča kap 3.2.), de 1 KB ii leat juste 1000 B, muhto
1024 B. 1 MB = 1024 KB ja 1 GB = 1024 MB. 

Sáhtát čállit ollu siidduid ovdal go diskeahtta dievvá. Prográmmat, govat, jietna ja
filmmat váldet mihá stuorát saji go teaksta, ja danin sáhttá leat ávkkalaš diehtit man ollu
sadji dus lea ja man ollu leat geavahan.

Ovdamearkkat čájehit sullii galle baitta guđege lágan fiilla váldá, ja man ollu sáhtát vurket
guđege lágan vuorkái: 

baita kilobaita megabaita gigabaita
olles siiddu teaksta 1000-5000 B
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govva 30-1000 KB
1 sekundda TV 10 MB
dát girjjáš, govaid haga (teakstaformáhtas) 150 KB??
dát girjjáš, govaiguin  (OpenOffice-formáhtas) 1,2 MB
prográmma Open Office 70 MB
Skuvlalinux 600 MB
buot máilmmi olbmuid namat 100 GB
diskeahtta 1,44 MB
CD-ROM 600-800 MB
Ođđa garraskearru 20-100 GB

Bargobihttá: Rehkenastte eará ovttadahkan ja deavdde guorus ruvttuid bajábealde.

3.2. LOHKOVUOGÁDAGAT  
Go mii rehkenastit, mii lávet atnit dušše fal logilohkovuogádaga (dasimála vuogádat), ja mii
leat nu hárjanan dasa ahte eat jurddaš ge ahte gávdnojit eará lohkovuogádagat. Iešguđetge
áiggiin ja riikkain leat ráhkaduvvon ja geavahuvvon lohkovuogádagaid maid leat iešguđet
vuođđologut, dáid gaskkas:  2, 4, 5, 8, 10, 12, 16, 20 ja 60. 

Dihtorteknologiijas leat eanemusat geavahuvvon guoktelohkovuogádat (binára) ja
guhttanuppelotlohkovuogádat (heksadesimála). Ovdal go čilget dáid dárkkileappot áiggut
geahčadit prinsihpaid man vuođul lohkovuogádagat leat huksejuvvon. 

Buot vuogádagain mii sáhttit čállit vuolimus loguid ovtta siffariin, go mannat bajás de
fertet geavhit guokte, golbma dahje eanet siffaraiid. Lohkovuogádagat leat nammaduvvon
dan vuolimus logu mielde, mii čállo guvttiin siffariin. Dat mearkkaša ahte mii lohkat álggos
ovtta siffáriin, dassái go ollet vuogádaga vuođđolohkui. Dalle mii mannat ovtta ceahki gurut
guvlui ja álgit fas ođđasit nolla rájes olgeš bealde sajis. 

Dá leat moadde ovdamearkka mo  mii lohkat gávccinuppelohkái rádjái muhtin
lohkovuogádagain:

guoktelohkovuogádat (binárá vuogádat): 
0-1-10-11-100-101-110-111-1000-1001-1010-1011-1100-1101-1110-1111-10000-10001-
10010

njealljelohkovuogádat: 
0-1-2-3-10-11-12-13-100-101-102-103-110-111-112-113-120-121-122

logolohkovuogádat (desimálavuogádat):
0-1-2-3-4-5-6-7-8-9-10-11-12-13-14-15-16-17-18

guhttanuppelotlohkovuogádat (heksadesimála vuogádat):
0-1-2-3-4-5-6-7-8-9-A-B-C-D-E-F-10-11-12

Lea vejolaš ráhkadit vaikko man ollu lohkovuogádagaid. Vaikko logilohkovuogádat
hálddaša min beaivvalaš eallimis, de mii geavahit maiddái muhtin eará lohkovuogádagaid
bázahusaid; jándoris leat 24 diimmu (2*12), diimmus leat 60 minuhta jna. 

Bargobihtát:
1. Dovddat go loguid  dusin, snes ja gross? Makkár lohkovuogádagain dat bohtet?
2. Geahččal čállit loguid gávccinuppelohkái rádjái vihtta- ja gávccilohkovuogádagaid mielde.
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BINÁRA LOGUT
Dihtora prosessor ipmirda dušše guokte mearkka dahje signála, maid mii gohčodit 0 ja 1,
dahje lea / ii leat, earáin sániiguin guoktelohkovuogádat dahje binára vuogadat. Dihtor
jorgala ieš loguid, bustávaid ja eará mearkkaid binára «gillii» Dá mii čilget mo dat doaibmá.

Go galgat rievdadit muhtin logu logilohkovuogádagas guoktelohkovuogádahkii,
rehkenastit vuos man ollu dat lohku lea 2. poteansan. 
Omd. 4 = 2*2 = 22.  Dárbbašit guokte nulla čállit njeallje guoktelohkovuogádas: 100.6  
16 = 2*2*2*2 = 24, ja dárbbašit njeallje nulla čállit guhttanuppelohkái: 10000. 
Go lea lohku maid it sáhte čállit njuolga 2. poteansan, fertet juohkit mahkáš ná: 
7 =  4 + 2 + 1 = 22 + 21 + 20.  Danin guoktelohkovuogádagas 7 šaddá 111. 

Dá leat moadde ovdamearkka mo rievdadit logilohkovuogádagas guoktelohkovuogádahkan:
logilohkovuogáda

t
Faktoriserejuvvon 2. poteansan guoktelohkovuogádat

1 1 20 1

2 2 21 10
3 2+1 21 + 20 11

4 4 22 100

13 8+4+1 23 + 22 + 20 1101

85 64+16+4+1 26+24+21+20 1010011

255 128+64+32+16+8+4+2+1 27+26+25+24+23+22+21+20 11111111

Bargobihttá: Faktorisere dáid loguid ja čále dáid loguid nuppi poteansan ja
guoktelohkovuogádaga mielde:

logilohkovuogádat Faktoriserejuvvon 2-poteansan guoktelohkovuogádat
9

24
125

Go mii bargat dihtoriin, lihkus eat dárbbaš čállit dakkár guhkes ráidduid main leat dušše 0:t
ja 1:t. Boallobeavddis mii sáhttit deaddilit boaluid mas leat dábálaš mearkkat, logut ja
bustávat. Dihtor jorgala signálaid iežas gillii ja fas ruovttoluotta nu ahte boađus ihtá šerbmii
dakkár gillii maid mii ipmirdit.  

HEKSADESIMÁLA LOGUT
Dihtorteknologiijas lea vel okta lohkovuogádat mii lea dehálaš; 16-lohkovuogádat dahje
heksadesimála vuogádát. Dán vuogádagas mii lohkat guhttanuppelohkái rádjái ovdal go
dárbbašit guokte siffara, ja geavahit bustávaid go eai leat šat doarvái logut. Dát mearkkáša
ahte 10 logilohkovuogádagas mii čállit A heksidesimála vuogádagas, ja alimus siffar lea F,
mi vástida 15:i logilohkovuogádagas.

Dáid golbma vuogádaga sáhttá buohtastahttit ná:

6 Sidan både det binære ja desimale systemet brukar siffera 0 ja 1, kan det bli misforståingar, fordi f.eks  "10"
betyr ti i titalssystemet, men to i totalssystemet. Frå no av brukar vi derfor skrå skrift når vi skriv tala etter det
binære systemet.
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10-lohkovuogádat
(desimála)

16-lohkovuogádat
(heksadesimála)

Čilgehus 10-lohkovuogádagas guoktelohkovuogádat

1 1 00 00 00 01
2 2 00 00 00 10
9 9 00 00 10 01

10 A 00 00 10 10
11 B 00 00 10 11
13 00 00 11 00
15 F 00 00 11 11
16 10 16 + 0 00 01 00 00

11 00 01 00 01
20 14 16 + 4
30 1E 16 + 14
43 2*16 + 11 00 10 10 11
56 38 00 11 10 10

128 80
254 11 11 11 10

100 16*16 + 0 + 0 00 00 00 01  00 00 00 00
382 17E 16*16 + 7*16 + 14 00 00 00 01   01 11 11 01

1000
2534

Bargobihttá: Deavdde guorus sajiid bajábealde tabeallas.

Fuom! Sáhttá leat váttis diehtit mii vuogádagaid lea anus jus 10- ja 16-vuogádagat
geavahuvvojit oktanaga. Danin fertet dávjá čállit «x» ovdal loguid mat leat 16-vuogádagas,
omd.: x16 (=22) dahje xEA (=235).

Kapihtalis 11.6, html-prográmmerema birra, sáhtát oaidnit mo geavahit heksadesimála
vuogádat ivdneprográmmeremii.

3.3. BUSTÁVAKODAT    
Dát kapihtal lea čállon du várás, gii háliidat ipmirdit manne muhtumin bohtet ártegis
mearkkaid šerbmii, go galggašii leat sámegiel dahje dárogiel bustávat. Dát sáhttá orrut leame
ipmirmeahttun, muhto lea goit logihkalaš ja vejolaš ipmirdit.

8-BIHTÁ KODATABEALLAT   
Go deaddilat muhtin boalu boallobeavddis, lea prográmma dihtoris mii jorgala kodii, mas
leat 8 nulla/ovtteža. Mii gohčodit dan 8-bihtá koda. 

mearka desimála vuogádat heksadesimála vuogádat binára vuogádat
& 38 26 00100110
? 63 3F 00111111

A 65 41 01000001
B 66 42 01000010
a 97 61 01100001
z 122 7A 01111010

Mas boahtá ahte omd. A-bustávas galgá leat desimálárvu 65? Dat ii lea miige luonddulágaid,
muhto boađus kodatabeallas, mii ráhkaduvvui USA:s juo 1960-logus. Dát oaččui nama
ASCII - American Standard Code for Information Interchange. Álggu rájes dás eai lean go  7
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bihtá ja 128 saji, maŋŋil viididuvvui 256 sadjin ja das bohte máŋga veršuvnna. Measta buot
máilmmi kodatabeallain lea ain 128 vuosttas sajit nugo lea ASCII-tabeallas. 

Oinniimet kapihtalis 3.2 (guoktelohkovuogádaga birra) ahte 8 bihtá addet 256 vejolaš
kombinašuvnna. Muhto máilmmis leat máŋga čállingiela ja masá juohke gielas leat bustávat
mat eai leat eŋgelasgiel alfabehtas, man vuođul dihtorteknologiija álggos huksejuvvui.
Muhtin gielain lea latiidna alfabehta vuođđun ja muhtin liigebustávat, omd: 

davvisámegiella á  č  đ  š duiskkagiella ü
dárogiella æ  ø  å spánskagiella ñ
suomagiella ä  ö polskagiella ą  ć  ł 

Eará gielain, nugo ruoššagiella ja kiinnagiella, leat fas áibbas sierra alfabehtat. Danin leat
ráhkaduvvon sierra kodatabeallat (eŋg.: codepage) mat leat heivehuvvon guđege gielaide, vai
sáhttá addit sáji dáidda bustávaide. 

Riikkaidgaskasaš standardiserenorganisašuvdna (ISO) lea dohkehan
kodatabeallaráiddu, mii gohčoduvvo ISO-8859. ISO-8859-1 (Latin 1) gokčá eanaš
oarjeeurohpalaš gielaide, dáid gaskkas leat davviriikkaid riikagielat. ISO-8859-2 (Latin 2)
gokčá fas gaska- ja nuortaeurohpalaš gielaide, man alfabehta vuođđu lea latiidnagiel
bustávat. 

ERENOAMÁŽIT SÁMEGIELA BIRRA
ISO-8859-ráiddus leat guokte kodatabealla main leat sámegiel bustávat; ISO 8859-4 (Latin
4) ja ISO 8859-10 (Latin 6). Leat vel moadde kodatabealla mat leat dohkkehuvvon
riikaidgaskasaččat ja main leat sámegiel bustávat: ISO-IR-197 ja ISO-IR-209. Dasa lassin
leat moadde tabealla mat eai leat riikkaidgaskkasaččat dohkehuvvon, muhto mat leat ollu
geavahuvvon. Dábáleamus daid gaskkas lea WS2 (Levi 2), maid Sámi dihtorlávdegoddi lea
mearridan. Iešguđelágan tabeallat anus dagahit gulahallanváttisvuođaid.

UNICODE  
Unicode lea kodavuogádat mii lea ráhkáduvvon vealtin dihtii moivvi ja váttisvuođaid 8-bihtá
kodaiguin. Prinsihppa lea ahte buot máilmmi bustávat ja mearkkat galget čahkat ovtta tabellii
ja juohke bustávas galgá leat dušše okta koda. Jus du dihtoris sáhtát geavahit unicode, de it
dárbbaš molsut kodatabeallaid gaskkas jus galggát čállit omd. suomagiela, sámegiela ja
ruoššagiela. It ge dárbbáš sierra sámi foanttaid. Áidná maid dárbašat lea
boallobeavdeprográmma mii gávdna luotta boaluin sámi álfábehta bustávaide. 

Dál (2005) ođđaseamus dihtorat ja operatiivavuogádagat sáhttet geavahit Unicode.
Dat guoská sihke Windowsii (NT ja 2000 rájes), Macii (OS X rájes) ja Linuxii (veršuvnnat
mat leat boahtán maŋimus jagiid). Muhto dađe bahábut dát ii mearkkaš ahte buohkat duođaid
váldet Unicode atnui. Dokumeanttat mat čállojuvvojit omd. eŋgelasgillii, dárogillii ja
suomagillii, leat ain eanaš 8-bihtá vuogádaga mielde, dat mearkkaša ahte čuvvot
kodetabealla Latin 1 dahje ISO 8859-1. 

Gávdnojit maiddái máŋga geavaheaddjiprográmma maid eai vel hálddaš Unicode.
Danin mii fertet ain muhtin áigi rahčat 8-bihtá kodatabeallaiguin. Buot prográmmat maid mii
čilget dán girjjis hálddašit unicode.

Unicoda kodatabealla lea ISO 10646. Das eai leat dušše 256 saji (= 28), muhto prinsihpas
gitta 2 147 483 648 saji (= 231), vaikko measta buot mearkkat mat dán rádjái leat anus leat
vuosttaš 65536 (= 216) gaskkas. 

Go koda lea bajábealde 256 desimála vuogádagas dahje x0100 heksadesimála
vuogádagas, de ii šat birge dušše ovttain baittain. Mo dalle dahkat vai dihtor galgá ipmirdit
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goas ođđa mearka álgá? Leat guokte prinsihpa mo sáhttá čoavdit dan:

UCS
Sáhttá mearridit ahte juohke mearkkas galget leat lea vissis meare baittat; 2 dahje 4.
Vuolábealde tabeallas čájehit vuogi mii gohčoduvvo UCS-2. Dat geavaha álo 2 baitta, ja
danin eai čaga go 65536 mearkka dán vuogádahkii. Dat doaibmá dušše bures go dihtor
juohká baittaid rievttes láhkái vai vuosttaš boahtá ovdal nuppi. Jus dát manná boastut, de
šaddá dušše moivi. Seammaláhkái gávdno UCS-4, mas buot mearkkat geavahit 4 baitta. 

UTF
Nubbi prinsihppa lea ahte mearkkat geavahit ovtta dahje moadde baitta, ja vuosttaš baita
muitala dihtorprográmmaid galle baitta geavahuvvojit dán mearkkas. Dábáleamus dákkár
kodavuogádain gohčoduvvo UTF-8, earát leat omd. UTF-7 ja UTF-16. UTF-8 mearkaša
ahte unicode-koda juhkkojuvvo osiide, main leat 8-bihtá dahje 1-baita. Dušše fal bustávat
dahje mearkkat mat birgejit 7 bihtáiguin, sáhttet birget 1 baittain dán vuogádagas. Mearkkat
mat unicode-tabeallas leat nummar 128 rájes, dárbbášit guokte baitta, 2048 rájes golbma
baitta jna.  

Jus čállá dušše fal bustávaiguin mat leat eŋgelasgiel alfabehtas dahje kodatabeallas US-
ASCII, de ii leat erohus UTF-8 ja latiidnagiel 8-bihtá kodatabeallaid gaskkas. Muhto jus
geavaha eará mearkkaid, de dáid kodat šaddet earálágánat. Dát guoská sihke erenoamáš
sámegiel bustávaide ja skandinaviagiel bustávaide nugo æøåöä. Skandinaviagiel bustávat
kodejuvvo earáláhkái UTF-as, vaikko dain leat seamma kodat Unicode-tabeallas / UCS-2 go
8-bihtá-tabealla ISO-8859-1 (Latin 1).    

Tabeallas oainnát mo moadde bustáva leat unicodas. 

mearka logilohko-
koda

heksadesimal
koda

guoktelohko-koda 
(UCS-2)       

UTF-8

$ 36 24 00 00 00 00   00 10 01 00 00 10 01 00
a 97 61 00 00 00 00   01 10 00 01 01 10 00 01
z 122 7A 00 00 00 00   01 11 10 10 01 11 10 10
ö 246 F6 00 00 00 00   11 11 01 10 11 00 00 11  10 11 01 10
ø 248 F8 00 00 00 00   11 11 10 00 11 00 00 11  10 11 10 00
Č 268 10C 00 00 00 01   00 00 11 00 11 00 01 00  10 00 11 00
č 269 10D 00 00 00 01   00 00 11 01 11 00 01 00  10 00 11 01

Đ 272 110 00 00 00 01   00 01 00 00 11 00 01 00  10 01 00 00
ŋ 331 14B 00 00 00 01   01 00 10 11 11 00 01 01  10 00 10 11
ž 382 17E 00 00 00 01   01 11 11 10 11 00 01 01  10 11 11 10

Я 831 42F 00 00 00 11   00 11 11 11 11 00 11 00  10 11 11 11

€ 8449 20AC 00 10 00 01   00 00 00 01 11 10 00 10  10 00 01 00  10 00 00 01

Jurdda UTF-8:in lea juohkit bihttáráidduid main leat eambbo go 7 bihtá multibaitaráidduide,
main leat guokte dahje golbma baitta (á 8 bihtá). Mo unicode-árvu rievdaduvvo UTF-8-árvun
boahtá ovddan tabeallas:

binára árvu (ucs-2) 1. baita  2. baita  3. baita 

00000000 0xxxxxxx    0xxxxxxx

00000yyy yyxxxxxx 110yyyyy 10xxxxxx

zzzzyyyy yyxxxxxx 1110zzzz 10yyyyyy 10xxxxxx
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Jus lea mearka mas eai leat go 7 bihtá (x7F dahje unnit, xxxxxxx rájes, nu go čájehuvvon
tabealla vuosttaš linjás), dalle ii rievdaduvvo. Vuosttas 128 mearkka čuvvot ASCII, maiddái
UTF-8:s. Ovdamearka: Bustáva "a" lea x61 = 1100001, buot vuogádagain.

Jus lea muhtin unicode-mearkka gaskal 10000000 ja 11111111111 (= gaskal x80 ja
x7FF) de dat jorgaluvvo guokte-baita-ráidui, dan láhkái ahte bidjá maŋimus 6 bihtá nuppi.
baitii (bajábealde  "x"-at), ja 5 vuosttáš bihtáid (bajábealde "y":at) vuosttáš baitii. 

Baittain leat iešguđetge álgosiffarat: Jus vuosttáš bihttá lea 0, dieđát ahte dát lea
mearka mii ii dárbbaš go ovtta baitta (ASCII). Jus vuosttáš 3 bihtá leat 110, dieđát ahte dát ja
boahtte baita (mas lea 10 prefiksan) gullaba oktii. Jus vuosttáš 4 bihtá leat 1110, dieđát ahte
dát gullá oktii boahtte guvttiin baittain. Ovdamearka: Bustáva "á" lea xE1 = 1110 0001.
Ráidu  xxxxxx lea dás 100001, ja ráidu yyyyy lea 00011. (Mii lasihit nullaid álggos dalle go
input lea oanehit go 11 siffara). xE1:a UTF-8-árvu šaddá dalle 1100 0011 1010 0001. Jus
prográmma lea biddjon  nu ahte dat lohká UTF-8 riekta, de mii lohkat á, nu go galgá leat. Jus
fas lea biddjon omd.. Latin 1:ii, oažžut ovtta mearkka juohke baitta ovddas. Dalle mii lohkat
ná: 11000011 = xC3 ja 1010 0001 = xA1. Latin 1:s lea  xC3 = Ã ja xA1 = ¡. Dalle  omd.
sátni "Sápmi" boahte šerbmii ná: «SÃ¡pmi».

Mearkkat mat unicodetabeallas leat 2048 (x800) rájes, juhkkojuvvojit golbma baita n,
málle mielde mii leat čujuhuvvon bajábealde tabealla goalmmát linjás. Das gávdnojit ee.
korealaš, kiinalaš ja japánalaš mearkkat. 

Vaikko unicode prinsihpalaččat galggašii čoavdit buot konverterenváttisvuođaid iešguđet
kodatabeallaid gaskkas, de sáhttá áin leat čuolmmat dan dihte go muhtin
operatiivavuogádagat / prográmmat geavahit UTF-8, earát fas UCS-2. Linux geavaha UTF-
8.

Bargobihttá: Mii lea  «š»-bustáva UTF-8-árvu?

4. SIHKARVUOHTA 
Gávdnojit dušše guovttelágan dihtorgeavaheaddjit: sii, geain leat juo leamaš
dihtorvuogádatváttisvuođat ja sii, geat ožžot váttisvuođaid. Ja dát váttisvuođat sáhttet boahtit
váikko goas. Danin mii fertet oahppat maid bargat vai eat heađástuva bearehaga go
váttisvuođat bohtet. 

Mii fertet oahppat dihtorsihkarvuođa birra, mo váldit vára iežamet fiillaid,
prográmmaid (software) ja mašiidnagálvvuid (hardware).

Deháleamus oppalaš sihkarvuođanjuolgadus lea: Galggat diehtit maid barggat!! 
Jus it dieđe, loga instrukšuvnna dahje jeara veahki.

MAŠIIDNAGÁLVVU SIHKARVUOHTA
Gávdnojit máŋga vuogi bilidit dihtora ja vurkenmediaid. Dá leat moadde ovddamearkka
ovttas rávvagiin  mo sáhtát vealtit billásteamis:

* Sáhttá bilidit dihtora fysalaččat gáhččama, časkkástagaid dahje šluvgideami dihtii. 
Go galggat sirdit dihtora fertet loktet dan várrugasat ja páhkket bures. Dát guoská maiddái 
mátkedihtoriidda! Mátkedihtorii berre leat buori lávka. 

*  Dásehis el-rávdnjeváráiduhttin
Berre leat sihkkaris el-rávdnje-gáldu: joatkkajođas mas lea sierra sihkkarastti.

* Golggosat mat mannet mašiinnagálvvuid sisa 

2222



Ii galgga leat biebmu ii ge juhkamuš dihtora lahka. Dutkit leat gávnnahan ahte stuorámus
uhkidus dihtorgálvui lea gáffe sohkariin. (Deadja dahje Cola ii leat ge buoret, ja dán girjji
čállii fertii oktii sáddet mátkedihtora divodeapmái go lei láhppon sávtta boallobeavdái.)

* Vurkenmediaid billisteami
Diskeahtaid ja CD:id berret vurket goike ja buhtes bovssain. Ale guoskka CD:a vuolábealde,
ii ge hoigga diskeahta sirdasahtti gokčasa. 

Magnehtalaš vurkenmediat, nugo diskeahtat, digitála govvenapparáhta muitokoarta ja
pendrive berret doallat guhkkin eret magnehtain, skájaniin ja mobiltelefuvnnain mat sáhttet
váikkuhit magnehtadoaimmaid.

Jus fuomášat ahte diskeahtta ii leat áibbas ortnegis: Váldde kopiija diskeahtas jus ain
lea vejolaš ja bálkes billašuvvan diskeahta dakkaviđe.

* Vurkke bures buot dieđuid prográmmaid ja dihtorbierggasiid birra. Don dárbbašat daid jus
muhtin beaivvi fertet installeret ođđasit. 

VURKET JA MÁŊGET
Vurke iežat barggu dávjá, áinnas sihke garraskerrui ja diskehttii. Duollet dálle berret kopieret
du garraskearru, ja erenoamážit kataloga mas dus leat iežat fiillat, eará garraskearrui dahje
CD-ii. Buoremus lea jus sáhtát máŋget olles garraskearru. Unnimusat berret čállit du
partišuvnnaid sturrodaga ja katalogastruktuvrra, nu ahte šaddá álkit rekonstrueret dan jus
jávká. 

SKIHKKA GARRASKEARRUS
Berret organiseret garraskearru nu ahte dus lea ieža oassi (partišuvdna dahje ohcu)
persuvnnalaš fiillaide, ja dan fas berret juohkit fáttáid mielde. Ale vuordde dáinna daššái go
dus lea nu ollu fiillat ahte it dieđe mii dus lea. 

Operatiivavuogádagain leat iešguđetge vuohki vurket fiillaid garraskearrus. Linuxas
vurket buot iežat fiillaid katalog /home/geavaheaddjinamma vuolde. ja dasa berret ráhkadit
katalogaid iešguđetge fáddáide, omd. /home/biret/skuvla/luonddufaga. Windowsas válljejit
máŋggas álkimus vurkenvejolašvuođa, juogo njuolga čállinbeavdái dahje "Mine dokumenter"
vuolde. Dát sáhttá doaibmat bures álggos, muhto go oaččut ollu fiillaid, de dat ii leat buorre.
Bija danin jus vejolaš sierra partišuvnna iežat fiillaide, omd: F:/skuvla/luonddufaga dahje 
jus dus ii leat sierra partišuvdna nie: C:/biret/skuvla/luovddufaga. 

Duollet dálle berret sihkkut fiillaid maid dieđát ahte it dárbbáš šat. Ovdal go čorget ja
sihkut berret máŋget berret váldit sihkarvuođamáŋgosa, nu ahte sáhtát gávdnat boares fiillaid
fas jus gártat sihkkut bearehaga. 

Windowsas ferte muhtumin čorget garraskearru automáhtalaččat. Linuxas ii leat
seamma dárbu. Kapihtalis 7.7. mii čilget eanet Linuxa partišuneren ja fiilavuogádaga birra.

ÁLGGAHANMEDIA
Jus muhtin sivas šaddá veadjetmeahttun álggahit operatiivavuogádaga garraskearrus,
dárbbašat eará vuogi. Mo dan sáhttá dahkat lea du váldokoartta ja operatiivavuogádaga
duohken. 

Lea guhká leamaš dábálaš geavahit diskeahtta mas leat dárbbašlaš vuogádatfiillat, ja
dakkár diskeahta beassá dábálaččat ráhkadit operatiivavuogádaga installeredettiin. maŋimus
áiggis lea šaddan dábáleabbun geavahit installeren-CD álggahanmedian. Muhtin
váldokoarttain lea maiddái vejolašvuohta álggahit USB-diskkas. 
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Go álggahat álggahanmediain oaččut dábálaččat dušše vuđoleamos doaimmaid, nu
ahte beasat vurket dehálaš dáhtaid, geahččalit ortnet dan mii lei boastut ja maŋŋil álggahit
dábálaš vuogi mielde.
 Linuxas dát lea čovdojuvvon iešguđetge vuogis iešguđetge distribušuvnnas ja
veršuvnnas, ferte danin iskat mo sáhttá dahkat dan iežas distribušuvnnas. 

Dat mii lea čállon dás guoská dušše álggahanmedia heahttečoavddusin. Eará ášši lea
ahte gávdno sierra Linux-distribušuvnnat mat álo álggahuvvo CD:s ja maid ii dárbbaš ge
installeret garraskerrui.

INTERNEAHTTA 
Oktavuohta du dihtora ja interneahta gaskkas sáhttá doaibmat goappašiid guvlui. Muhtumin
sáhttá fierpmádatlogan doaibmat dan láhkai ahte dan botta go don leat fitname muhtin
fierpmádatbáikkis, de sáhttet muhtin dihtorat fierpmádagas geahččat mii lea du
garraskearrus. Dat guoská erenoamážit jus don leat čadnon fierpmádahkii fiilalonuhallama
várás. 

Fierpmádatloganat leat ráhkaduvvon nu ahte muhtin fierpmádatbáiki sáhtte vurket
dieđuid du dihtorii. Dieđut vurkojuvvojit unna teakstafiilan, mii gohčoduvvojit
diehtočoahkkun dahje eŋgelasgillii "cookies". Maŋŋil dat fierpmádatbáiki sáhttá lohkat dan
dieđuid go fas finan dan báikkis. Deike sáhttá vurkejuvvon dieđuid du giellaválljema birra,
du kodaid jna. Lea dušše fierpmadatbáikkit mat leat bidjan diehtočoahkkuid du dihtorii mat
besset lohkat daid fas. 

Bajábealde govva čájeha ahte Google lea guođđán diehtočoahku, man namma lea PREF, ja
mii šaddá leat doppe 2037 rádjái, jus ii sihkkojuvvo (ja jus dát dihtor doaibmá nu guhká). 

Sáhtát gávnnahit makkar diehtočoahkut mat leat du dihtoris, sáhtát sihkut dat mat leat doppe
dahje muhtin sis, ja sáhtát válljet mo ferpmádatlogan galgá boahtteáiggis gieđahallat ođđa
diehtočoahkuid mat bohtet; dohkkehit buot, hilgut buot dahje jearrat dus juohke háve háliidat
go dohkehit diehtočoahku dán fierpmáatbáikkis. Iešguđetge fierpmádatloganiin leat
iešguđetge vuogit mo dahkat dan. Dá boahta bálgis dohke moadde fierpmadatloganiin: 
Konqueror: Innstillingar > Set opp Konqueror > Informasjonskapslar 
Mozilla ja Netscape: Edit > Preferences > Privacy & Security > Cookies
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MS Internet Explorer: Verktøy > Alternativer for internett > Egendefinert nivå >
Informasjonskapsler 
Opera:  

Leat moadde intreneahtabálvalusa mat eai doaimma ovdal go leat dohkehan
diehtočoahku. Dat guoská ee. fierpmádatbáŋkkuide. Sivva dasa lea ahte oaččut ođđa
oktavuođa bálvváin juohke háve go ráhpat ođđa siiddu. Jus fertet logget sisa, lea
diehtočoahkku áidna vuohki mo bálvá sáhttá dovdat du ja diehtit ahte don leat loggen sisa. 

Muhto eatnasat mis eat dárbbaš dakkar doaibmat nu dávjá, ja lea vejolaš giddet
uvssa ja rahpat dan fas dalle go geavahit juste dáid fierpmádatbáikkiid. Muđuid berre
muhtumin sihkut buot diehtočoahkuid. 

Hehtten dihtii earáid beassamis sisa berre leat muhtinlágan nu gohčoduvvon
buollinseaidni (brannmur/firewall). Dan sáhttá ortnet máŋgga láhkái. Go máŋga dihtorat leat
čadnon oktii fierpmádagas lea dábálaš geavahit sierra dihtora buollinseaidnin, geavahit sierra
buollinseaidnebovssa, koarta maid bidjá bálvái dahje buollinseaidni sáhttá leat oassin ruteris.
Jus dus lea iešheanalaš dihtor mas lea Windows, berret, installeret buollinseaidneprográmma,
omd. ZoneAlarm. Linuxas sáhtát muhtin muddui hehttet earáid beassamis du dihtorii dušše
dainna ahte rievdadit ovtta gohččuma muhtin fiillas. Mo dahkat dan sáhttá leat iežáláhkái
iešguđetge distribušuvnnain, muhto Debianis lea fiila /etc/host.deny. 

Sihke Linuxa ja eará operatiivavuoádagaid várás lea buorre čuovvut mielde ja viežžat
ja installeret ođđaseamus sihkkarvuođaođasmahttimiid mat leat olámuttos interneahtas. 

Jus háliidat sáddet e-poastta maid dieđát vissásit ahte earát eai sáhte lohkat, sáhtát
geavahit kodenprográmma, nu go PGP - Pretty Good Privacy. (Geahča omd.
http://www.pgpi.com)

Jus dus lea e-poasta-adreassa, de dus lea maiddái iežat beassansátni (passord). Dan
berret doallat čihkosis ja maiddái molsut gaskohagaid. Maiddái jus dus leš vejolašvuohta
geavahit bálvvá ja dárbbašat beassansáni dohko, berret gozihit ahte earát eai beasa geavahit
du beassansáni. 

VIRUSAT
Virusat leat prográmmat mat leat ráhkaduvvon vai mannet suoli dihtora prográmmii ja dás
levvet viidáseappot. Virusat sáhttet dahkat stuora váhágiid, bilidit prográmmaid ja fiillaid
maid don leat čállán dahje sárgon. Ollu virusat leat prográmmerejuvvon nu ahte
doaibmagohtet vissis áiggis, nu ahte fuomašat vahágiid easka guhkes áiggi maŋŋil go leat
ožžon virusa. 

Virusat sáhttet boahtit fiillaiguin maid installeret dahje kopieret diskeahtain dahje
interneahtas. Dábáleamus virusgáldu dál lea e-poastta milddosat. Virus sáhttá sáddejuvvot
máŋga láhkái, ee. kamuflerejuvvon várrehussan virusiid vuostá. Muhtin daid celkejit ahte
bohtet Microsoftas. Maiddái fiilajuohkinprográmmat nugo Kazaa sáhttet leat virus-gáldut. 

Mo sáhtát vealtit oaččumis virusaid?

1. Operatiivavuogádat
Buot buoremus suodjalus virusaid vuostá lea vealtit Microsoft Windows. (Buot maŋimus
Windows-veršuvnna mii dál lea sihkkar virusaid hárrái lea 3.11.) Buot eará
operatiivvavuogádagat leat sihkkareappot go Windows.
Linux:in dahje Mac:in don leat oalle sihkkar virusaid hárrái. 
Berret maiddái viežžat interneahtas du operatiivavuogádaga maŋimus
sihkkarvuođaođasmahttimiid. 
 
2. Fierpmádatloganat
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Jus dattetge geavahat Microsoft Windows operatiivavuogádahkan, berret válljet eará
fierpmádatlogana go MS Internett Explorer, omd. Netscape, Mozilla dahje Opera.

3. E-poastaprográmma
Buot váraleamus e-poastaprográmma lea MS Outlook / Outlook Express. Buot eará e-
poastaprográmmat leat buoret.

4. Anti-virus-prográmma
Jus geavahan Windows de dus ferte leat anti-virus-prográmma, ja dat ferte leat ođasmahtton. 
Dan ferte dábálaččat máksit, muhto máŋga interneahta-fálliin lea anti-virus-prográmma
mielde sin páhkain. Ja jus it gávnna nuvttá prográmma, berret muitit ahte sáhtá šaddat ollu
divraseappot dan haga. Go dus lea anti-virus-prográmma mii lea registrerejuvvon, oaččut
maiddši dieđuid ođasmahttimiid birra. 

5. e-poastalogan
Virus mii boahtá e-poasttain sáhttá dušše boahkuhit du dihtora go poasta boahtá du
garraskearru sisa. Gávdno prográmma, mas sáhtát lohkat e-poastta neahtas, go ain lea
bálvvás. Sáhtát omd. geavahit fierpmádatbáikkin nugo epostleser, gmail dahje hotmail. Go
leat geahččan poastta doppe ja sihkkon dan mii sáhttá leat várálaš, sáhtát viežžat eará
reivvvid iežat dihtorii.

6. Behandling av e-post-vedlegg
 Jus oaččut e-poasta mas lea mielddus (attachment), it berre rahpat dan njuolga e-poasta-
prográmmas. Lea buoret vurket mildosa sierra katalogii ja de rahpat dan prográmmas maid
virusat eai sáhte geavahit, omd. Word Viewer, maid sáhttá viežžat nuvttá Microsoft:s.  Jus
lea dárbu, sáhtát kopieret ja liibmet dan sisa eará prográmmii.. 
Erenoamáš várrugas berret leat jus:
- e-poasttas ii leat sáddejeaddji, dahje don it dovdda dan.
- reivves ii leat bajilčála dahje jallas bajilčála dahje bajilčála lea gillii maid it vuordá dán
saddejeaddjis.(Measta buot virusiin lea eŋgelasgiel bajilčála.)
- mielddus lea fiila mas lea *.exe, *.com, *.bat, *.pif dahje .vbs goargun dahje das leat
moadde goarggu maŋŋalágaid. (Windowsas fertet stellet nu ahte goarggut oidnojit.)

Jus jáhkát ahte muhtin fiillas lea virus, lea buoremus sihkut dan oaidnekeahttá. Sáhttá
leat virus váikko boađášii du olbmás, go muhtin virusat sáddejuvvo automáhtalaččat
buohkaide geat leat e-poastaprográmma adreassalisttus. 

Gávdnojit virausat mat ávkkástallet autentalaš korrespondanssa mii lea leamaš, nu
ahte sáhtát oažžut vel oktii reivve maid áigá leat ožžon muhtin olbmás, muhto dán háve
virusiin.

Sullasaš váralaš “eallit” 
Gávdnojit máŋgalágan váralaš “eallit” mat leat virusaid fuolkežagat ja mat sáhttet dahkat
ollu vahágat. Sierralágán virusat leat ng. “ormar “ (worms), mat máŋget iežaset.
  “Trojanalaš heasttat” leat liigeprográmmat mat čuvvot omd. spealut dahje eará
prográmmaid maid vieččat interneahtas. Go vuos leat ožžon trojanalaš heastta sisa du
dihtorii, sáhtet  hackarat interneahta bokte beassat sisa du garraskerrui ja bilidit doppe, ja
geavahit dan sáddet ruskapoastta dahje fállehit eará dihtoriid. Trojanalaš heasttat fállejit
maiddái Linux-geavaheddjiid.

Erenoamáš šlája lea ng. “hoax” dahje manuála virusat (gohčoduvvojit maiddái
polskalaš virusin). Oaččut e-poasta-dieđu gáldus mii orru leame luohttehahtti, ahte váralaš
virus lea fállehan du, ja sihkarastin dihtii iežat dihtora fertet sihkut muhtin erenoamáš fiila
Windows. Dan maŋŋil galggat sáddet dan várrehusa buot oahppesolbmuide. Dát
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gohččoduvvojit manuála virusin danin go fillejit geavaheaddji ieš dahkat sullálaš vahágiid
dihtorii maid virus sáhtášii dahkat. Dakkár dieđut sáhttet leat oalle gávvilat, muhto it galgga
goassige jáhkit daid, sihkut makkarge vuogádatfiilla it ge sáddet viiddaseappot. 

RUSKAPOASTA
Eatnasat geain lea e-poastačujuhus ožžot eanet dahje unnit ruskapoastta (spam). Dát lea
duođaid interneahta heajos beali: poastaboksa dievva roavva porno, behtolaš dálkasiid,
fálaldagaid vilgatbassat miljovnnaid dollara miehtá máilmmi bahádahkkiid ovddas, dieđut
ahte leat vuoittán miljovnaid dollariid. jna. 

Mo bat dát bahádahkkit gávdnet juste du e-poastačujuhusa? Vuosttažettiin dat atnet
ohcanmohtoriid mat ohcet čujuhusaid interneahtas. Dađe eambbo don geavahat čujuhusat
reivečállimii, searvat ságastallanlisttuide dahje diŋgot áđaid, dađe stuorat lea vejolašvuohta
oažžut ruskapoastta. Jus dus leat iežat fierpmádatsiiddut, soaittát leat čállán čujuhusat dohko,
ja dalle lea hui álki gávdnat dan. 

Sáhtát dahkat juoidá vai it gavnnahala nu álki. Iežat fierpmádatsiidduin sáhtát addit
čujuhusa eahppenjuolga, nu ahte sii geat duođaid háliidit čállit dutnje besset dahkat dan,
muhto ohcanmohtorat eai gávnna du. Jus čálat gaskka juste ovdal dahje maŋŋil  @, de
ohcanmohtorat eai šatta lohkat dan e-poastačujuhussan. Sáhtát maiddái kodet nu ahte linka
mii oidno lea omd. "Čále munnje", ja go deaddila dasa de boahte skovi maiguin sáddet e-
poastta

Oppalaččat lea váttis hehttet sin geat sáddet ruskapoastta dahje virusa gávnnamis du
e-poastačujuhusa. Jus molsu e-poastačujuhusa, dat veahkeha muhtin áiggi, muhto hehttehus
lea ahte maiddái šadda váttis olbmuide, geain háliidat reive, gávnnamis du. 

 Gávdnojit nu gohčoduvvon spam-filttárat, mat lukar ut sávvakeahttes e-poastta.
Čuolbma lea ahte dát ge eai leat áibbas sihkarat. Muhtin ruskapoasta šaddá dattetge beassat
sisa, muhto vel vearrát lea ahte poasta maid duođaid háliidat maiddái sáhttá jávkat. Muhtin
bálvvát gozuhit ahte buot sin domena e-poastačujuhusain lea spam-filttár, earát fas dahket
dan dušše jus mávssát liigemávssu. 

Go vuos leat ožžon ruskapoastta, lea buoremus maid sáhtát dahkat sihkut daid
jođanepmosat. Ale fal goassege vástit dáhkár reivii. Jus dagat dan duođáštit ahte du e-
poastačujuhus doaibmá ja ráŋgastussan oaččut vel eanet ruskapoastta. 

Ođđa ja erenoamaš bahás ruskapostašládja lea dakkar maid eŋgelasgillii
gohččoduvvo “Phishing”, mas bivdet du logget sisa ja muitalit iežat persovnnalaš dieđuid,
nugo kredittkoartanummar ja sisaloggendieđuid. Dát boahtá dávjá čihkkojuvvon reiven
báŋkkus dahje fitnodagas mii vuovdá interneahtta. Jus don leat kundár dan fitnodagas, sáhtát
álki fillehallat. Dát ii leat go geahččaleapmi háhkat du ruđaid, ja it goassege galgga dahkat
maid čállet reivves. Jus dattetge smiehtat sáhtttá go dát leat duohtá, čuojat fitnodaga ja jeara
lea go sii geat leat sádden dan. Lea dál ovddiduvvon prográmmagálvvu mainna sáhttá
gávnnahit lea go “phishing”, dan bokte ahte iskkadit leat go almmuhuvvon čujuhusat riekta ja
gullet go dat duođaid dan fitnodahkii. 

5. VUOIGATVUOĐAT JA LISEANSSAT
Go dihtorprográmmat vuvdejuvvojit dahje distribuerejuvvojit, leat hui molsodahtti eavttut
čadnon prográmmaide. Muhtin prográmmat juogaduvvojit eavttuid haga, mii mearkkaša ahte
geavaheaddji sáhttá dahkat maid háliida dainna. Dat gohčoduvvo "Public Domain" dahje
"Almmulaš opmodat". Dat lea seamma go ng. BSD-liseansa.

Eanaš prográmmain lea muhtinlágán liseansa, mii muitala maid geavaheaddji beassá
dahkat ja maid ii beasa dahkat prográmmain. Máŋga prográmmas bohtet liseansaeavttut

27 27



ovdan go galggat installeret prográmmá, ja fertet duođáštit ahte dohkehat daid ovdal go
beasat viidáseappot installašuvnnain. Jus dus lea rabas prográmma, sáhtát dávja gávdnat
liseansaeavttuid jus neavvolinjás deaddilat  Hjelp > Om (prográmmanamma). 

Jus geavahat Windows dahje Macintosh vuogádagaid, de fertet daid ovddas máksit
liseanssa. Dása lassin fertet máksit liseanssa máŋga geavaheaddjiprográmma ovddas, omd.
Microsoft Office. Dávjá don it eaiggat ge prográmma, muhto dušše láigguhat vuoigatvuođa
dan geavahit vissis eavttuid mielde. Ja jus it čuovu eavttuid, de sáhtát ráŋgastuvvot, jus omd.
máŋget prográmmá ja attát dahje vuovddát dan earáide. Dus ii leat vuoigatvuohta rievdadit
prográmma, ii ge vejolašvuohta ge, go koda mii leat prográmma duohken lea čiegus.

Lea muđui dievvá liseanssaid ja vuovdineavttuid. Dá leat moadde:

Freeware: Prográmma mii lea nuvttá ja maiguin sáhtát dahkat maid háliidat.

Shareware: Prográmma maid sáhtát geahččalit nuvttá, dan maŋŋil bivdojuvvot registreret
iežat ja máksit liseanssa. Muhtin prográmmat leat maiddái nuvtttá priváhta geavaheapmái.
muhto fitnodagat ja ásahusat fertejit máksit. (Omd. WS-FTP-LE, Zone Alarm).

Adware: Prográmma lea nuvttá veršuvnnas mas lea máinnus, muhto fertet máksit jus háliidat
veršuvnna máidnosa haga, (Omd. Opera). 

Demo: Sáhtát geahččalit prográmma muhtin áiggi, muhto dalle heaitá doaimmaheamis jus it
leat máksán. Muhtin variánta demos lea ahte beasat geavahit dušše muhtin oasi prográmma
doaimmaid, omd it sáhte vurket fiillaid maid ráhkadat. 

Dát leat dušše moadde ovdamearkka, gávdnojit vel máŋga variántta ja kombinašuvnna. 

Linux ja muhtin eará operatiivavuogádagat leat huksejuvvon áibbas eará prinsihpaid mielde;
rabas gáldokoda (open source). Eanáš prográmmat mat gávdnojit Skuvlalinux skearrus,
juohkejuvvojit liseanssa GPL - General Public Licence mielde. (Eambbo GPL birra
kapihtalis 7.2.)  Liseansaeavttut sihkarastet geavaheaddji vuoigatvuođa geavahit, máŋget,
juogadit, iskkadit ja rievdadit  prográmma. Prográmma galgá dušše juogaduvvot ovttas
gáldokodain, ja dat gii rievdada prográmma ferte maid diktit rievdadusaid gáldokoda leat
almmolaččat olámuttus. 

Dát liseansaeavttut dagahit ahte Skuvlalinux sáhttá ieš jorgalit prográmmaid
sámegillii ja dárogillii,  jearatkeahttá ovttasge. Ii oktage leat vel jorgalan Windowsa
sámegillii. Jus muhtin háliidivččii ieš dahkat dan, de ii oaččo, danin go ii beasa
prográmmakodaid sisa.
 

6. OPERATIIVAVUOGÁDAGAT
Operatiivavuogádat (operating system) lea prográmma mi sisttisdoallá vuđolaš doaimmaid
maid dihtor dárbbaša vai doaibmat. Lea operatiivavuogádat mii jorgala du gohččumiid
mašiidnakodan ja doaibmá dego johtplatpolitiijan, nu ahte guokte prográmma eai bilit nuppi
nubbái, omd. dakko bokte ahte čállet garraskerrui oktanaga. 

Mii jurddašit dávjá ahte Operatiivavuogádat lea vuosttaš prográmma mii biddjo
dihtorii., omd. Windows, Mac dahje Linux. Muhto ovdal go beassá dan rádjái, lea vel
vuođoleabbo prográmma, BIOS. 
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6.1. BIOS
BIOS (Basic Input Output System) lea buot vuosttáš prográmma mii álgá go álggahat
dihtora. BIOS lea integrerejuvvon biires muhtin unna birccošis dihtora váldokoarttas. Dat
dagaha ahte šaddá oktavuohta doaimmára, boallobeavddi ja garraskearru gaskkas, nu ahte
šaddá vejolaš installeret ja maŋŋil vuolggahit operatiivavuogádaga. 

Geahčal álggahit dihtora guorus diekeahtain diskeahtastašuvnnas. Dalli it beasa nu
gugkás go operatiivavuogádahkii. Visot maid oainnát vilges čállosiin čáhppes šeapmas
boahtá BIOS:s. 

Ovdal lei dušše vejolaš lohkat BIOS:s, ii ge rievdadit dan, muhto ođđa dihtoriin lea
vejolaš muhtin muddui rievdadit BIOS:a. Oaidnin dihte BIOS:a stellemiid ja vejolaš rievdadit
daid ferte (dábálaččat) deaddilit vissis boalu dakkaviđe go lea álggahan dihtora. (Dábálaččat
dát lea Delete-boalu, muhto sáhttá maiddái leat omd. F1, dán oaidná šearpmas go álggaha
dihtora.) Ovdal go rievdada juoidá BIOS:s lea dehálaš čállit mo lei ovdal rievdadusaid, nu
ahte sáhttá stellet ruovttoluotta jus dárbbašuvvo.   

Sáhttá maiddái viežžat ja ođasmahttit BIOS:a prográmma. Dalle ferte háhkat sierra
prográmma dasa ja álggahit dihtora diskeahtas dahje CD:s

6.2. MÁŊGA VUOGÁDAGA
Gávdnojit máŋga operatiivavuogádaga dihtoriid ovddas. Dábáleamos operatiivavuogádat lea
dál Windows, muhto gávdnojit máŋga molsaeavttu. Muhtin vuogádagat leat áigá juo historjá,
nugo CP/M, DR-DOS ja Minix. Earát leat jávkame, dahje doibmet dál dušše fal vissis
erenoamáš doaimmain, nugo MS-DOS ja OS2. 

Boarráseamus vuogádat mii ain lea ollu anus lea UNIX, ja dát lea dađistaga ožžon
máŋga maŋisboahtti, daid gaskkas Linux, Solaris ja BSD. Macintosh lea muhtin
geavaheapmái šaddan dehálaš hástaleaddjin Windowsii, erenoamážit gráfalaš buvttadeamis. 

Go installere ođđa operatiivavuogádat, oažžu  ollu eambbo go dušše ieš
operatiivavuogádat, go dain leat ollu eará prográmmat integrerejuvvon. Danin lea otne váttis
earuit ieš operatiivavuogádaga ja muhtin geavaheaddjiprográmmaid.

Muhtin operatiivavuogádagat leat nu čadnon mašiidnagálvui (hardware) ahte dihtor ii
sáhte atnit eará vuogádagaid. Dán rádjái ii leat sáhttán atnit DOS/Windows-prográmmaid
Mac-dihtoris ja nuppe láhkai, muhto dát lea dál rievdadeame. Linux sáhttá baicce sihke
PC:as ja Mac:as.

Máŋggas jurddašit ahte sidjiide lea eambbo go doarvái lohkat ovtta
operatiivavuogádaga. Muhto lea operatiivavuogádagain nugo gielain. Go máhttit eanet, de
mii sáhttit gulahallat eanet olbmuiguin / prográmmaiguin. Nugo gielain lea ollu mii
operatiivavuogadagain lea oktasaččat. Dan maid lea oahppan ovtta vuogádagas sáhttá dávjá
ávkkáštallat nuppis. Go mii oaidnit eanet vugiid mo dahkat / dadjat juoidá, de mi oažžut
maiddái čieŋaleabbo ipmárdusa. 

Lea čielga oktavuohta dan gaskkas makkár nákca (kapasitehta) dihtoris lea ja makkár
operatiivavuogádaga dáhje veršuvnna dat sáhttá geavahit.  Jus dus lea logi jagi boares dihtor,
ii ábut geahččalit ge installeret Windows  XP, Mac OS-X, ii ge stuorimus Linux-veršuvnnaid
dasa. Fertet iskat man stuora muitu, man alla frekveansa ja man stuora garraskearru dus lea
ja vearddidit gáibádusaid ektui mat operatiivavuogdagas lea. Windows XP gáibida dasa
lassin maiddái ođđaset CPU, go dárbbaša muhtin mašiidnakoda mii lea das.
Vaikko du dihtor lea beare unni geavahit ođđa prográmmaid iešheanalaš dihtorin, lea vejolaš
ahte dat sáhttá doaibmat bures muhtin báikkálaš fierpmádagas, mas lea Linux bálvvás.
Fierpmádagas galgá sáhttit geavahit Linux velá dihtoris nugo 16 MHz 386.
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6.3. PARTIŠUNEREN JA FORMATEREN
Juohke garraskearru ja diskeahtta ferte formaterejuvvot ovdal go sáhttá atnit dan masage.
Formatteren mearkkáša organiseret skearru nu ahte lea vejolaš vurket dieđuid dasa ja
gávdnat daid fas. 

Lea dábálaš juohkit garraskearru unnit osiide. Dát gohčoduvvo partišuneren, ja
iešguđetge operatiivavuogádagain leat muhtin muddui iežálágán partišunerenvuogit.
Partišuneren Linuxas lea omd. áibbas earálágan go Windowsas. Sáhttá leat moadde
operatiivavuogádaga seamma garraskearrus, iešguđetge partišuvnnas. 

Sihke formatteren ja partišuneren sihkku dábálaččat visot mii lea vurkejuvvon diskii.
Váldonjuolgadussan ferte partišuneret ovdal go formatere. Muhtin eavttuid vuolde ja muhtin
erenoamáš prográmmaiguin sáhttá leat vejolaš rievdadit partišuvnnaid almma massakeahttá
dáhtaid. Jus galgá geahččalit dan, berre ovdalgihtii sihkarvuođa dihtii máŋget visot mii lea
vurkejuvvon garraskerrui. 

Go gávppis oasttá olles dihtora, lea dábálaččat garraskearru formaterejuvvon ja
operatiivavuogádat installerejuvvon. Jus háliidat molsut eará operatiivavuogádahkii, lea
vejolaš ahte fertet ieš formateret ođđasit,  jus formaterenvuohki mii lea geavahuvvon ii heive
du operatiivavuogádahkii.  Jus dušše oasttát ođđa garraskearru, dat jáhkkimis ii leat
formaterejuvvon, ja dalle fertet formateret ovdal go sáhtát installeret operatiivavuogádaga. 

MS-DOS ja Windows várás leat golbma formáhta:
FAT 16: MS-DOS, Windows 95
FAT 32: Windows 98 ja 2000
NTFS: Windows NT, 2000 ja XP 
Valdonjuolggadussan sáhttá ođđa formáhtas lohkat fiillaid mat leat ráhkadan boarrásat
formáhtain. Nuppi guvlui sáhttá leat váttis jus ii leat listalleren sierra prográmmaid dasa. 

Linuxa várás leat maiddái golbma váldoformáhta: Ext2, Ext3, Reiserfs. Iešguđetge
formáhtas leat iežat buorit ja heajos bealit, ja muhtin Linux-distribušuvnnaid sáhttá válljet
formáhta go installere. Skuvlalinux geavaha formáhta Ext3. 

Lea vejolaš installeret moadde operatiivavuogádaga ovtta garraskerrui, iešguđet
partišuvnnaid vuolde. Muhtin Linux-distribušuvnnat sáhttet ráhkadit olles Linux-
installašuvnna Windowsa siskkobealde. 

Linux sáhttá lohkat fiillaid DOS:s ja Windowsas liigeprográmmaid haga. Linuxas
sáhttá vurket partišuvdnii mii lea formatterejuvvon FAT:s, muhto ii fal NTFS-partišuvnnaide.
Windows sáhttá dušše lohkat Linux-fiillaid jus lea erenoamáš prográmma dasa. Muhtin
dákkár prográmmat leat ráhkaduvvon rabas gáldokodain, ja sáhttá viežžat daid interneahtas,
omd. Explore2fs (http://uranus.it.swin.edu.au/~jn/linux).

Diskeahtat leat dábálaččat ovdalgihtii formaterejuvvon juogo Windows (IBM) dahje
Mac várás. Linuxas sáhttá geavahit diskeahtaid mat leat formatterejuvvon Windowsa várás.
muhto Windows ii sáhte lohkat diskeahta mii lea formatterejuvvon Linuxa várás.

FUOM: Ale formattere ovdal go dieđát maid dagat, go formatteren jávkada buot
dieđuid mat sáhtášedje leat dan garraskearrus.

6.4. FIILLAT JA OZUT
Buot dieđut mat leat vurkejuvvon dihtoris, leš go garraskearrus dahje diskeahtas, lea
organiserejuvvon fiillain. Fiila sáhttá leat hui unni, omd sáhttá čállit ovtta bustáva muhtin
editoras, lea vejolaš oažžut fiilla mii ii leat go 1 - okta - baita. Dattetge dákkár fiila váldá ollu
eambbo saji garraskrarrus, go juohke fiila váldá unnimusat ovtta sektora, mas leat moadde
KB. Fiila mas leat ollu teaksta ja govat sáhttá leat hui stuoris, omd. moaddelogi MB. Jietna-
ja filbmafiillat sáhtet leat vel ollu stuorát, ii leat absoluhtta rádji man stuoris sáhttá leat.
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FIILANAMMA
Juohke fiillas ferte leat namma, ja namas leat dábálaččat guokte oasi, nugo ovdanamma ja
goargu. 

Ovdal, operatiivavuogádagas MS-DOS, ii sáhttán leat go maksimum 8 bustáva
ovdanamas ja 3 goarggus, ja bustávaid gaskkas ii galgga leat gasku. Sáhtii dušše geavahit
US-ASCII-mearkkaid; nappo ii sáhttán geavahit bustávaid mat eai eat eŋgelasgiel alfabehtas.

Dál sáhttá sihke Windowsas ja Linuxas ja eará operatiivavuogádagain geavahit sihke
guhkit namaid, gaskka ja prinsihpas buotlágan bustávaid. Dát sáhttá doaibmat bures nu
guhká go don leat ovtta dihtora ja ovtta prográmma siskkobealde, muhto sihke gaska ja
erenoamáš bustávat sáhttet dahkat váttisvuođaid go sirdá fiillaid dihtoriid, prográmmaid ja
operatiivavuogádagaid gaskkas. Dalle ferte geahččalit gásttašit fiilla ođđasit, namain mat leat
dušše bustávat eŋgelasgiel alfabehtas. Danin lea buot sihkkáreamus geavahit dušše
engelasgiel alfabehta ja vealtit gaskkaid. Fiillanamat eai ge berre leat beare guhkás (max. 12-
15 bustáva), ja berre leat goargu mii muitala makkar fiila dat lea.  

Dehálaš erohus Windowsa ektui lea ahte Linux dulká unna ja stuora bustávaid áibbas
eará mearkan. Dus sáhttá danin leat muhtin fiila man namma lea linux.txt ja eará man
namma lea LINUX.txt. Buorre njuolggadus lea geavahit dušše fal unna bustávažiid.

Dábálaččat lea dušše okta goargu, muhto Linuxas sáhttá muhtumin leat 2-3 goarggu.
Lea dattetge maŋimus mii lea deháleamus, sáhttá dadjat ahte doaibmi goargu lea dat mii
boahtá maŋimus čuoggá maŋŋil. 

FIILAŠLÁJAT
Gavdnojit máŋgalágan fiillat: prográmmafiillat, teakstafiillat, govvafiilat , jietnafiillat jna.
Máŋga prográmma ráhkadit iežaset fiillaformáhtaid, omd:
- fiillat main leat čabu teaksta: *.txt (Notepad, KEdit ja muhtin eará editorat)
- fiillat main lea formatterejuvvon teaksta: *.doc (MS Word), *.kwd (KWord), *.sxw (Open
Office / Star Office Writer), *.rtf (Rich Text Format), *.pdf (Portable Document Format) 
- govvafiillat: *.jpg, *.jpeg, *.bpm, *.gif, *.tif , *.png
- máilbmefierpmádatfiillat: *.htm, *.html, *.shtml
- jietnafiillat: *.wav. *.mp3

Erenoamážit Windows-geavaheddjiide lea dáhálaš earuhit ASCII-fiillaid ja binára fiillaid,
erenoamážit go sirdá fiillaid internehtii ja interneahtas (FTP). Fiillat main lea čabu teaksta
(omd. *.txt) leat ASCII-fiillat, seamma leat html-fiillat, muhto buot earát leat binára, daid
gaskkas Word-fiillat. Jus teakstafiila vižžojuvvo dego bináran, sáhttet muhtin dieđut jávkat,
omd. linjámolsun. Dalle teaksta sáhttá boahtit ovdan teakstaeditoras oktan guhkkes linján.
Sullasaš čuolbmat sáhttet šaddat jus vurke buhtes teavstta Linuxas ja rahpá dan Windowsas.
Sivva dasa lea ahte linjámolsun kodejuvvo iežálágan dáin operatiivavuogádagain. (Mac:as
lea vel eará kodenvuohki.) Seammaláhkái sáhttá MS Word-fiila billášuvvot jus vižžojuvvo
ASCII:n ii ge bináran. 

Windowsas leat prográmafiillain (executable files) dávjá erenoamáš formáhta, mii
boahtá ovdal goarggus (extension), omd. *.exe. *.bat ja *.com. Das lea hui čielga oktavuohta
fiilašlája ja goarggu gaskkas. Linuxas dát ii leat seamma deahálaš, omd. sáhttá muhtin *.txt-
fiila velá leat prográmmafiila, jus dat lea ožžon lobi dasa (execution permission). Linuxas
gávdnojit maiddái muhtin unna prográmmafiillaža mat leat čállon buhtes teakstan, ja main ii
leat goargu ge (omd.: /etc/fstab). Earáin lea namma mas leat guokte oasi, muhto goargu ii
muital maidege fiilašlája birra. (omd .: /etc/hosts.deny)

Prográmmafiillat mat leat čállon buhtes teavsttas gohčoduvvojit skriptan. Muhto
eanaš prográmmat leat čállon muhtin prorgámmerengielas ja kompilerejuvvon, dat
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mearkkáša konverterejuvvon binára hábmái. Dát unnida prográmma sturrodaga, muhto nuppi
bealde dat gokčá ieš prográmmakodaid.

OZUT
Fiillat leat fas sorterejuvvon ozuin dahje katalogain. (Muhtin vuogádagain gohčoduvvo
máhppan.) Go operatiivavuogádat ja eará prográmmat installerejuvvojit ráhkaduvvo
automáhtalaččat ozut. Dasa lassin sáhtát ráhkadit iežat ozuid gosa bijat iežat fiillaid.
Ohconamain dábálaččat ii leat goargu. Go ieš ráhkadat ohconamaid berret geavahit dušše
eŋgelasgiela alfabehta ja vealtit gaskkaid.

Ohcovuogádat lea oalle iešguđetlagan operatiivavuogádagas.

FIILAGIEĐAHALLANPROGRÁMMAT
Buoremus vuohkki geahččat du dihtora ozuid ja fiillaid lea geavahit
fiilagieđahallanprográmma. Dakkár prográmmain sáhttá ee. ráhkádit, sihkut, sirdit ja
gásttašit ođđasit sihke ozuid ja fiillaid. 

Fiilagieđahallanprográmmat Windowsa várás leat ee. MS Explorer, Norton
Commander ja Windows Commander / Total Commander.   

Linuxa várás leat muhtin dovdus fiilagieđahallanprográmmat Konqueror ja Midnight
Commander. Loga eambbo Linuxa fiilavuogádaga kapihtalis 7.7, fiilagieđahallanprográmma
Konquera birra kapihtalis 8.3 ja Midnight Commander fas kap. 12.1. 

FIILABEASSAN
Dán rádjái mii leat čállán dego juohke geavheaddji beassá dahkat maid son háliida buot
dihtora fiillaiguin ja ozaiguin. Duođaid ii leat nu jus don leat fierpmádagas (eambbo
fierpmádaga birra kapihtalis 11.1) dahje dihtoris mas leat máŋga geavaheaddji. 

Linux, Unix ja Windows NT ja 2000 rájes earuhit hálddašeaddji (administrator, root)
ja geavaheddjiid. Go álggahat dihtora fertet logget sisa geavaheaddjinamain ja
beassansániin. Dušše hálddašeaddjin sáhtát rievdadit dihtora oppsett (konfigurašuvdna),
installerer prográmma, sihkut dahje rievdadit prográmmafiillaid. Go dihtor lea čadnon
fierpmádagas, omd. skuvllas, lea dábálaččat dušše ovttas dahje moattis geat dovdet
hálddašeaddji beassansáni. Jus dus lea iešheanalaš dihtor, de dus ferte dieđusge ieš leat
hálddašeaddji beassansátni, muhto it galgga logget sisa hálddašeaddjin eambbo go
dárbbašat. Dábálaš geavaheamis logget sisa iežat geavaheaddjinamain. Dalle lea unni várra
bilidit juoidá dihtoris. Váikko leat loggen sisa iežat geavaheaddjinamain, sáhtát Linuxas
oažžut hálddašeaddji vuoigatvuođat muhtin prográmmas. Dat oaččut juogo konsollas go
čálát su↵ ja dan maŋŋil hálddašeaddji beassansáni, dahje álggáhat prográmma gohččunlinjás
(Alt+F2) ja das válljet root. Maŋimus vuohki lea čájehuvvon kapihtalis 7.8. 

Guđege fiilii dahje ohcui leat čadnon vissis eavttuid, mat muitalit geain lea
vuoigatvuohta lohkat, čállit dahje vuolggahit fiillaid. Vuoigatvuođain leat juogo várrejuvvon
geavaheaddji várás, vissis joavkui dahje buohkaide. Dábálaččat lea nu ahte jus don leat
loggen sisa iežat geavaheaddjinamain ja čálát teakstafiilla maid vurket iežat guovlui, de
sáhttát buohkat lohkat, muhto dušše don ieš beasat rievdadit fiilla. Earát geat geahččalit
rievdadit fiilla, ožžon dalle dieđuid ahte dat lea čállinsuodjaluvvon dahje „read only“. Sáhtát
lohkat eambbo dán birra makkár vuoigatvuođat leat čadnon fiillaide ja mo rievdadit daid
kapihttaliiin 7.6.(Konsolla) ja 12.1 (Midnight commander).    
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7. OPERATIIVAVUOGÁDAGAT UNIX JA LINUX
Juohke operatiivavuogádagat leat juhkkojuvvon laiggahagaide, nu maid UNIX/Linux. Dás
vuolábealde oainnát UNIX/Linux vuogádaga váldoosiid.

1. Geavaheaddjiprográmmat 
Geavaheaddjiprográmmat leat omd. teakstagieđahallanprográmma ja
fierpmádatlogan. 

2. Vuogádatbálvalusat
Vuogádatbálvalusat leat omd. lássavuogádat ja skálžu, ja maiddái vuogádaga
prográmmerenlakta. 

3. UNIX/Linux-siskkoš
UNIX/Linux-siskkoš lea dat prográmma mii álggahuvvo aibbas vuos go bijat dihtora
johtui. Dat ráhkada oktavuođa mašiinna ja eará prográmmaid gaskkas. 

4. Mašiidnagálvu
Mašiidnagálvu lea garraskearru, CD, šearbma, jna.

7.1. UNIX
Unix lea operatiivavuogádat mii vuosttažettiin lea anus stuora dihtoriin ja
fierpmádathálddašeapmai. Ii leat ollu anus dábálaš PC-ain. UNIX lea ráhkaduvvon nu ahte
máŋga geavaheaddji sáhttet geavahit dan oktanaga ja ovttasbargat. Juohke geavaheaddjis lea
iežas «ruoktoohcu», gosa buot persuvnnalaš fiillat ja heivehusat vurkejuvvojit. Geavaheaddji
sáhttá ieš mearridit jos earáin galgá leat vuoigatvuohta su fiillaid ja ozuid geahččat dahje
rievdadit.

Vuosttáš Unix-veršuvdna ráhkaduvvui USA:s sullii 1970, Bell laboratoriain, mii dalle
lei oassin telemonopolas AT&T (American Telephone & Telegraph Company). Álggo rájes
distribuerejuvvui Unix ovttain gáldokodain. Dat dagahii ahte máŋga geavaheaddji hutke dasa
ođđa «ideaid» ja buoridedje vuogádaga. Ásahusat, main lei Unix-liseansa juogadedje
buorideamiid gaskaneaset. Ovddidanvuohki sulastahtii dan mii otne geavahuvvo fridja
prográmmagálvvu oktavuođas. 

1984 kommersialiserejuvvui AT&T ja sii čavge eavttuid man vuođul Unix
distribuerejuvvui. Dalle gáldokoda ii lean šat fridja seammaláhkai go ovdal. Maŋŋil vuvddii
AT&T Unix liseanssaid mii attii vuoigatvuođa ieš ovdánit prográmma viiddáseappot eará
fitnodagaide, nugo IBM, HP, Sun. Unixa váldoliseanssa oamástanvuoigatvuođa vuvdejuvvui
1992 Novellii, mii fas maŋŋil vuvddii SCO:ii. Dan maŋŋil šattai riidu dan birra mii
fitnodagain lea vuoigatvuohta dahkat maid, ja 2003:s álggii riekteášši SCO ja IBM gaskkas
vuoigatvuođaid birra juogadit prográmmagálvuid main lea Unix vuođđun ja geavahit dan
ovdánahttit Linuxa. Dát ášši lea šaddan dehálaš prinsihppaášši friddja prográmmagálvu
vuoigatvuođaid birra.

UNIX lea leamaš hui dehálaš dihtorprográmmaovdánahttimii ja erenoamážit
dihtorgulahallamii. Omd. lea  fierpmádatprotokolla mii geavahuvvo internehtas (TCP/IP),
čállejuvvon Unix:a várás.

7.2. GNU 
Go UNIX ii lean šat rabas prográmmagáldu, ii ge nuvtta prográmma, šattai dárbu ráhkadit
molsaeavttu dasa. Danin álggahuvvui GNU prošeakta 1984. (Oanádus GNU mearkkáša
“GNU is Not Unix”!) Dan ulbmil lei ovddidit friddja prográmmagálvvu ja seammás
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sihkarastit ahte ii fas galgga prográmmat mat álggu rajes lea friddja sáhttá
kommersialiserejuvvot ja kodat giddejuvvot. 

GNU ráhkadii liseanssa, GPL (GNU General Public License), mii várjala
fridjavuođaid máŋget, iskkadit ja rievdadit prográmmaid. Go muhtun viidásit ovddida
prográmma mii lea GPL vuolde, galgá ođđa veršuvdna dahje ođđa prográmma maiddái
čuovvut GPL-liseanssa.

GNU prošeavtta ulbmil lei ráhkadit ollislaš Unix-lágana vuogádaga mii galggai leat
fridja prográmmagálvu. Buot standárdaneavvut (ja vel eanet) mat gávdnojedje Unix:as lea
GNU prošeakta ođđasit čállán, vai gávdno fridja eavttut Unix:a neavvuide. 

Debian, mii lea Skuvlalinuxa vuođđun, gohčoduvvo Debian GNU/Linux, mii
mearkkáša ahte dat čuovvu liseanssa GPL ja geavaha ollu prográmmaid ja doaimmaid mat
leat ovddiduvvon GNU-prošeavtta bokte.

Várjalan dihtii fridja prográmmagálvvu vuoigatvuođaid lea vuođđoduvvon searvi
FSF - Free Software Foundation.

Sáhtát lohkat eambbo GNU birra dán čujuhusas: http://www.gnu.org. Olles GPL-
liseansa eŋgelasgillii  gávnnat dás: Konqueror > Hjelp > Om Konqueror > Lisensavtale

7.3. LINUX
Maŋŋil go Unix lei kommersialiserejuvvon váillui friddja operatiivavuogádat. GNU-
prošeavtta vuolde lei ráhkaduvvon ollu prográmmagálvu mii sáhtášii geavahit dása. Aidna
mii váillui lei siskkoš. Siskkos lea prográmmaoassi mii álggahuvvo aibbas vuos go bijat
dihtora johtui. Dat ráhkada oktavuođa mašiinnagálvvu ja eará prográmmaid gaskkas.

1991:s ráhkadii suopmelaš studeanta Linus Torvalds vuosttáš siskkosa, ja ođđa
operatiivavuogádat gasttašuvvui maŋŋil su namain. SIskkosa son bijai internehttii ja
seammas son čálii dan GPL vuollái, sihkarastin dihtii ahte sihke siskkos ja buot bargu mii
maŋŋil dahkkoduvvo ovdánahttit dan, galgá leat friddja prográmmagálvu. Farga máŋgas
miehtá máilmmi ledje searvan buoridit ja ovdánahttit siskkosa, ja oanehis áiggi maŋŋil ledje
ráhkadan doaibmi operatiivavuogádaga dainna ahte čatne siskkosa oktii prográmmaiguin
mat ledje GNU vuolde. 

Linux lea huksejuvvon seamma prinsihpaid ala go Unix, ja geavaha maiddái
buorremuddui seamma prográmmaid ja gohččumiid. Linux sáhttá geavahit measta juohke
sajis, buot lágán dihtroriin  (sihke PC ja Mac) ja maiddái eará bierggasiin main lea
datateknologiija. Omd. lea IBM ovddidan diimmu mas lea Linux ja gávdno sihke
satelihttavuostáiváldi ja MP3-čuojaheaddji biilla várás mat leat huksejuvvon Linuxa vuođul.
Nu lea Linuxas ollu govdat geavahanguovlu go Unix. 

Álggu rájes, 1991:s leat čuđiid ja duháhiid olbmot miehtá máilmmi joatkán barggu
maid Linus Torvalds álggahii. Siskkos lea ovddiduvvon ja lea dađistagan ožžon eanet
doaimmaid. Lea álo bargu jođus ovdánahttit dan, nu ahte sáhttá válljet eanet veršuvnnaid
gaskkas. Dábálaš geavaheddjiide deháleamus lea stabila siskkos, muhto
programmerejeaddjit ja sii geat háliidit čuovvut mielde mii lea dáhpáhuvvame sáhttet háhkat
ođđaseamus ovdánahttinveršuvnna. Siskkos maid Skuvlalinux geavaha dál (2004
juovlamánu) lea veršuvdnanummar 2.4.27, muhto ođđaseamus stáđis veršuvdna lea 2.6.12.3.
Jus háliidat diehtit eambbo Linux-sikkosiid ja dáid ovdánahttima birra, sáhtát geahččat dán
čujuhusas:  http://www.kernel.org .

Dan dihte go Linuxas lea rabas gáldu, sáhtet buohkat ráhkadit iežaset Linux-
veršuvnnaid. Lea dušše siskkos ja muhtin eará oasit mat leat oktasaččat buot Linux-
veršuvnnaide. Dan birra leat iešguđetge bargojoavkkut ja fitnodagat huksen
prográmmapáhkat maid sáhtát oastit dahje viežžat interneahtas. Dákkár prográmmapáhkka
gohčoduvvojit distribušuvdnan. Oktiibuot galgá 2005:s leat sullii 150, ja bohtet jámma ođđa. 
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Dá leat dovdaseamus Linux-distribušuvnnat ovttas fierpmádatčujuhusaiguin:  
 
Red Hat http://www.redhat.com
Mandriva http://www.mandrivalinux.com
SuSe http://www.novell.com/linux/suse
Debian http://www.debian.org 
Slackware http://www.slackware.org 
Knoppix http://www.knoppix.com  
Aurox http://www.aurox.org

Distribušuvnnain leat vel veršuvnnat, dađe stuorit nummár, dađe ođđasit veršuvdna, omd.
Mandrake 7.2 ja 9.1, Debian 3.0 jna. Stuorimus distribušuvnnain sáhttet leat gitta 10-15 CD,
dahje moadde DVD, muhto gávdnojit maiddái unnit distribušuvnnat mat čahket ovtta CD:ii
(F.eks. Knoppix ja Skolelinux).  Muhtin leat vel unnit, omd. moadde diskeahta, muhto dat
leat spesialiserejuvvon vissis ulbmiliida. Sáhtát lohkat eambbo Linux-distribušuvnnaid birra
das: http://www.distrowatch.com.

  

7.4. DEBIAN JA SKUVLALINUX 
Debian gullá boarrasaemos Linux-distribušuvnnaide, dat álggahuvvui 1993:s. Debiana
duohken ii leat makkarge kommersiala fitnodat, nugo eanaš eará Linuxa distribušuvnnain,
dušše čuođit eaktodáhtolaš olbmot geat ealljárit barget buoridit ja jorgalit prográmmaid.  

 Debianis lea páhkkavuogádat mii dagaha ahte lea álki viežžat prográmmapáhkaid
interneahtas ja installeret daid. Dát lea dárkkileappot čilgejuvvon kapihttalis 7.8, installerema
birra..

Jus háliidat olles Debian, mii veršuvnnas 3.1 leat 15 CD, sáhtát viežžat dan
interneahtas dán čujuhusas: http://www.debian.org, dahje oastit CD:aid dás:
http://www.linuxbutikken.no. 

Debian deattuha ahte prográmmat galget leat dárkilit geahččaluvvon, nu ahte dat leat
stáđis go geavaha daid. Dan botta go leat ovdánahttime ođđa Debian-veršuvnna, sáhttet
buohkat geat háliidit geahččalit mo prográmma doaibmá. Vuosttaš veršuvnna mii
almmuhuvvo gohčoduvvo stáđihis (unstable). Boahtte veršuvdna gohčoduvvo geahčaleame
(testing). Do dát leat geahččaluvvon muhtin áiggi ja meattáhusat mat leat gávdnon leat
divvojuvvon, de oažžu stáhtusa stáđis (stable). Skuvlageavaheapmái ja dan rádjái go mii leat
bures oahpásmuvvan prográmmaiguin, berret gevahit stáđis veršuvnna. Skuvlalinux geavaha
dušše fas Debiana stáđis veršuvnna. Dát mearkkáša ahte Skuvlalinuxas eat oaččo iešguđetge
geavaheaddjiprográmmaid maŋimus veršuvnnaid, eat ge drivariid buot ođđaseamus
dihtorgálvui. Jus lea muhtin prográmma maid mii erenoamážit sávvat ođđa veršuvnnas, de
mii sáhttit installeret dan erenoamážit. Sáhttá dalle leat dárbbašlaš geavahit nu gohčoduvvon
"backports", mat ortnet heivehemiid ođđa geavaheaddjeprográmmaid ja
operatiivavuogádaga boarraset veršuvnnaid gaskkas. Geahča: http://www.backports.org 
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Skuvlalinux-prošeavtta álggahii searvi "Linux i skolen", mii 2001 mearridii ráhkadit páhka
skuvllaide, gos galgá leat buot prográmmat mat skuvllat dábálaččat dárbbašit. Jurdda lei
maiddái ahte prográmmat galge leat buot Norgga almmulaš gielain.. 

Skuvlalinux lea huksejuvvon Debian GNU/Linux vuođul. Ovttasbargguin
vuođđoskuvllaiguin ja joatkkaskuvllaiguin lea čoahkkán vuogáš prográmmaid ja
jorgalisgoahtán fáluid, gohččumiid ja čilgehusaid. Eanaš prográmmat leat dál olámuttus
sihke ođđadárogillii ja girjedárogillii, ja muhtin prográmmat maiddái davvisámegillii.
Skuvlalinuxa vuosttaš doaimmaid gaskkas lei ráhkadit sámegiel boallobeavdeprográmma.

Jorgaleamit ja boallobeavdeprográmmat mat Skuvlalinux lea ovddidan juogaduvvo
Debianin ja KDE:in. Jus oastá olles Debian-páhka vaikko gos máilmmis, dahje viežžá dan
interneahtas, sáhttá válljet buot gielaid gaskkas masa prográmmaid leat jorgaluvvon,  dáid
gaskkas sámegiella ja dárogiella. Skuvlalinuxas leat golbma jorgalanjoavkku ja vaikko
máŋga prográmma leat jorgaluvvon, báhcet ain prográmmat jorgalkeahttá ja ođđa
prográmmat ja veršuvnnat ihtet dađistaga. Sámegiel jorgalanjoavkkus lea sierra
digástallanjoavku interneahtas,  i18n-sme@lister.ping.uio.no

Skuvlalinux lea álkkidahttán Debiana installerenrutiinnaid ja ráhkadan veršuvnnaid
váldobálvvá, asehisklientabálvvá, bargostašuvnna ja iešheanalaš dihtora ovddas.  

Skuvlalinuxas lea dušše okta CD. Danin eai leat mielde visot maid gávnnat jus oasttát
olles Debian-páhka. Sáhttá leat jierpmas álgit Skuvlalinuxiin, ja de maŋŋil jus lea dárbu
háhkat olles Debian-páhka ja installeret eanet prográmmaid das dahje intreneahtas:
http://www.debian.org. 2004 bođii Skuvlalinuxa veršuvdna 1.0. Sáhtát viežžat maŋimus
veršuvnna dán čujuhusas: http://www.skolelinux.org. Das sáhttá maiddái diŋgot CD
poasttain.  

7.5. X 
X, dahje the X Window System, lea  grafalaš vuogádat mii sárgu dan maid oainnát
šearpmas. Dat doaibma goallusin sissosa (kernel) ja geavaheaddjiprográmmaid gaskkas.
Máŋga gráfalaš geavaheaddjilávttat geavahit X.   

X lea standárda grafálaš vuogádat Unix:as ja Linux:as, muhto gávdno maiddái eará
operatiivavuogádagaid várás. Dás leat moadde veršuvnna. Dábáleamus lea X11, mii
geavahuvvo Unixas ja XFree86, mii geavahuvvo Linuxas. Namma XFree86 čájeha ahte dán
X-veršuvnnas lea rabas gáldokoda, mii X11:s ii leat. Nugo eanaš eará dihtroprográmmaid
XFree86:s lea maiddái ollu veršuvnnat. Skuvlalinux geavaha dál (1.0r1) veršuvnna 4.?. 
 X lea juhkkojuvvon guovtti oassái, mat doibmet dego klientan ja bálván. X-bálvá lea
dat bealli mii stivre mašiidnagálvvu, nugo váldit vuostá signálat boallobeavddis, dulkot
sáhpánlihkádusaid ja sárgut šerbmii. X-prográmmat (nu gohččoduvvon klientat) «muitalit»
de X bálvái maid dat galgá. X-prográmmat geavahit dan bálvvá čájehit sisdoalu sin lásiide.
Gulahallan dáid osiid gaskkas lea ráhkaduvvon nu ahte bálvá ja klienta sáhttet gulahallat
juogo báikkálaččat dahje fierpmádaga bokte. Jus dus lea X-bálvá du dihtoris.lea maiddái
vejolaš vuodjit prográmmaid eará dihtoriin, ja oaidnit daid du báikkaláš dihtoris. Mii sáhttit
dadjat ahte X lea prográmma mii dagaha ahte PC mas lea Linux sáhttá doaibmat
bargostašuvdnan muhtin bálvvá ektui. 
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X lea sorjjasmeahttun operatiivavuogádagas ja dihtorgálvvus. Jus gávdno muhtin
prográmma mii dušše gávdno Unix dahje Linux várás, muhto háliidat vuodjit dan Windows
vuolde, sáhtát Windows-dihtoris čatnat Unix-dihtorii ja muitalit ahte X-bálvá lea du
Windows-dihtoris. De álggahat prográmma Unix-dihtorii ja dán prográmma láse ihtá
Windows-dihtorii.

Sáhttá ráhkadit fierpmádaga gos čatná ovtta gievrras dihtora oktii moatti dihtoriin mat
eai leat nu gievrrat. Gievrras dihtor lea dalle bálvá, ja eará dihtorat leat «asehis klienttat»,
mat eai dárbbaš iežaset garraskearru ge. Klientadihtora diskeahtastašuvdnii bijat erenoamáš
álggahandiskeahta ja álggahat dihtora. Dalle vižžojuvvu minimala Linux vuogádat X:ain
bálvvás ja álggahuvvo. Boahtá sisaloggenláse ja go leat loggen sisa beasat geavahit buot
bálvvá ressurssaid. Prográmmat vuojehuvvo bálvvás, muhto čájehuvvo klientta šearpmas.
Dát lea sivva dasa ahte Linux sáhttá ávkkáštallat boares dihtoriid ja geavahit daid go vuodjá
ođđaseamus ja stuorimus geavaheaddjiprográmmaid.

Go dus lea čállinbeavdebiras nugo KDE dahje Gnome, it baljo oainne X šearpmas,
muhto dat lea dattege das ja lea dábbašlaš vai oaččut oaidnit maid oainnát šearpmas.

7.6. SKÁLŽU / KONSOLLA 
Otne leat eanaš dihtorprográmmat ráhkadan čállinbeavdebirrasiid (desktop environment)
várás, mas mii sáhttit geavhit sáhppána válljet gohččumiid fáluin maid oaidnit šearpmas.
Ovdal lea dábáleappot addit gohččumii boallobevdiin, omd Ctrl+X, Alt+Ctrl+Del ja boalut
F1-F12. Vel boarraset vuohki lea čállit gohččumiid  ng. gohččunlinjái (command line). Dasa
gávdnojit iešguđet doaimmat mat gohčojuvvojit skálžu (shell), konsolla (console) dahje
terminála. 1980-logu rádjái dát lei hálddašeaddji vuohki gulahallat sihke iežas dihtoriin ja
eará dihtoriiguin, operatiivavuogádagain nugo CP/M, MS-DOS ja Unix. Ođđa Windows-
veršuvnnaid dát doaibma lea jávkán, muhto Linuxas dat lea ain ollu anus. Sii geat dovdet
Linuxa bures, geavahit dávjá konsolla gráfalaš lásiid sadjái, ee. prográmmaid installeremii ja
konfigureremii.

Konsolla gávnnat vuollin šearpmas dákkár mearkka vuolde. Go rabat dan, oačcut measta
guorus šearpma. Badjin leat moadde sáni mat muitalit gos don leat, dihtora ja geavaheaddji
nama ja jus don leat vissis ozus. 
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Muhtin prográmmaid mii álgit konsollas ja doaimmahit konsollaláse siste, omd.
fiilagieđaheaddji Midnight Commander, maid mii čájehit kapihtalis 12.1.

Álggaheddjiide sáhttá leat álkimus bargat gráfalaš láses, gos ii dárbbaš muitit
gohččumiid. Dađe eambbo Linux-geavaheaddjid ožžot vásihusa das, dađe eambbo geavahit
konsolla. Go vuos leat oahppan moadde gohččuma, manná jođáneappot bargat das, go
sáhtát álkidit barggu go čálát moadde gohččuma maŋŋalagaid.

GOHČČUMAT
Mii áiggut geahččat moadde álkes gohččuma maid sáhtát dahkat konsollas. Dát gohččumat
leat dávjá eŋgelasgiel sániid oanádusat, ja mii váldt dáid mielde, jo sáhttá leat álkit muitit
gohččumii jus sáhttá čatnat daid masa nu. Buot gohččumiii mii vuolggahit go deaddilit boalu
Enter, maid mii čállit ná: ↵

ls (list)
Oaidnin dihtii mii lea dan ozu sisdoallu, mas leat dál, čálát ls ↵. Jus dalle oaččut fiila- ja
ohconamaid iešguđetge ivnniin, de lea muhtin ivdni ozuide ja iešguđiin fiilašlájain  leat
iešguđet ivnniid. Jus leat loggen sisa iežat geavaheaddjiguovllus, de oainnán álggos dan mii
leat ozus  /home/geavaheaddjinamma.

cd (change directory)
Jus leat iežat ozus, ja háliidat oaidnit mii lea dan olggobealde. čálát  cd .. ↵  (fuomaš gaskka
ovdal čuoggáid) ja don leat ozus /home. Jus dalle čálát cd .. ↵ vel oktii, de leat ruohtasis.
Juohke sajis sáhtát geahččat ozu sisdoalu gohččumiin ls ↵. 
Dál sáhtát mannat muhtin eará ohcui maid oainnát šearpmas, omd. cd usr. Mana fas ohcui  /
usr/bin ja geahča makkar geavaheaddjiprográmmat leat du garraskearrus. 
Sáhtát álkidit njuiket iežat ruovttuohcui jus dušše čálát cd↵

mkdir (make directory) 
Jus háliidat ráhkadit ođđa ozu, čále mkdir ja ohconama. 

rm (remove)
Jus háliidat sihkkut muhtin ozu, čále rmdir ja ohconama. 
Jus áiggut sihkkut fiilla čálát rm ja fiilanama. Fertet dalle juogo leat ozus gos fiila leat dahje
čállit olles bálgá ozus gos leat dan ohcui gos fiila lea.
 
cp (copy)
Jus áiggut máŋget muhtin ozus eará ohcui, čálát cp. Sáhtát juogo mannat ohcui gos fiilla lea
ja čállit ohconama masa áiggut máŋget, omd. cp mifil.sxw /minkatalog. dahje sáhtát leat
ozus masa áiggut máŋget ja čállit bálgá das fiillii. 

df
Sáhtát oaidnit makkár garraskearropartišuvnnat leat ja man ollu sadji doppe lea geavahuvvon
ja olámuttos. Čále df ↵.

su (substitute user)
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Jus leat loggen sisa iežat geavaheaddjiguovllus, it beasa dahkat visot dihtoriin. Jus dus lea
dárbu dahkat juoida mii gáibida hálddašeaddji vuoigatvuođaid, čálát su↵ ja dan maŋŋil
hálddašeaddji beassansáni. Dus soaitá leat dárbu dahkat juoidá eará geavaheaddjin. Dalle
čálát su geavaheaddjinama ↵ ja dan geavaheaddji beassansáni. Go leat geargan bargguin
mii gáibida dáid erenoamáš vuoigatvuođaid, čálát exit↵ ja don leat ruovttoluotta iežat
guovllus iežat vuoigatvuođaiguin. 

OPŠUVNNAT
Gohččumiid lassin mii sáhttit geavahit ng. opšuvnnaid (options), gohččumiid  sadjai dahje
daid lassin. Ieš gohččuma maŋŋil lea dalle gaska, de sárggis ja de moadde bustáva. Mii áigut
čájehit moadde ovdamearkka ja masa sáhttá atnit daid.

ls -l
Dát kombinašuvdna gohččumis ja opšuvnnas čáliha šerbmii doaibmi ozu sisdoalu, ja addá
ollu dieđuid guđege fiilla dahje vuolleozu birra. Mii áiggun geahčadit dan dárkkileappot, go
dás sáhttit oažžut ollu ávkkalaš dieđuid jus ipmirdit dulkot daid.

Mii oaidnit ahte ohcu linuxgirji sisttisdoallá ozu man namma lea govat ja njeallje fiilla. Lea
hálddašeaddji (geavaheaddjinamma root) mii lea ásahan ozu ja fiilla samutd.txt, earát
fiillaid leat svein ásahan. Gurut bealde lea ráidu mas leat bustávat ja sázut. Dat muitalit geain
lea vuoigatvuohta dahkat maid dáiguin ozuguin ja fiilaiguin. Jus buot sajiin lea bustávat leat
ráidu ná: drwxrwxrwx. Jus álggos lea d, dat lea ohcu (directory), jus lea sáhcu, dat lea fiila.
Boahtte golbma bustáva muitalit sáhttá go son gii lea ásahan fiilla lohkat (r - read), čállit (w
– write) ja vuolggahit (x – execute) fiilla, boahtte golbma bustáva muitalit seammá muhtin
joavkku birra ja golbma maŋimus eará geavaheddjiid birra. Mearka x guoská dušše
prográmmafiillaide. Ozus mearkkaša x ahte geavaheaddjis lea lohpi mannat ozu sisa.

Geahča bajimus fiilla, linux032n.sxw. Dán besset buohkat lohkat, muhto dušše fal
svein, gii lea ásahan dan, beassá čállit dasa. Vuolimus fiilla beassá dušše lohkat, ii ovttasge
lea vuoigatvuohta rievdadit dan. 

Jus mis leat máŋga dihtora čadnon bálvái ja máŋga geavaheaddji, de dát vuogádat lea
hui dehálaš. Dat sáhttá sihke sihkkarastit ahte buohkat ožžot vuoigatvuođaid maid sis galget
leat ja ahte earát eai sáhte lohkat ii ge rievdadit dan masa sis ii galgá leat vuoigatvuohta.
Dákkár joavku sáhttá omd. leat buot oahppit muhtin luohkás.

Bargobihttá: Mo šaddá muhin fiilla bustávaráidu, jus dušše don galgat beassat rievdadit,
buot luohká oahppit galget beassat lohkat, muhto ii oktage eará?  
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rm -R
Jus áiggut sihkkut ozu ovttas visot sisdoaluin, fertet geavahit ng. rekursiiva sihkuma. Dalle
geavahat rm -R. Jus áiggut sihkkut olles du ruovttuguovllu, čálát rm -R ~ (Dan ii sáhte
ávžžuhit.)

Muhtin prográmmaid mii álggahit konsollas ja vuolggahit konsollaláse siskkobealde, omd.
fiilagieđaheaddji Midnight Commander, maid mii vuolggahit gohččumiin  mc↵ ja čilget
lagabui kapihtalis 12.1.

7.7. OHCU- JA FIILAVUOGÁDAT
Dihtorfiilla čujuhus mii gohččodit bálggisin (engelsk: path). Windowsas dákkár olles bálggis
sáhttá omd. leat ná: C:\Documents and Settings\svein\My Documents\data\databok.doc
(Sáhtát dieđusge dahkat dan álkibun, muhto dát lea standard vurkenvuohki ođđaset
Windows-veršuvnnain.) Linuxas sullasaš bálggis livččii: /home/svein/data/databok.swd

Windows : Juohke vurkenovttadagas (garraskearru, partišuvnnas, diskeahttastašuvdna dahje
CD-stašuvdna) lea bustáva. Jos áiggut gávdnat fiilla dahje prográmma de fertet diehtit guđe
skearrus dat lea ja olles bálgá dasa. 

Linux: Váldokataloga álgá mearkkain «/». (Sulástahttá buorremuddui  Windowsa «C:\».)
Partišuvnnat ja skearrut čatnojuvvojit dasa ohcun. Ozuid huksehus lea sorjjasmeahttun das
mii garraskearruin fiila lea. 

Erohusa oaidná jus geahččá mii dáhpáhuvvá jos skearru dievvá ja mii fertet lasihit ođđa
skearru.

Windowsas ferte ođđa skearrus lea bustáva, omd. F. Jus áiggut sirdit muhtin
prográmma C-skearrus F-skerrui, de álget váttisvuođat. Go prográmmat leat čadnon oktii
dievva linkaiguin mat muitalit ahte dát prográmma lea C-skearrus. Lea váttis gávdnat ja
rievdadit buot dáid linkaid ja ii leat dorvvolaš. Sihkareamos vuohki sirdit prográmma lea
avinstalleret dan ja installeret fas ođđa garraskerrui. 

Linuxas sáhttit ásahit ozuid mat dárbbašit ollu saji, nugo /usr
(geavaheaddjiprográmmaid várás) ja /home (persuvdnalaš fiillaid várás) sierra partišuvdnan
ođđa garraskearrus ja de sirdit dáid ozuid sisdoalu dohko, Dihtor sáhttá dalle lohkat dáid
fiillaid seamma lahkái go jus livččii ozus mas lea seamma namma boares garraskearrus.

Jus háliidat geahčat iežat dihtora partišuvdna- ja fiilavuogádaga, sáhtát dahkat dan
prográmmas KDiskFree, maid gávnnat ná: K > System > More programs > KDiskFree

Linux-skearru dábáleamus ozut:

/bin binary = vuojehahtti vuđolaš prográmmat
/boot boot = álgaheapmi siskkoš ja álggahanfiillat dáidda
/cdrom cdrom dasa sáhttá čatnat cd-skearru
/dev device = ovttadagat buot ovttadagat (mašiidnagálvu) maid Linux dovdá
/etc etc = feara mii vuogádaga heivehusfiillat, mange av dei kan

endrast manuelt
/floppy floppy disk = diskeahtta dás oainnát diskeahta sisdoallu, jus lea

monterejuvvon
/home home = ruoktu geavaheaddji ruoktoozut, gosa vurket iežat fiillaid
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/lib library = girjerájus buot lágan bibliotehkafiillat; rutiinnat mat leat
oktasaččat máŋgga prográmmaid várás

/lost+
found

billášuvvon  ja ođđasitkonstueren fiillat

/mnt mount = čatnat dasa sáhttá bidjat garraskearruid, cd-rom,
diskeahtaid

/opt optional =lasáhus midlertidige filer (ofte tom), nokre prográmma
geavahit denne for installašuvdnasfiler

/proc processes = dieđut proseassaid ja vuogádaga birra
/root root = ruohtas hálddašeaddji ohcu
/sbin static binary = buot vuođoleamus prográmmat,

heahtteprográmmat
/tmp temporary =

gaskabottosaš
ohcu gos fiillat vurkejuvvojit oanehis áiggis

/usr user = geavaheaddji geavaheaddjiprográmmat
/var variabel = molsašuddi filer som stadig skiftar, bl.a. innkommande post,

dataloggar, skrivarkøer

Go don leat registrerejuvvon geavaheaddjin, de lea automáhtalaččat ráhkaduvvon ohcu: /
home/dunamma

ČATNAN
Linuxas ferte čatnat vurkenovttadagaid ovdal go sáhttá lohkat dain ja vurket daidda. Dát
gusket diskeahtaide, CD:ide, ja eará garraskerruide ja partišuvnnaide go dan gos mii leat go
álggahit dihtora. Ovdal go mii sáhttit váldit dákkár ovttadaga eret fas, omd. váldit diskeahta
olggos diskeahtastašuvnnas, fertet čoavdit dan. Dasa mii geavahit gohččumiid mount ja
umount konsollas, ovttas ovttadaga bálgáin ja čatnanbáikkiin, omd.: mount /dev/fd0 /
mnt/floppy. 

Lea easkka go čoavdá diskeahta ahte dieđut mii lea vurken ohcui /floppy vurkejuvvo
diskehttii. Jus mii váldit diskeahta eret ja vajálduhttit čoavdit, de mii vásihit ahte fiillat maid
jáhkkit ahte leat diskeahtas dattetge eai leat das.

Čatnanbáikkis lea sadji ohcovuogádagas gos ođđa ovttadat oažžu saji, dat lea
dábálaččat juogo njuolga ruohtasis, ozus mnt dahje sierre ozus, mii lea ráhkaduvvon
erenoamážit dán ovttadaga várás, omd. /floppy dahje /cdrom. Sáhtát geahččat gos du
dihtoris iešguđet ovttadagain čatnanbáikkit leat fiillas /etc/fstab. (Sáhtát geavahit omd.
Midnight Commander dása, geahča kapihtalis 12.1)

KDE:s sáhttá ráhkadit jođanisluotta nu ahte sáhttá čatnat ja gálgat ovttadagaid dušše
ovttain spoahkusiin čállinbeavddis. Jođánisluotta diskehttii ráhkadat ná: Spoahkus olgeš
boaluin rabas sadjái čállinbeavddis. Vállje Ráhkát ođđa ja Diskeahttaovttadat.
Ovttadagain válljet /dev/fd0 (/floppy) ja OK. Dalle galgá čállinbeavdái ihtit diskeahttaikon.
Bija sisa diskeahta mas dieđát ahte leat muhtin fiillat, ja spoahkal ikona ala gurut boaluin.
Vállje Čáná. Go galggat čoavdit dagat seammaláhkái ja válljet čoavdde. Sáhtát maiddái
čatnat nu ahte spoahkat gurut boaluin diskeahttaikona ala. Dalle rabat seammás Konqueror,
mas oainnát diskeahta sisdoalu. Seammaláhkái sáhtát ráhkadit jođánisluottaid vai čatnat CD-
stašuvnna ja eará ovttadagaid.

7.8. INSTALLEREN LINUXAS
Ovdal go sáhtát installeret prográmmaid fertet logget sisa root:an dahje dus ferte leat
gaskabottosaš hálddašeaddjivuoigatvuođat (su ↵ + beassansátni konsollas). 
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Jus ovdal leat installeren prográmmaid eará operatiivavuogádagain, sáhttá installeren
Linuxas leat veahá earálágan, muhto go oahpásmuvvá dáinna vugiin, de oaidná ahte dás leat
ollu ovdamunit.

Prográmmafiillat Linuxa várás páhkkejuvvo páhkkain, nu ahte galgá oažžut juste daid
fiillait maid dárbbaša. Gávdnojit moadde páhkkaformáhta, ja berre geavahit formáhta mii
heive Linux-distribušuvdnii. Dábáleamus formáhtat leat rpm, maid RedHat lea ovddidan ja
maid ee. maiddái SuSE ja Mandrake geavahit, ja deb, maid Debian lea ovddidan ja maid
maiddái muhtin eará distribušuvnnat geavahit. Mii galgat dás čájehit installašuvnna deb:in. 

Čájehit álggos mo installeret ieš Skuvlalinux-CD, dán maŋŋil mo sáhttá lasihit eanet
prográmmaid ja ođasmahttiid, dás ja eará CD:in ja interneahtas. Loahpas dán kapihttalis
čilget installerema deb-páhkáin prográmmain Kpackage. 

Lea maiddái vejolaš installeret prográmmaid gáldofiillain, mat dábálaččat
distribuerejuvvojit komprimerejuvvon fiilan, *.tar.gz. Dáinna vugiin sáhttá beassat installeret
ođđaseamos prográmmaveršuvnnaid, mat eai leat vel inkluderejuvvon distribušuvdnii.
Álkimus prográmma mainna rahpat komprimerejuvvon fiillaid lea Midnight Commander,
geahča kapihttalis 12.1.

SKUVLALINUXA INSTALLEREN 
Mo galgá installeret Skuvlalinuxa lea dan duohken lea go dus fierpmádat dahje iešheanalaš
dihtor. Installeremiin válljet čuovvovaš profiilaid gaskkas:
- váldobálvá (server)
- bargostašuvdna (asses klienta)
- ásehisklientabálvá (bálvá X-terminala ovddas)
- iešheanalaš dihtor (ruovttugeavaheddjiide)  

Vuosttáš golbma profiilla geavahuvvo dušše fierpmádagas. Jus galggat installeret
fierpmádahkii, berret geavahit Skuvlalinuxa instrukšuvnna, maid sáhtát viežžat dás:
http://www.skolelinux.org/no/documentation/manuals

Jus galggat installere Skuvlalinuxa ruovttudihtorii, fertet geavahit profiila iešheanalaš
dihtor. Installašuvdnasprosessen lea dál automatisejuvvon , nu ahte ieš installeren galgá
mannat oalle álki, muhto leat muhtin áššit maid fertet ortnet dan maŋŋil vai visot galgá
doaibmat bures.  

Vuosttáš geardde go installeret berret dahkat dan áibbas guorus garraskerrui, mas ii
leat mihkkege mii sáhttá jávkat. Álggat dihtora. Visot maid dál oainnát šearpmas, boahtá
BIOS:s, mii lea gitta dihtorii ja sorjjasmeahttun operatiivavuogádagas. BIOS:a
álggahandieđuid loahppa lea ahte jearra álggahandiskeahta. (Loga eambbo BIOS:a birra
kapihtalis 6.1.)

Ovdal go installeregoađát berret diehtit ahte dál fertet geavahit muhttin
doaibmaboaluis erenoamáš vuogi mielde:
- Sirddat iešguđiid vástádusmolsoeavttuid gaskkas boaluin Tab.
- Merket mossaeavttu maid háliidat gaskaboaluin.
- Vuolggahit dan maid leat válljen Enter-boaluin.
- Go ihtá šerbmii nu guhkes teaksta ahte it sáhte lohkat visot oktanaga, galggat geavahit
njuollaboalu vulos vai oaidnit eambbo. 

Dál bijat Skuvlalinux-CD:a CD-stašuvdnii. Čuovu mielde instrukšuvnnas mii
dađistaga ihtá šearpmas, ala mana viidáseappot ovdal go leat lohkan dan. 

Vuos boahtá eŋgelasgillii: Welcome to Skolelinux. To start installation press
Enter. Sáhtát dál válljet F1 ja oažžut veahki installeremii, muhto jus čuovut dán čilgehusa it
galgga dárbbašit dan. Deaddil fal Enter. 

Dál beasat válljet mii gielaid háliidat geavahit viiddáseappot installeremis. Gielaid
galskkas leat sihke ođđadárogiella, girjedárogiella ja sámegiella.
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Dan maŋŋil oažžut gažaldaga makkár boallobeavdi galgá leat. Jus dus lea dárogiel
boallobeavdi, fertet dás válljet dárogiella, vaikko mii gielaid áiggut čállit maŋŋil.
Boallobeavdeprográmma sámegiela dahje eará gielaid várás ortnet maŋŋil installerema.

Muhtin šearpmagovaid mat ihtet installeremis eai leat makkárge válljenvejolašvuođat,
fertet dalle dušše duođáštit Enter-boaluin ja joatkit. Skuvlalinuxas ohcá
installerenprográmma ieža dieđuid du bierggasiid birra, ja heiveha omd. šearpma ja
sáhppána nu ahte it dárbbaš beroštit das. Dát gohččoduvvo "Plug and Play".
Installerenprográmma partišunere automáhtalaččat garraskearru. Dál biddjojuvvojit
prográmmapáhkaid garraskerrui, rahpojuvvojit, ja Linux-siskkoš ja álggahanprográmma
GRUB installerejuvvojit. 

De rahpasa CD-lođa ja CD boahtá olggos. Divtte dan leat, dat manná sisa fas go
dárbbašuvvo. Oaččut dieđu Fullfør installasjon ja reboot. Deaddil Enter. Dihtor álggaha dál
ođđasit ja addá dieđu CD-skánnema birra. Vuorddát dassái go bivdojuvvot addit
beassansáni root:ii ja iežat geavaheaddjinama ja beassansáni. Installašuvdnaprográmma ii
jeara go root ja ovtta geavaheaddji. Vejolaš eará geavaheddjiid sáhtát lasihit maŋŋil. Čális
beassansániid ja bija daid dorvvolaš sadjái. Ale luohte ahte muittát beassansániid. 

Muhtin bottu maŋŋá ihtá Skuvlalinuxa sisaloggenláse (localhost). Dása čálát iežat
geavaheaddjinama ja beassansáni. Jus visot manná bures, galggat dál oažžut šerbmii KDE:a
čállinbeavdi. Gasku šearpmas galgá leat Desktop Settings Wizard. Dá leat 5 ceahki, muhto
sáhtát mannat njuolga daid čađa rievdatkeahttá maidege. Sáhtát rievdadit maŋŋil jus háliidat.

Dál galggat sáhttit geavahit KDE ovttas muhtin geavaheaddjiprográmmaiguin,
boallobevddiin ja sáhppániin. Go leat ollen deike lea buorre oahpásmuvvat
čállinbeavdebirrasiin KDE ovdal go manat viidáseappot.(Geahča 8. kapihttala) 

Dat mii dál báhcá lea oažžut oktavuođa olggoldas ovttadagaiguin nugo čálán ja
internehtii. Mii eat galgga čilget dan dárkkileappot dás, dušše namuhit ahte čálána sáhtát
heivehit KDE bokte: Kontrollsenter > System > Utskriftsbehandlar. 
Vuđolaš heiveheami fertet dahkat hálddašeaddjin, dan maŋŋil ferte heivehuvvot
geavaheddjiide iešguhtege geavaheddjikontos. 

LÁSSEPROGRÁMMAID INSTALLEREN
Olle guhkás Skuvlalinuxa prográmmaiguin. Muhto dađistaga eanaš geavheaddjit áaddet
sávvat eanet prográmmaid dahje ođđaset veršuvnnaid, ja daid sáhttá installeret juogo CD:s
dahje interneahtas. Dál áigut geavahit Debiana vuogádaga viežžat ja installeret deb-páhkáid.

Deb-páhkká lea fiila maid sisttisdoallá dan maid dárbbašat installeret muhtin
prográmma (application) dahje dieđuid maid prográmmat sáhttet geavahit, nu gohčojuvvon
bibliotehkka (library). Páhkáid namaid leat huksejuvvon ná: Álggos boahtá ieš páhká namma
(dávjá seamma go prográmmanamma), dan maŋŋil prográmma veršuvdna, de páhká
veršuvdna ja loahpas .deb. Ovdamearka: cupsys_1.1.14-5.deb. Dá lea čálánprográmma
cupsys veršuvnnas nr. 1.1.14, ja páhká 5. veršuvdna. Ieš prográmma lassin, sisttisdoallá
juohke páhkká nu gohčoduvvon metadieđuid, ee. dan birra makkár eará páhkár dárbbašat jus
dát prográmmama galgá sáhttit doaibmat ja jus lea vejolaš ahte eará páhkát sáhtet leat dán
páhká vuostálágaid.

Gávdnojit iešguđet vuogit maiguin mii sáhttit viežžat páhkáid ja installeret daid
garraskerrui. Konsollas dahje gohččunlinjás sáhttit geavahit dpkg, dselect dahje apt-get.
KDE:s mii sáhttit geavahit Kpackage. Lea maiddái vejolaš ovttastahttit muhtin dáin vugiin.
Dá leat veahá dieđut iešguđege vuogi birra:

dpkg - lea Debiana originála vuogádat páhkkágieđahallamii ja konfigureremii. Vuojeduvvo
gohččunlinjás dahje iešguđet gráfalaš skálžžuid bokte.
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dselect - lea gráfalaš grensesnitt for dpkg, maid mii vuodjit konsollas. Dáinna sáhttit ohcat
páhkáid mát leat olámuttos, lohkat dieđuid daid birra, válljet páhkáid maid háliidit installeret
dahje avinstalleret. Ávzzuha maiddái dárbbašlaš liigepáhkáid ja ved avinstallering váruha
dan vuostá ahte eará prográmmat sáhttet billašuvvot jus mii sihkkut oktasaš elemeanttaid.

apt-get lea prográmma gohččunlinja dahje konsolla várás. Dáinna sáhttit válljet gáldu mas
viežžat páhkáid, ođasmáhttit listtu mii čájeha páhkáid mat leat olámuttos ja gohččut dpkg
installeremii. Jus lea váttisvuođat dan dihte go dát páhkká lea eará eará páhkaid duohken,
ihtá šerbmii váilevaš páhka nama, nu ahte sáhttá divvut listtu páhkáiguin maid galgá viežžat.
Dát lea er erenoamáš ávkkálaš systemáhtalaš sihkarvuođaođasmahttimiidda.

Kpackage lea KDE-skálžu dpkg ja apt-get badjel. Dán gávdna dás K > System >
Pakkebehandlar. Gurut láses sáhttá válljet dáid gaskkas: Installert, Oppdatert, Ny ja Alle.
Mii mannat molssaektui Alle, ja sáhttit guovlat sihke páhkáid mat leat installerejuvvon
garraskearrus ja dat mat leat olámuttos installerema várás. Mii oaidnit maiddái man stuoris
páhkát leat ja makkár veršuvdna lea. Jus mii merket muhtin páhká, de oažžut olgeš lásii
dieđuid dán prográmma birra. 
 

Geahčas dáid páhkáid. Jus buot páhkkánamaid ovddabealde lea seamma ikona, de eai leat

dás installerekeahttes páhkát olámuttos. Muhto jus muhtin páhkás eará ikona sádjái lea N,
de dát páhkká ii leat installerejuvvon ja dan mii sáhttit dahkat Kpackage:s. Jus háliidat muhtin
páhká mii lea merkejuvvon N, merket dan fiilla kolonnas Merk, ja dan maŋŋil spoahkat
vuolimusas, gos lea čállon Installer merka. Dalle oaččut konsollii dieđuid mii dáhpáhuvá.
Loga dan dárkkilit, go deike sáhttá boahtit čilgehus jus installašuvdna ii menestuvvan dahje
jus dárbbašat installeret eanet páhkáid vai prográmma galgá doaibmat.

Gávnnahin dihte lea go mis muhtin prográmma vai ii leat, sáhttit mannat dohko: Fil > Finn
pakke.  
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Jus eat leat vel gávdnan prográmma, fertet ohcat olggoldas gálduin, omd. CD:in dahje
interneahtas. Gáldut mas mii galgat ohcat prográmmapáhkáid, fertejit leat čállon muhtin fiilii
garraskearrus, man namma lea sources.list.  

Vai beassat doaimmahit prográmmafiillaid, ferte leat hálddašeaddjin muhtin áiggi.
Deaddil Alt+F2 rahpan dihtii gohččunlinjjá. Čále prográmma maid háliidit geavahit
redigeremii, dán háve kedit. Mana Alternativer:i, merke Sjekk inn som annen bruker ja
čále root. Vuolimus gieddái čálát hálddašeaddji beassansáni ja spoahkat Kjør. 

Dái oaččut Kedit šerbmii. Deike vieččat  /etc/apt/sources.list. Dát sáhttá omd leat dákkár:

Buot linját dán fiillas leat čujuhusat gálduide mas sáhttá viežžat prorgámmapáhkaid. Leat
njealjjelágan gáldut: file (báikkálaš fiilavuogádat), cdrom, ftp dahje http. Guokte maŋimus
mákset ahte mii viežžat interneahtas. Go linjá álgá deb:in, dát gáldu lea rabas viežžamii, go
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álgá  #deb:in, dat lea gaskabottosaččat giddejuvvon. Dán háve galgat diktit buot linjáid leat
giddejuvvon  #-mearkkain. Bija # daid linjáid álgui mas ii leat. De vurket fiilla.

Áigut vuos gahččalit CD:s. Jus leat installeren Skuvlalinux-CD:a lea vejolaš ahte it leat ožžon
buot dan prográmmaid mielde, go muhtin prográmmat leat duše jurddašuvvon vissis
installerenprofiilaide. Mii ohcat danin álggos Skuvlalinux-CD:s. Mana konsollii,  čále su ja
hálddašeaddji beassansáni. De čálán apt-cdrom add. CD čatná ieš. Oaččut máŋga dieđu
šerbmii, ee. okta dahje moadde linjá mat dál automahtalaččat leat biddjon fiillii /
etc/apt/sources.list. Vuolimusas jáhkkimis lea čállon Repeat this process for the rest of the
CDs in your set.
Dál čálát apt-get update.    
Dalle galggat oažžut dán dieđu:
Reading Package List... Done
Building Dependency Tree... Done

Du dihtor lea dál skánnen  CD-skearru ohcan dihte makkar installerekeahttes páhkát das leat.
Dál sáhtát mannat ruovttoluotta Kpackage:i, ja geahččat mii dál lea olámuttos. Jus manat

Alle:i, sáhtát geahčastit buot páhkáid. Jus oainnát páhká merkejuvvon  N, dat lea páhkká mii
lea dán CD:s, muhto mii ii leat installerejuvvon du dihtorii. Jus oainnát páhká merkejuvvon

U, dat lea páhkká mas CD:s lea ođđaset veršuvdna go du dihtoris lea. Daid gávnnat maiddái
Ny ja Oppdatert vuolde. Sáhtát dál merket páhkaid maid haliidat ja spoahkat Installer
merka. Dalle ihtá ođđa láse mas oainnát makkár páhkár leat válljen. Jus leat eanet páhkát go
dan maid válljejit, dat lea danin go muhtin prográmmat maid leat merket leat eará páhkáid
duohken jus galget doaibmat. Spoahka installer. Dál dát prográmmat galget installerejuvvot.
Čuovu mielde šearpmas makkar dieđut ihtet.   

Sáhtát seammaláhkái installeret eará CD:in main leat deb-páhkát, omd. CD:t mat leat
olles Debian-páhkás. 

Jus it gávnna maid háliidat CD:s, sáhtát ohcat interneahtas. Mana vuos dohko:
http://www.debian.org ja geahča gávnnat go doppe páhká maid ozat. Jus gávnnat, sáhtát
viežžat dan iežat garraskerrui. Ráhkat dalle sierra ozu dušše dbianpáhkáid ovddas, vurke
páhkáid dohko ja bija bálgá dohko fiilii sources.list, omd:
deb file:/home/brukarnamn/deb. Dan maŋŋil sáhtát installere dáid páhkáid Kpackage :in
(File > Open), gávdnat ozu ja merket fiilla maid áiggut installeret.

Eará vuohki lea mannat njuolga interneahtta-bálváide main leat debian-páhkát. Dat
gávdnojit máŋga riikkas, ganneha geavahit lagamusa. Fiilii sources.list sáhtát, jus ii leat juo
doppe, čállit dáid linjáid:
deb ftp://ftp.skolelinux.no/debian woody main contrib non-free
#deb http://ftp.no.debian.org/debian woody main contrib non-free 
(Mii váldit ovtta gáldu ain hával, vai ii šatta bearehaga.)

Go leat dahkan dan ja vurken, čanat internehttii, manat konsollii (jus dus ii leat juo
hálddašeaddji vuoigatvuođat, fertet dál čállit su ja beassansáni) ja čálát: apt-get update.
Dalle galggat oažžut du dihtorii listtu mii čájeha deb-páhkáid mat gávdnojit dain gálduin
maid son leat bivdán dihtora iskat. Jus dál manat Kpackage:i ja geahčat New, galggat oaidnit
dan listtu ja sáhtát installeret páhkáid maid háliidat, nu go čilgejuvvon ovdal. Fertet doalahit
oktavuođa interneahtain dassái go leat geargan installeremis.

8. KDE
Linuxa várás leat ráhkaduvvon moadde čállinbeavdebirrasa (Desktop Environment), maiddái
gohčoduvvon gráfálaš láse dahje gráfalaš geavahanlakta. (user interface) Dat sulástahttet
sullii dan maid oainnát šearpmas go rábat Windows dahje Mac. Skuvlalinux lea válljen
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geavahit KDE, ja dás mii galgat čilget dan. Eará čállibeavdebirrasat Linuxa várás leat
Gnome, WindowMaker ja Enlightenment. Jus installeret olles Debian-páhka, oaččut sihke
KDE ja Gnome.

KDE doaibmá buot Linuxa distribušuvnnain ja velá eará Unix-lágan
operatiivavuogádagain, ja das lea X11-teknologiija vuođđun. (Geahča kap. 7.5.) KDE:s
sáhtát gávdnat buotlágán prográmmaid; vuogádathálddašeami, fierpmádatloganiid, e-poasta-
prográmmaid, kántorprográmmaid, sárgonprográmmaid jna.

KDE leat juo boahtán máŋga veršuvdnas ja lea jámma bargu jođus buoridit
prográmmaid. Skuvlalinuxas lea 1.0-veršuvnnas KDE 2.2.2. Dán girjji šearbmagovat ja fálut
leat veršuvnna 3.1. mielde. Sáhttet leat muhtin erohusat boarraset ja ođđaset veršuvnnaid
gaskkas. Maŋimus veršuvdna dál (2005 suoidnemánu) lea 3.4. Jus háliidat nu ollu go vejolaš
fáluin sámegillii, de lea buoremus installeret veršuvnna 3.2. 
 

8.1. ČÁLLINBEAVDI
Vuosttaš geardi go rabat KDE maŋŋil go leat ožžon iežat geavaheaddjikonto, boađát
Čállinbeavdeheiveheami ofelaččii (Veiviser for skrivebordsoppsett). Dá válljet omd. Norga
ja davvisámegiella ja eará gažaldagaide sáhtát álggos dušše dohkehit standárd vástadusaid.
Álggos oaččut dušše golbma ikona čállinbeavdái: Ruskalihti, Debian ja Ruoktu.
Čállinbeavddi olggošoaidnu ja ikonat leat čadnon iešguđetge geavaheaddjái, nu ahte sáhtát
ieš heivehit dan nu go háliidat. Čállinbeavddi fárda ja válljenvejolašvuođat moplsašuddet
veahá iešguđetge KDE-veršuvnnaid gaskkas.

Lea ávkkalaš bidjat jođanisluottaid prográmmaide maid mii geavahit dávjá ja
diskeahta, CD-ROM:a ja vejolaš eará garraskerruid čatnamii. Dá lea govva mii čájeha
čállinbeavddi, masa leat biddjon máŋga dakkar ikona.

Galggat dás ovddamearkkain čájehit mo sáhttá bidjat prográmma čállinbeavddái. Mii válljet
prográmma Dárkkistanguovddáš dahje Kcontrol. 

Deaddil vuos olggeš sáhpánboaluin guorus sadjái čállinbeavddis. Vállje dasto ráhkat
ođđa ja Link to application. Láses mii dál ihtá gávnnat oppalaš vuolde gietti mas lea čállon
"Link to application" Dasa galggat dan sadjái čállit "Kcontrol". Dan gurut bealde oainnát
ikona mii sulastáhttá bátnejuvlla. Deaddil dasa ja de boahtá "Vel ikon". Vállje "Systemikon"
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ja "Program" Dál boahtá máŋga ikona man gaskkas sáhtát válljet. Dát leat ordnejuvvon
alfabehtalaččat, ja ozat dassái go gávnnat Kcontrol ja deaddilat dasa. Mii oaidnit dalle ahte
Kcontrol lea daid prográmmaid gaskkas mas KDE:s lea iežas erenoamáš ikon. Mana de
gohččumii Køyr ja Bla gjennom ja oza ozu /usr/bin. Dás oainnat hirbmat ollu prográmmaid
mat leat alfabehtalaččat ordnejuvvon. Mana kcontrol:i ja deaddil dasa. Dan maŋŋil sáhtát
deaddilit guktii OK ja ikon ihtá čállinbeavdái. Geahččal álggahit prográmma ikonas. 

K-FÁLLU
Vuolimusat gurutbealde gávnnat K-fálu. Go deaddilat dán oaččut prográmmafálu dahje K-
fálu :

Jus bijat seavana muhtin linjá ala mas lea čáhppes golbmačiegat, ihtet vel eanet prográmmat.
Bajábealde šearpmagovas mii leat dahkan dan geahččan dihte makkár gráfálaš prográmmat
mis leat. 

Váldofálu bajimusas oaidnit prográmmaid mat leat geavahuvvon maŋimusas. Dan
maŋŋil bohtet buot prográmmaid mat leat olamuttos, ordnejuvvon joavkkuid mielde, ja de
iešguđetge doaimmat nugo ohcat fiillaid, iežat ruovttoohcu, veahkki, girjemearka ja
gohččunlinjá. Buot vuolimus lea olggošloggenfállu, mas sáhttá molsut geavaheaddjinama
dahje jaddadit dihtora. Dađistaga sáhtát ieš rievdadit ieš K-fálu, omd. lasihit ođđa
prográmmaid. Dan mii dahkan nu ahte coahkkalit olgeš boaluin K-ii ja válljet
Menyredigering.. 

Jus deaddilat muhtin prográmma ala, dat álggaha dakkaviđe. Sihke dás ja muđuid
KDE:s lea doarvái coahkkalit oktii. Ii galgá leat dupparcoahkkaleapmi nugo lea dábálaš
Windowsas. Jus čoahkkalat guktii KDE:s, de alggahat prográmma guktii. (Lea maiddái
vejolašvuohta heivehit KDE nu ahte dás maid oažžu duppalcoahkkaleami.)
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PANELLINJÁ 
Muhtin dehálaš prográmmat ja doaimmat leat biddjon njuolga neavvoholgii maid oainnát
vuollin šearpmas:

Dán sáhtát ieš dađistaga rievdadit ja lásihat prográmmaid maid eanemusat geavahat. Sáhtát
maiddái rievdadit mo bohtet maŋŋalagaid ikonat, ja ii leat sihkkar ahte du dihtoris lea juste
seamma láhkái go čájehit dás. Mii čilget dušše daid ikonaid main leat fásta sadji dán linjás. 
Álggos bohtet prográmmaikonat:

Dat lea ikon mainna oažžu čállinbeavddi ovdan, vaikko šearpmas sáhttá leat dievva eará
lásiid. It dárbbaš nappo gokčat, it ge unnidit doaibmi lásiid vai beassat oaidnit ikoniid mat
leat čállinbeavddis.

Dát buktá du konsollii. (Geahča kap. 7.6)

Dás boahtá Konquerorii, maid sáhtát geavahit sihke fiilagieđahallin (kap. 8.3.) ja
fierpmádatloganin (kap. 11.5).
 

 

Dát lea du ruoktoohcu dihtoris, jus coahkkalat dáike oainnát du ruovttoozu sisdoalu
fiilagieđahallanprográmmain Konqueror. 

Dás sáhtát válljet iešguđetge čállinbevddiid gaskas, jus háliidat. Álggos buot njeallje
čállinbeavddi leat ovttalaáganin, muhto sáhtát heivehit daid iešguđetge mállái. 

De boahtá gieddi maid gohčodit neavvolinján:

Dás sáhtát oaidnit mii prográmmaid ja fiillaid leat doaibmame dál ja mannat njuolga daidda. 

Panelalinjá maŋimus ikoniid mii gohčodit vuogádatikonan:
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Golbma čuoldda čájehit prosessora, muittu ja swap:a doaibmá. Swap:s (viididuvvon muitu) ii
lean makkarge doaibma go dát govviduvvui, danin ii oidno dás goalmmat čuolda.

Leavga muitala makkar giella dahje boallobeavdeprográmma mii dál lea doaibmame.
(Geahča kap. 8.2.)

Čuohpusbeavdi vurke buot teakstabihtaid maid čuohpat dahje máŋget bargadettiin. Jus
háliidat liibmet sisa muhtin dain teavsttain, sáhtát coahkkalit dan ikona ala ja geahččat
teavsttaid maid leat čuohpan (dahje álgu jus lea guhkes teaksta). De sáhtát válljet dan maid
háliidat. Čuohpusbeavddi sáhtát ieš heivehit iešguđetge láhkai.

Dás álggahat prográmma Korganizer, mii lea kalendar masa sáhtát bidjat iežat šiehtadusaid
ja plánaid. 

8.2. DÁRKKISTANGUOVDDÁŠ
Go leat installeren Linuxa ovttas KDE:in dahje don leat biddjon ođđa geavaheaddjin, oaččut
standard dahje default veršuvnna KDE:s, mas leat vissis ivnnit, fonttat, čállinbeavdeduogáš
ja vissis ikonat čállinbeavddis ja panelalinjás vuollin. Geavaheaddjin sáhtát rievdadit visot
daid iežat dárbbu ja miela mielde, ja eanaš reivdadusat dagat prográmmas
Dárkkistanguovddáš. Kapihtalis 8.1. čájeheimmet mo sáhttá bidjat Dárkistanguovddáža
čállinbeavdái. Sáhtát maiddái gávdnat dan K-fálus Heivehemiid vuolde. 

5050



Dárkkistanguovddážis leat vaikko man ollu doaimmat, ja mii galgat dušše geahčadit
moaddasa.

RIEVDADIT ČÁLLINBEAVDDI
Dárkkistanguovddáža váldofálus mii válljet Fárda ja fáttát > Duogáš. Vállje árkaleavgga
Wallpaper ja Bla. Dás sáhtát válljet máŋga duogáža gaskkas, dahje sáhtát bidjat sisa gova
mii dus lea, gassaskearrus, diskeahtas dahje CD:s. 
Go leat bisjan sisa ođđa duogášgova, lea vejolaš ahte ikoniid teaksta oidno hejot
čállinbeavddis. Dalle sáhtát rievdadit fontta, sturrodat, čálaivnni ja vejolaš duogášivnni.
Mana dohko: Čállinbeavdi > Fárda. 

Fárda ja fáttát vuolde gávnnat maiddai vejolašvuođa heivehit ivnniid ja fonttaid. Dát
heivehusat váikuhit iešguđetge prográmmat maid vuddjojuvvo KDE vuolde. Dá gávnnat
šearbmaseastana ja ollu eará heivehusaid. Ovdal go eksperimenteregoađát lea buoremus
čállit makkar ledje heivehusat ovdal, nu ahte gávnnat luotta ruovttoluotta.

VÁLLJE GIELA JA BOALLOBEAVDDI
KDE:s sáhttá vállje fáluid giela. Go KDE veršuvdna 3.2. almmuhuvvui 2004:s, ledje 42 giela
maidda fálut ledje jorgaluvvon dan muddui ahte šadde mielde dán veršuvdnii. 
Jus muhtin bearráža miellahtut hupmet iešguđetge gielaid, de sii eai dárbbaš riidalit dan birra
man gillii galget dihtorprográmmat leat, jo iešguhte geavaheaddji beassá válljet man giella
galgá leat su geavaheaddjiguovllus. Sáhttá omd. leat KDE sámegillii, dárogillii ja suomagillii
seamma dihtoris, iešguđetgegeavaheaddjinamas. 

Go leat installeren Skuvlalinuxa dahje eará Linux-veršuvnna KDE:in bohtet álggos
buot gohččumat ja fálut eŋgelasgillii. Danin mii leat dán kapihtalis váldán eŋgelasgiel
gohččumiid mielde. Dá boahtá čilgehus mo sáhtát rievdadit daid omd. sámegillii dahje
dárogillii.  

A.. Válljet fáluid giela
KDE 2.2.2.: K > Preferences > Personalisation > Country & Language > Locale
KDE 3.1.: K > Settings > Control Center > Regional & Accessibility > 

Country/Region & Language > Locale
Riika (Country): Norway (no)
Giella (Language): Northern Sami (se)
Mearkaráidu (Charset): iso10646-1
Deaddil OK. Fertet logget olggoš ovdal go ođđa heivehusat doibmet.

B. Válljet vejolaš boallobevddiid
Jus du dihtor lea ostojuvvon Norggas, de das lea doaivvumis dárogiel boallobeavdi. Jus
háliidat čállit eará gielaid, fertet ortnet nu ahte lea vejolaš válljet daid. Jus du neavvolinjás lea
muhtin leavga, de deaddilat dan ja oainnát makkár vejolašvuođat dus leat. Jus ii oidno
makkárge leavga, fertet doaimmahit dan, ja dan daga ná:
KDE 2.2.2.: K > Preferences > Peripherals > Keyboard > Layout 
KDE 3.1.: K > Settings > Control Center  > Regional & Accessibility >  Keyboard
layout > Kárta
Ovddemus kárta (primary layout) berre leat Norggalaš, (Vaikko čálašit eanemusat
sámegiela dárbbašat vejolašvuođa čállit bustávaid qwx ja mearkkaid < ja >, mat eai leat
mielde sámegiel boallobeavddis). Láses mii lea merkejuvvon Lási karttat válljet
Davvisápmelaš (Norga) ja vejolaš eará boallobevddiiid maid dárbbašat. Go leat merken
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gielaid maid háliidat, deaddilat OK. Sáhtát dál válljet giela go deaddilat leavgga mii ihtá
šerbmii vuollin olgeš bealde. 

8.3. KONQUEROR FIILAGIEĐAHALLIN
Konqueror lea KDE fiilagieđahallanprográmma. Sáhttá maiddái geavahit dan
fierpmádatloganin, dan birra sáhtát lohkat 16. kapihtalis. Dás mii geahččat mo geavahit
Konqueror iskat ja čorget iežamet fiillaid ja ozuid.

Go deaddilat Konqueror govaža, (snapshot) boahtá dát šearbmagovva:     

Dás sáhtát lohkat Konquera doaimmaid birra. Dás leat ollu ávkkálaš rávvagat. (Go čállit
dán, de lea álggos vel veahá eŋgelasgillii, muhto measta visot lea jorgaluvvon sámegillii.)

Jus deaddilat viesu, de boahtá du ruoktoohcu, mii sáhttá leat sullii dakkár:
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Dás sáhtát ráhkadit, sihkkut ja sirdit ozuid ja fiillaid. Sáhtát golggadit miehtá fiilavuogádaga
ja rahpat fiillaid.  Muhtin fiilašlájat (omd. html) ráhpasit Konqueror siste, eará fiilašlájat
rahpet automáhtalaččat prográmma mii dárbbašuvvo vai beasat geahččat fiilla.

Daiguin ikonaiguin neavvolinjás sáhtát válljet háliidat go dakkár šearbmagova maid oainnát
dás bajábealde, mas oainnat ozuid ja fiillaid stuora ikonan, dahje oaččut ozuid ja fiillaid
iešguđetge linjás, mas maiddái leat dieđuid sturrodaga ja dáhtona birra. 

Mannat eará ozuide 

Badjin oainnát golbma njuola:  
Njuolla bajás buktá du ovtta ozu bajás omd. ozus /home/dunamma ohcui /home. 
Njuolla gurutguvlui buktá du dohko go leat leamaš ovdal. 
Jus leat mannan máŋos ja háliidat máhcat ovddos fas, deddilat olgeš njuola. 

Ráhpat fiillaid / ozuid
Bija seavana fiilla dahje ozu govaža ala ja coahkkal oktii gurut boaluin

Ráhkadit ozuid
Bija seavana guorus sadjái ja deaddil olgeš boaluin. Fálus maid dalle oaččut válljet Ráhkat
ođđa ja fas Directory (Ohcu). Boahtá ođđa láse masa čálát ozu nama ja deaddilat OK.

Sihkkut ozuid ja fiillaid
Deaddil olgeš boaluin fiilla dahje ozu maid háliidat sihkkut ja vállje Sihko fálus. 

Ohcat ozuid ja fiillaid
Gurut bealde šearpmas oainnat ohcomuorra. Muhtin ozuin sáhttá leat +-mearka. Dat
mearkkáša ahte dain leat fas vuolleozut. Deaddil + ja oainnát vuolleozuid. Jus deaddilat
muhtin ozu, oainnát dan sisdoalu stuora rámmás olgeš bealde.

Jus it dieđe gokko ohcostruktuvrras muhtin ohcu dahje fiila lea, sáhtát ohcat dan dás:
Neavvut  > Oza fiilla. Jus it dieđe juste fiilla dahje ozu nama, sáhtát geavahit * buhtadusan
amas bustávaide. Govas oainnát ahte ohcá fiillaid mat gusket sárgonprorgámma qcad, ja
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ohcan álgá dás: file:/, dat mearkkáša ahte ohcá olles garraskearrus. Ohcan ádjána veahá
áiggi, jus sáhtát ráddjet ohcama, manná jođáneappot. 

Háliidat omd. geahččat buot fiillaid maid ieš leat čállán ja man fiilanamma sisttisdoallá
"aga", sáhtát ohcat *aga* ja álggahit ohcama dás: /home/geavaheaddjinamma. 

Sirdit ja máŋget ozuid ja fiillaid 
Go galggat sirdit muhtin ozus nubbái, lea buoremus vuohki juohkit šearpma guovtti oassái,
nu ahte dus leat guokte ozu rabasin oktanaga. Mana dalle dohko: Láse > Juoga čájeheami
olgeš/gurut. De rabat ozu mas galggat sirdit nuppi láses ja ozu masa galggat sirdir fas
nuppis. Deaddil fiilla dahje ozu govaža maid háliidat sirdit. Doala boalu vuollin dan bodda
go geasat  govaža ozu ala gosa áiggut sirdit dan. Go dalle luoittat boalu oaččut válljet juogo
máŋget dahje sirdit dan.  

Nubbi, veahá njoazit muhto sihkareabbu vuohki lea merket fiilla mii galgá
sirdojuvvon olgeš sáhppánboaluin, válljet Čuohpa dahje Máŋge. De manat nuppi lásii,
coahkkulat fas olgeš boaluin ja válljet Liibme sisa.

Atte ođđa nama
Merke fiilla dahje ozu olgeš boaluin, vállje "Atte ođđa nama" ja čále ođđa nama dohko.

9. KÁNTORPROGRÁMMAT

9.1. PROGRÁMMAMAPÁHKAT  
Máŋga dihtorfitnodaga leat ráhkadan kántorpahkaid (Office Packets), mat sisttisdollet
deháleamus geavaheaddjiprográmmaid maid dárbbáša kántorbargui, nugo tekstagieđahallan,
rehkenastin ja presentašuvdna. Álggos dát prográmmat ledje áibbas sierra prorámmat, muhto
dađistaga dat leat gorron oktii. Muhtin dáin prográmmaráidduin leat nu gorron oktii ahte lea
váttis earuhit daid.

Linuxa várás gávdnojit moadde kántorpáhka, main leat teakstagieđahallan-,
rehkenastin-, presentašuvdna- ja eará prográmmat. Dasa lassin gávdnojit sihke
teakstagieđahallan- ja rehkenastinprográmmat mat eai leat čadnon oktii eará
prográmmaiguin. 

Skuvlalinux-CD:s leat guokte kántorpáhka: KOffice ja OpenOffice. 
KOffice gullá KDE:ii. Dat ii leat nu stuoris, das eai leat nu ollu doaimmat go omd.
OpenOffice dahje Microsoft Office. Muhto dat sisttisdoallá buot dábálaš doaimmaid maid
dárbbašat kántorbargui dahje skuvlabargui. Stuora oassi KOffice-páhkas lea jorgaluvvon
sámegillii. 
OpenOffice7 lea stuora kántorpáhkka, sullii seamma stuoris go Microsoft Office. Dat
gávdno ođđadárogillii ja girjedárogillii, muhto ii vel sámegillii. OpenOffice sáhttá geavahit
sihke Linux, Windows ja velá Mac vuolde. 

7Almmolaš namma lea OpenOffice.org, ja dát girjjáš lea čállon veršuvnnain 1.0.1.
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Gávdnojit maiddái muhtin eará kántorpáhkat maid sáhttá geavahit sihke Linux ja
Windows vuolde, nugo StarOffice ja EIOffice, ja muhtimat mat gávdnojit dušše Windowsa ja
vejolaš Macintosha várás, nugo Microsoft Office ja Lotus Suite. 
 
Dás mii áigut čilget deháleamus prográmmaid mat gullet kántorpáhkáide KOffice ja
OpenOffice ja muhtin unnit teakstagieđahallanprográmmaid dahje editoraid.

9.2. TEAKSTAGIEĐAHALLAN
Teakstagieđahallanprográmmat leat máŋga dásis. 
Unnimus prográmmain (nu gohčoduvvon editorat) sáhtát dušše čállit oktageardanis teavstta
ovtta čállosiin. Dát geavahuvvo ollu programmeremii, ja muhtin dain leat ávkkálaš doaimmat
programmačálliide main eará teakstagieđahallanprográmmain eai leat.

Stuorit prográmmaiguin oažžu ain eanet doaimmaid, nugo  rievdadit fonttaid, ráhkadit
rámmáid ja tabeallaid, bidjat govaid jna. Muhtin teakstagieđahallanprográmmain lea vejolaš
automáhtalaččat divvut sániid. Dákkár doaibmá gávdno omd. dárogillii ja dál (2005) lea
bargu jođus ráhkadit divvonprográmma maiddái sámegiela várás. 

Dá leat muhtin teakstagieđahallanprográmmat:
Linuxa várás: emacs, vi, Kedit, Kate, KWrite, KWord
Windowsa várás: NotePad, NoteTab+, Write, WordPerfect, Microsoft Word
Sihke Linuxa ja Windowsa várás: AbiWord, Open Office Writer

Linux-prográmmaid gaskkas muhtimat doibmet konsole vuolde, nugo emacs ja vi. Eará
prográmmat doibmet KDE vuolde, muhtin dain sáhttá maiddái geavahit Gnome vuolde.
KDE:s leat prográmmat: KEdit(Text Editor), KWrite (Advanced Editor), Kate ja KWord
(Oassin KOffice). Dain gávdnojit  KWrite, Kate ja KWord sámegillii. 
Gnome várás lea ráhkaduvvon teakstagieđahallanprográmma AbiWord, mii maiddái lea
vejolaš geavahit KDE várás ja velá Windowsa dahje Mac várás. 

Stuorimus teakstagieđahallanprográmma maid sáhtát geavahit Linuxas lea
OpenOffice.org Writer. 

Makkár teakstagieđahallanprográmma galgá válljet lea dan duohken makkár dárbbut
dus leat. Máŋgalágan bargui unna prográmma sáhttá leat seamma buorre dahje buoret go
stuorra. Dábálaččat lea nu ahte dan maid leat oahppan unna prográmmažis sáhtát maiddái
geavahit stuora prográmmas.  

Jus dárbbašat rievdadit skripta, konfigurašuvnna dahje html-fiilla, berret geavahit
unna prográmmaža nugo KEdit dahje Kate.

Mii čilget dás teakstagieđahallama dáid prográmmaid bokte: KEdit, Kate, KWord ja Open
OfficeWriter. Álggos čájehit prográmmaid ja muitalit veahá iešguđet prográmma birra.

KEDIT
KEdit ja Kate gávnnat K-fálus Doaimmaheaddjit vuolde (Skriveprogram, Editors,)
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KEdit lea unna ja oktageardánis teakstagieđahallanprográmma. Dat ii leat buoremus jus
galggat čálihit čappa áššiid báhpáriid, muhto heive bures omd. čállit dieđuid maid maŋŋil
áiggut sáddet e-poastan ja kodet fierpmádatsiidduid html:s.

Go čálát KEdit:s sáhttá leat nu ahte linjá ii botkašuva, muhto joatká guhkit go šeapma
govdodat. Dán sáhtát čoavdit ná: Mana dohko: Innstillingar > Set opp KEdit > Ymse. Bija
Tekstbryting dasa: Vindusbreidda avgjer, ja de coahkkulat Bruk ja OK.  Dán ii galgga
dahkat jus bargá konfigurerenfiillaiguin dahje skriptaiguin. 

KATE
Kate ii leat dán oktavuođas nieidanamma, muhto oanádus: K Advanced Text Editor.

Kate:s lea láse mas leat golbma oasi. Váldogieddái sáhtát čállit ja doaimmahit teavstta, gurut
bealde beasat mátkkoštit iežat ozuin ja vuollin sáhtát geavahit konsolla. Dát kombinašuvdna
lea hui ávkkálaš ee. jus galggat doaimmahit fierpmádatsiidduid.

KWORD

KWord:s lea dákkár govastata, ja sáhtát gávdnat dan juogo vuolimusat KDE-šearmmas
dahje K-fálus, "Kántuvra" vuolde.
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KWord lea oassin kántorpáhkas KOffice, ja das lea ollu stuorát redigerenvejolašvuođat go
editorain nugo KEdit ja Kate. Earret eará sáhttá bidjat govaid sisa tekstii. KWord:s leat
eanaš doaimmat maid sáhttá dárbbašit.  

Dán rádjái lea leamaš čuolbma ahte KWord:s ii sáhte lohkat fiillaid mat leat
ráhkaduvvon muhtin eará teakstagieđahallanprográmmain, omd. OpenOffice. KWord sáhttá
lohkat oktageardánis fiillaid mat leat čállon .doc-formáhtas, muhtto ii sáhte vurket dan
formáhtii. KOffice veršuvdna 1.3., mii bođii 2004, lea muhtin muddui čoavdan dáid
čuolmmaid, muhto dát ii leat vel mielde Skuvlalinuxas. 

OPENOFFICE 
OpenOffice:s leat vel eanet doaimmat go KWord, ja dasa lassin lea eambbo kompatibel eará
prográmmaiguin; sáhttá ee. sihke lohkat .doc-formáhta ja vurket dán formáhtii. Nubbi bealde
OpenOffice ii loga KWord-fiillaid (Ovdal KOffice 1.3 -iskka mo dál lea)

Dál mii álgit teakstagieđahallana. Dalle go muhtin doaimmat leat iešguđetlágánat iešguđet
prográmmain, de mii čájehit erohusa. Sáhtát álggos válljet muhtin
teakstagieđahallanprográmma ja hárjehallat dainna. De sáhtát maŋŋil geahččalit seamma
doaimmaid eará prográmmain.

Oažžun dihte guorus árkka masa čállit sáhtát juogo coahkkulit árkaikona maid
oainnát badjin gohččunlinjás dahje Fiila  > Ođđa . Muhtin prográmmain oaččut dalle
dakkaviđe čállinárkka, KWord:s fertet vuos válljet árkka formáhta. Dalle galggat dábálaččat
válljet A4. 
Go galggat viežžat fiilla mii ovdal lea čállon ja vurkojuvvon, sáhtát coahkkulit dán mearkka:
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dahje válljet álus Fiila  > Raba (File > Open). 

Dál sáhtát čálligoahtit. Jus it dovdda buot boallobeavddi boaluid ja doaimmaid, loga vuos
kapihtala 1.6. 

Bargobihttá: Čále oktageardanis teavstta vaikko man birra, sáhttá leat juogá maid dárbbašat
eará oktavuođas.  

FONTTAT

  
Fonttat dahje «typesnitt» leat čálamearkaráiddut mas buot mearkkain lea seamma stiila.
Muhtin fonta sistisdoallá vissis bustáva- ja merkahivvodaga, dábálaččat čadnon muhtin
kodatabellii dahje oassái das. (Kodatabeallaid birra geahča kapihttala 3.4.)

Álggos bohtet fonttat dološáigásaš girjeprentemis ládjobustávaiguin, go fertii leat
sierra mearkaráiddut omd. vinju bustávaide, bajilčállagiidda jna.  

Čállinmašiinnain lei hui unnán mearkkat. Árbevirolaš «dárogiel» čállinmašiinnas lei
dušše dárogiel alfabehta bustávat, ja juohke bustávas lei dušše okta unna ja okta stuora
variánta. Ii gávdnon árbevirolaš čállinmašiidna mas ledje sámegiel bustávat. Easká IBM:a
kuvlaoaivemašiinnain, 1970-logu gaskamutto rájes, šattat vejolaš ovtta mašiinnas lonuhit
fonttaid, omd. oažžut vinju bustávaid ja iešguđetge alfabehtaid. Dađistaga bođii maiddái
kuvlaoaivi mas ledje sámegiel bustávat. 
  

  
Vuosttaš dihtoriin ii lean eanet go okta fonta, muhto dađistaga lea válljenvejolašvuođat
lassanan golmma láhkái:

* Sáhttá válljet máŋga alfabehta gaskkas ja maiddái bidjat sisa bustávat eará alfabehtain.
Nugo čilggiimet kapihtalis 3.4., gávdnojit guokte váldovuogi mo jorgalit bustávaid
dihtorkodii; 8-bihtá-kodat ja unicode. Dán girjjis geavahit dušše unicode. Dalle ii dárbbaš
sierra sámegiel fonttaid, muhto sáhttá čállit sámegillii dábálaš unicode-fonttaiguin. Eanaš
fonttat mat čuvvot Skuvlalinux leat unicode várás.

* Mii leat ožžon máŋga fontta main leat iešguđet namat, nugo Arial, Times, Helvetica jna.
Máŋga dáin namain bohtet dološáigásaš girjeprentemis. earát fas leat ođđa dihtoráiggis. 

* Dáid šlájaid gaskkas mii sáhttit molsut bustávaid sturrodaga ja válljet buoiddes bustávaid,
vinju bustávaid ja/dahje vuolláisárguma. 

Fonttain leat guokte váldošlája, mat leat čadnon gráfalaš formáhtaide (čilgejuvvo kapihtalis
10.1). Nubbi lea bitmap-fonta, mas mii dárbbašit ođđa font juohke stuorrodaga várás. Nubbi
fas  vektor-fonta, mas mii dáhttit rievdadit sturrodaga (scaleable fonts).   

Leat oalle unnán fonttat mat čuvvot Skuvlalinuxa, muhto lea vejolaš viežžat eanet foanttaid
internett. Bivnomus fonttaid gaskkas leat MS core fonts. Dat distribuerejuvvojit ovtttas
Windows:in, muhto Microsoft ii leat diktán eará operatiivavuogádagaid váldit daid mielde.
Dattetge lea nuvttá viežžat daid interneahtas, sáhttá gávdnat daid máŋga fierpmádatbáikkis,
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ee. http://corefonts.sourceforge.net. Maŋŋil go lea viežžan fonttaid ferte installeret daid, dalle
dárbbaša prográmma msttcorefonts, mii ee. gávdno Debian-páhkas.

Lea stuora erohus teakstagieđahallanprográmmaid gaskkas man muddui sáhtát rievdadit
fonttaid. 

KEDIT JA KATE

Sáhttá rievdadit sihke fontašlája ja sturrodaga, muhto rievdadus váikkuha olles dokumeantta
oktanaga. Dán dahká nie: Heivehusat > Heivehit KEdit/Kate > Fonttat. Kate sámegiel
veršuvdnii lea biddjon geahččaleami makkár fonttat sáhttet čállit sámegiel bustávaid. Go
bláđđe iešguđetge fontttaid čađa boahtá ovdal teaksta: "Doibmet go sámi bustávat:
áčđŋšŧž". Daid fonttaide mat eai leat unicode várás, eai oidno buot sámegiel bustávaid riekta
šearpmas. 

KWORD JA OPEN OFFICE

Sáhtát válljet sihke fontašlája ja sturrodaga, ja sáhttá maiddái merket vissis guovllu ja
mearridit ahte fontaválljen galgá guoskát dušše dán guvlui. Nie sáhttá geavahit máŋga
iešguđetge fonttaid ovtta dokumeanttas. 

Deaddil njuollaboaluid vai gávdnat rievttes fontta ja sturrodaga. Sáhtát geavahit sturrodaga
12 dábalaš čállinbargui, ja stuorát bustávaid bájilčállagiidda ja plakáhtaide.

Dás sáhtát maiddái válljet buoides, vinju dahje vuolláisárgon čállosa:
B (bold - buoidi),   
I (italic - vitnjut )
U (underlined - vuolláisárgojuvvon) 

Bargobihttá: Čále bajilčállaga iežat tekstii. Das galgá leat fonta:

Times - 18, buoidi ja vitnjut 

FUOM! 
OpenOffice boahtá iežas fonttaiguin, muhto jus áiggut geavahit OpenOffice:s maiddái eará
fonttaid mat čuvvot Linuxa, fertet installeret daid erenoamážit OO:i. Dalle manat dohko:  K >
OpenOffice.org > Printer Administration > Fonts > Add. Dás gávnnat fonttaid ozus /
usr/share/fonts.

LOKTEJUVVON JA VUOLIDUVVON ČÁLA:
Dán geavahat go háliidat ahte muhtin bustávat dahje mearkkat galget leat veahá alit dahje
vuolit go earát. Dát mearkkat unniduvvo automáhtalaččat seammás go loktejuvvojit dahje
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vuoliduvvojit. Dát doaibmá lea erenoamáš ávkkálaš go čállá matematihkalaš ja kemialaš
hámuid. 

Merke teavstta mas galgá leat loktejuvvon dahje vuoliduvvon čála.
KWord:s sáhtát dan maŋŋil geavahit nuppi dáin boaluin mat leat neavvolinjás:

Sáhtát maiddái geavahit dán vuogi: Format > Skrifttype > Heva skrift dahje Senka skrift
OpenOffice:s dagat nie:  Format > Character > Position > Superscript dahje Subscript

Bargobihttá: Geavat loktejuvvon ja vuoliduvvon čállaga ja čále: cm3, H2SO4, a2b3.

SÁMEGIEL BUSTÁVAT
Boallobeavddis eai oidno sámegiel bustávat á, č, đ, ŋ, š, ŧ ja ž. Go ii gávdno sierra sámegiel
boallobeavdi, ferte leat sierra prográmma (keyboard driver), mii definere boaluid earáláhkai
go dárogiel dahje suoma-/ruoŧagiel boallobeavdi, vai heivejit sámegiel alfabehtii. Go mii dás
hupmat "sámegiel boallobeavddi" birra, oaivvildit dákkár boallobeavdi mii doaibmá
sámegiel boallobeavdeprográmma mielde. Boalut main lea earálágan doaibma go leat
dárogiel ja sámegiel boallobeavddis leat: Q = Á, W = Š, ^ = Ŋ, * = Đ,  > = Ž, X = Č.
Bustáva Ŧ lea váddásat gávdnat. Fertet doallat boalu AltGr vuollin ja deaddilit T-boalu.
Boallobeavddis sáhtát merket sámegiel bustávaid bábirlihpuiguin dahje tuššain.

It go dieđe lea go dus sámegiel boallobeavdi? Deaddil vuos boaluid merkejuvvon q,w ja x.
Jus du šerbmii boahtá qwx, de dus ii leat sámegiel boallobeavdeprográmma jođus. 
Geahča šearpma vuolimusas olgeš bealde. Oainnát go doppe leavgga? Jus lea muhtin leavga
man alde lea guokte vilges bustáva (omd. Norgga leavga ja "no"), de deaddilat dan ja
geahcat makkár eará válljenvejolašvuođat dus leat. Jus gávnnat Norgga leavga man ala lea
čállon "se", de dus lea Norgga bealde sámi boallobeavdi. 

Jus it gávnna dás sámi boallobeavddi, de fertet viežžat dan. Geahča kapihttal 8.2.
boallobeavddi válljema birra.

SIHKKUT  
Jus háliidat sihkkut juoidá maid leat čállán, sáhtát geavahit ovtta dáin vugiin:
* Bidjat seavána gurutbeallái teavsttas maid áiggut sihkkut, ja sihkkut olgešguvlui Delete-
boaluin. (Dát ii doaimma buot prográmmain, ja Mac-dihtoriin ii leat dakkár boallu.)
* Bidjat seavána olgešbealde teavstta maid áiggut sihkkut, ja sihkkut gurutguvlui Backspace-
boaluin (njuolla njuolga gurutguvlui)
* Merket dán maid háliidat sihkkut ná: Bija sáhpániin seavána dohko gokko áiggut álgit
merket. Deaddil ja doala gurut sáhpánboalu. Sirdde dasto sáhpána dassái go visot teaksta
maid áiggut merket, lea vilggodan čáhppes duogáža ala. Dalle luoittát sáhpánboalu ja
deaddilat Delete-boalu.
* Mana njuollaboaluiguin dohko gos háliidat sihkkugoahtit. Doala Shift-boalu vuollin ja
merke teavstta njuollaboaluiguin. Go leat merken visot deaddilat Delete.

Bargobihttá:  Geahččal buot sihkkunvugiid iežat teavsttas.

SIRDIT 
  Jus háliidat sirdit muhtin teavstta nuppi sadjái dokumeanttas, merket vuos teavstta sáhpániin
dahje njuollaboaluiguin, ja de válljet ovtta dáin vugiin:
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* Bija seavana merkejuvvon teavstta ala ja gease teavstta doaladettiin sáhpánboalu. Luoitte
sáhpánboalu go leat ollen ođđa sadjái. Mana dalle eret merkejuvvon guovllus ja deaddil
sáhpánboalu fas.

* Deaddil skárritboalu  dahje Doaimmat > Čuohpa (Edit > Cut). Dál oainnát ahte
merkejuvvon teaksta jávká. Mana dohko gosa háliidat sirdit, deaddil seavániin dakko ja

deaddil dán boalu:  dahje Doaimmat > Liibme (Edit > Paste).
Nie sáhtát maiddái sirdit teavstta nuppi dokumeanttas nubbái.

Bargobihttá: Sirdde maŋimus linjá iežat teavsttas álgui.

MÁŊGET 
Jus háliidat máŋget oasi teavsttas, merket teavstta sáhppániin dahje njuollaboaluiguin, ja
dagat guobbá:

* Vállje fállolinjás Rediger > Kopier (Edit > Copy) dahje ikona 

Go leat sirdán seavána dohko gosa háliida teavstta, válljet Rediger  > Lim inn (Edit >
Paste).  dahje  

Jus háliidat eambbo go ovtta kopiija, sáhtát coahkkalit Rediger > Lim inn fas. 

* Deaddil boalu Control (Ctrl) ja doala dan dan botta go merket ja sirddát teavstta eará
sadjái. 

Bargobihttá: Merke sáni «Čállit» ja ráhkat dás 5 kopiija. 

LONUHIT SÁNIID
Maŋŋil go leat čállán guhkes teavstta sáhtát fuomášit ahte háliidat rievdadit muhtin sáni.
Dalle manat dohko: Doaimmat  > Buhtte. (Edit > Find&Replace, dahje dušše Replace)
Bajimus ruktui čálát teavstta nu go don leat čállán dan dokumentii, ja nuppi ruvttui fas
teavstta nu go galgá leat. Go deaddilat OK, rievdada dihtor automáhtalaččat buot dáid sániid.
Muhtin teakstagieđahallanprográmmat addet vejolašvuođa válljet háliidat go automahtalaš
rievdadusa vai geahččat ovtta ja ovtta ja válljet áiggut go rievdadit vai it. 
Go leat geavahan automahtalaš lonuheami, berret dárkkistit teavstta ovdal go čálihat dahje
sáddet dan, go lea vejolaš ahte boađus lea eará go dan maid ledjet jurddašan. 

Bargobihttá: Čále bajábealde teavstta "Molsut sániid" rájes. Dás leat guokte geardde «nu».
Don háliidat baicce «dán láhkai». Lonut nu go leat čilgen bajábealde.
 

GÁHTAT   
Jus leat bargan boastut sáhtát oažžut ruovttoluotta teavstta mii dus lei ovdal. Deaddil dán

boalu             dahje  Doaimmat (Edit) ja fas Gađa (Undo) dahje dán boalu: 
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Bargobihttá: Merke moadde linjá teavsttas ja sihko daid Delete-boaluin. Geahččal viežžat
daid ruovttoluotta geavahettiin gáhtandoaimmaid.

 VURKET 
Sáhtát vurket fiilla ná: Deaddil diskeahttamearkka: 

dahje fálus:  Fiila > Vurke (Save).  Dál ihtá govva gosa sáhtát čállit fiilanama (Báiki,
Location, File name) ja válljet kataloga, stašuvnna ja makkár fiilla (Filttár, Filter, File type).
Vállje vuos rievttes kataloga. Dus galgá leat iežat kataloga garraskearrus, man čujuhus galgá
leat /home/dunamma. Čále fiilla nama ja deaddil OK. 
Fiilanamas ii galgga leat gaska!. Fiilanamas berre dušše leat dakkár bustávat mat leat
eŋgelasgiel alfabehtas. Ale ane omd.: ŧ ŋ æ ö š á å ø č ž.
Jus áiggut vurket eará namain dahje eará sádjái, omd. sihke garraskerrui ja diskehttii,
deaddilat Fiila ja fas Vurke nugo (Save as). 

Dábálaččat sáhtát vurket teakstagieđahallanprográmma formáhtii. Muhto jus omd. galgá
vurket dan diskehtii ja ráhpat eará dihtoris, mas leat eará prográmmat dahje velá eará
operatiivavuogádat, berret vurket hápmái maid dan dihtor sáhttá lohkat. Jus it dieđe sihkkarit
makkár prográmma nuppi dihtoris lea, sáhtát válljet Rich text format (*.rtf ).

RÁHKADIT TABEALLA 
KWord: Bija sisa  > Tabealla
OpenOffice: Insert > Table

Dalle ihtá láse gosa galggat válljet galle kolonna ja galle ráiddu háliidat.:

Go deaddilat OK ihtá tabealla maid sáhtát deavdit. Jus háliidat rievdadit muhtin kolonna
govdodaga manat sáhpániin ceakko sáhcui mii lea kolonna olgešbealde, deaddilat
sáhpánboaluin ja sirddát dan dohko gosa háliidat.

Bargobihttá: Ráhkat iežat diibmoplána tabeallan. 

mánnodat distat gaskavahkku duorastat bearjadat
1
2
3
4
5
6
7
8

SÁRGUN

  OpenOffice Writer:s sáhtát maiddái ráhkadit álkes sárgumiid (tevnnegiid).

 Gurut bealde šearpmas lea neavvoholga mas gávnnat dán govaža:
Go deaddilat dan ihtet govusat maid sáhttá geavahit sárggumii  

6262



Mana sáhpániin dohko gosa áiggut sirdit govvosa ja deaddil oktii gurut sáhpánboaluin. Mana
dohko gosa háliidat sárguma. Deaddil fas gurut boaluin ja doala dan vuollin dan botta go
sárggut dahje fánahat hámu dan hábmái ja sturrodahkii maid háliidat. Go leat duhtavaš
dainna, luoittát fas boalu. 

Jus háliidat sihkkut muhtin govvosa, manat dan sisa ja deaddilat sáhpánboalu oktii.
Go ihtet gávcci unna njeallječiegada, deaddilat Delete-boalu, ja govus jávká. 

Bargobihttá: Ráhkat dákkár skovi mii čájeha du iežat bearraša:

 Áhčči     Eadni

 Máhtte               Iŋga Biret Ánte

Kword:s ii leat sullasaš sárgondoaibma, muhto sáhtát geavahit eará prográmmaid Koffice:s,
nugo Kivio ja Karbon14.

ČÁLIHIT 
Go galggat čálihit fertet vuos iskat lea go dus čálándriver mii heive du čálánii, ja lea go čálán
čadnon dihtorii. 
Linuxas lea moadde čálihanvuogi, vuohkáseamus sáhttá leat nu gohčoduvvon CUPS. (Muhto
jus dus lea doaibmi čálán eará vuogádagas, it dárbbaš rievdadit dan.) Jus dieđát ahte visot
lea biddjon riekta ja ahte galggat čálihit olles fiilla, sáhtát mannat njuolga čálánmerkii:  

  

Muđui berret geavhit Fil  > Skriv ut (Print). 
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Juohke teakstagieđahallanprográmmas sáhtát deaddilit Fiila  > Čálit (Print). 

KWord:s ja OpenOffice:s sáhtát máiddái deaddilit čálán-mearkka  . 
Oaččut dalle vejolašvuođa váikkuhit mo čálus galgá leat. Molsašuddá iešguđetge
teakstagieđahallanprográmmaid gaskkas galle molsaeavttu leat, muhto stuorimus
prográmmain sáhtát omd. čálihit dušše oasi dokumeanttas, čálihit seamma dokumeantta
máŋgii dahje bidjat vealu teaksta árkii.

OpenOffice:s ferte heivehit čáláná guhtege geavaheaddjikonto várás: K > OpenOffice >
OpenOffice Printer Administration. Doppe galgá čálána namma leat Generic Printer
(default printer), ja Command galgá leat lp. Jus dát lea boastut, sáhttá divvut dan
Oamástusat vuolde. Geahččal vuos čálihit geahččalansiiddu vai oaidnit doaibmá go visot
bures. 

HEAITTIHIT   
It leat geargan čállinbargguin ovdal go leat gokčan fiilla rievttes láhkái. 
KEdit ii earut fiilla ja prográmma gokčama gaskkas. Jus galggat čállit eará fiillaid dán
prográmmas, vurket fiilla ja divttát dan leat rabasin dan botta go álggahat ođđa dokumeantta.
Easká go it galgga čállit eambbo KEdit:s govččat prográmma ja seammas rabas fiillaid.

Eará teakstagieđahallanprográmmain earuhuvvo fiilla (Fil > Lukk / File > Close) ja
prográmma (Fil > Avslutt / File > Exit) gokčama gaskkas. 

Buot prográmmain sáhtát maiddái heaittihit nu ahte coahkkulat ruossa bajimusas
olgeš čiegas. OpenOffice:s (veršuvdna 1.1. rájes) lea liige ruossa dan maŋŋil. Dáinna sáhttá
gokčat fiilla gokčakeahttá prorgámma. Jus it leat vurken maŋimus rievdademiid maŋŋil,
oaččut dál gažaldaga áiggut go vurket.

Lea dehálaš ahte it jáddat dihtora ovdal go leat vurken visot ja heaittihan buot
prorámmaid. Linuxas it galgga jaddadit dihtora el-rávnnji botkenboaluin, muhto addit diehora
dieđu ahte galgá jaddadit. Heaittit vuos buot rabas prográmmaid, mana de K-fállui, doppe
galgá maŋimus linjás leat “Olggoščáliheapmi” dahje “Skriv “brukarnamn” ut” dahje
sullasaš. 
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9.3. REHKENASTIN

KALKULAHTOR JA MATEMATIHKKAPROGRÁMMAMAT
Leat máŋgalágan prográmmat maid geavahuvvojit rehkenastimii. KDE:as lea dieđalaš
kalkulahtor, man namma lea Kcalc, ja maid gávnnat Neavvut (Utilities) vuolde. 

Skuvlalinux-páhkas leat moadde matematihkkaprográmma skuvlla várás, nugo Kgeo,
KmGraf, Kpercentage ja Kgange.
Linuxas leat maiddái moadde prográmma máiguin čállit matemahtalaš hámut, ee.
OpenOffice Math ja KFormula (Koffice oassin).

REHKENASTINÁRKA
Rehkenastinárka (regneark / spread sheet) lea prográmma mainna sáhtát rehkenastit, čállit
rehketdoalu, ráhkadit statistihkaid, diagrámmaid jna. 
Dovddus rehkenastinárkkat leat omd.
Linuxa várás: KSpread, Gnumeric
Windowsa várás: Lotus 1-2-3, Excel, Symphony, QuatroPro.
Sihke Linuxa ja Windowsa várás: Open Office Calc

Dás galggat geahčadit moadde doaimma guovtti rehkenastinárkkas; KSpread, mii lea
KOffice oassin, ja OpenOffice Calc. Dán prográmmain leat sullasaš doaimmat, nu ahte
čilgehusas sáhttit buorre muddui gieđahallat daid ovttas. 

Čállin, rievdadeapmi vurken jna. dahkko sullii seammaláganin go sullasaš prográmmain
teakstagieđahallama várás, ja dan berret lohkat ovdal go álggát rehkenastinárkkain. 
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Rehkenastinárkkas leat dievva ruvttuid (celler), masa sáhtát čállit teavstta dahje loguid. 
Veallut leat kolonnat, merkejuvvon bustávaiguin: A, B, C jna.  
Ceaggut leat ráiddut, merkejuvvon loguiguin: 1, 2, 3, jna. 
Juohke ruvttos lea čujuhus (adresse), omd. A1, D7, K12 jna.

Sáhtát stuoridit dahje unnidit kolonnaid govdodaga:
a) Badjin rehkanastinárkkas oainnát ránes linjá, gos leat kolonnaid bustávaid: A, B, C,...
Jus sirddát seavána dan linjá miehtá, oainnát ahte seaván rievdá go deaivá ceakko linjáid
kolonnaid gaskkas. Dalle sáhtát deaddilit sáhpanboalu ja sirdit linjá olgeš- dahje gurutguvlui.
b) Deaddil kolonnabustávaid mat čájehit kolonnaid maid áiggut rievdadit. Mana šearpma
nuppi linjái: 
KSpread: Format > Column > Resize column ja čále govdodaga maid háliidat.
OpenOffice Calc:  Format > Columns
Seammaláhkai sáhtát rievdadit ráiddu allodaga.

 Mii čilget rehkenastima ovdámearkkain. 
Dás áigut čállit sisa makkár sisaboahtin ja olggosgolut mis leat leamaš golmma jagis.
Rehkenastinprográmma galgá veahkehit min gávdnat mii lea guđege jagi boađus ja mii lea
oktiibuot sisaboahtin, golut ja boađus.

Raba rehkenastinprográmmas guorus árkka. Deaddil vuos sáhpániin ruvttui B1.
Šaddá buoiddes rámma dan ruvtto birra. Čále dán jagi ja deaddil Enter-boalu. 
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Deavdde seammaláhkai ruvttuid A2-4, B2-3, C1-3, D1-3 ja E1 nugo bajábealde. Dán
rájes mii galggat geavahit formellinjá, guhkes vilges gieddi rett over bokstavane for
kolonnene.
Mana ruvttui B4 ja deaddil sáhpániin dohko, vai šaddá rámma ruvtto birra. Deaddil
formellinjái ja čále dohko  =B2-B3. Deaddil Enter-boalu ja don oainnát ahte B4-ruhtui ihtá
rehkenastima boađus: - 23500. 

Daga seammaláhkái ruvttuide C4 (formel: C2-C3), D4 (formel: = D2-D3) ja E2
(formel:=B2+B3+B4 dahje =SUMMER(B2:D2). Dál jáhkimis ipmirdat vuogádaga ja máhtát
ieš gávnnahit makkár formeliid galggat čállit ruvttuide E3 ja E4.

Gávdno vel álkit vuohki: Sihku buot loguid E-kolonnas. De doalvut sáhpána B2:i, deaddilat
gurut boalu ja hoiggat seavana E4:i, gos luoittát sáhppánboalu. De coahkkulat fas E4:i ja dan
maŋŋil oktiibidjanmearkka, 

DIAGRÁMMAT 

 Go leat rehkenastán muhtin statistihka sáhtát geavahit rehkenastinprográmma čájehit

dan diagrámman. Don merket sáhpániin loguid ja teavstta mat galget leat mielde.

Mana diagrámmaikonii, dahje deaddil Insert > Chart, ja čuovu čilgehusa mii boahtá ovdan.
Jus galggat oažžut teavstta mielde čilgehussan, fertet krysse av sihke First row as label ja
First column as label. (Guoská OpenOffice) De válljet diagrammahámi maid háliidat.  
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Jus mii dál rievdadit muhtin logu rehketdoalus, de oaidnit ahte dat maiddái váikkuha
diagrámmii.

Bargobihttá 1A: Rehkkenastit bálkká ja vearu
Čále vuolábealde rehkenastinárkka teavsttaid ja loguid sisa du prográmmii. Logut ruvttuin
B10, D6 ja F6 eai galgga čállojuvvot njuolga sisa, muhto hápmun. Hámu F6 duohken oainnát
dás govas. Hápmu D6 duohken lea B6*C6. Bija sisa hámuid mat dárbbašuvvvojit vai
rehkenastit dan mii váilo. Nettobálká lea dán oktavuođas bálká minus vearru.

Go leat geargan sáhtát rievdadit muhtin diibmologuid ja vearroproseantta. Geahča mo dát
váikkuhan eará loguid.  

Bargobihttá 1B: Diagrámma
Čájet daid njeallje bargiid nettobálkká diagrámman.

Bargobihttá 2. 
Dás vuolábealde oainnát skovi mainna rehkenastit čuoggáid bircospealus YATZY. Čále daid
dieđuid sisa rehkenastinárkii ja bija sisa formeliid maiguin rehkenastit čuogggaid dáidda:
sum, bonus ja oktiibuot. Geahča čilgehusa vuolábealde. 
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Supmi- ja oktiibuot-formeliid berret ieš nagodit ráhkadit, bonus-formel lea dan mađe váttis
ahte mii muitalit dan: HVIS(B7>83;50;0) Bija sullasaš formeliid unnimusat 4 kolonnii, bija
sisa muhtin loguid ja geahča mo supmi, bonus ja oktiibuot rievdá.

YATZY

ovttežat
guvttežat
golmmežat
njelježat
viđežat
guđežat
supmi
skeaŋka
1 bárra
2 bára
3 bára
3 ovttalágana
4 ovttalágana
5 ovttalágana
unna ráiddoš
stuora ráidu
olles ráidu
goahti
viessu
doardna
soaittáhat
maxiyatzy
oktiibuot

Čilgehusat:
Skeaŋka Jus submi lea badjel 84, oažžu 50 čuoggá skeaŋkan.
Unna ráiddoš 1-2-3-4-5 = 15
Stuora ráidu 2-3-4-5-6 = 20
Olles ráidu 1-2-3-4-5-6 = 21
Goahti 3 ovttalágana + 2 ovttalágana, omd. 5-5-5-4-4
Viessu 3 ovttalágana + 3 ovttalágana, omd. 5-5-5-4-4-4
Doardna 4 ovttalágana + 2 ovttalágana, omd. 5-5-5-5-4-4   
Soaittáhat Buot čalmmit rehkenastojuvvojit
Maxiyatzy 6 ovttalágana = 100

Eará doaimmat
Rehkenastinárkkain leat issoras ollu doaimmat, mat mii eat sáhte čilget dás. Sáhtát iskat daid
jus deaddilat doaibmaboalu (funksjonstast), 
 Kspread: 

OpenOffice Calc:  mearka dás gurutbealde: 
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Dás gávnnat earret eará vejolašvuođa rehkenastit gaskameari, tangens ja sinus ja máŋga eará
matematihkalaš doaimmaid.

Prográmmapáhkain KOffice ja OpenOffice gávdnojit vel eanet prográmmat maid mii sáhttit
geavahit go bargat matematihkain ja statistihkain:
KFormula, KChart, Kivio ja OpenOffice Math

9.4. PRESENTAŠUVDNA
Presentašuvnnat geavahuvvojit illustrašuvdna til ein tale dahje førelesing. Presentašuvdnafiila
sisttisdoallá eit sett med "čuovgagovaid" maid sáhttá čájehit prošektoris, mii lea čadnon
dihtorii, dahje vuolggahit njuolga dihtoršearpmas. Das leat buoremuddui seamma doaimmat
go čuovgaárkkat ja čuovgagovat, muhto dasa lassin lea vejolaš bidjat dakkár doaimmaid
ahte govva rievdá čájedettiinat. 
Presentašuvnnas lea dábálaš geavahit oalle unnán teavstta, dávjá čuoggáid, ja muhtin
gráfalaš ađaid. Sáhttá maiddái vuojahit govaid okto, teavstta balddas dahje teavstta
duogážin. 

Presentašuvdnaprográmmat leat omd.:
Linuxa várás:  KPresenter
Windowsa várás: Power Point, Freehand Graphic 
Sihke Linuxa ja Windowsa várás: OpenOffice Impress
 
(Her skal det komme meir med tida.)

9.5. DIEHTOVUOĐĐU
Diehtovuođđu (database) lea prográmma gosa sáhtát vurket hui ollu dieđuid. Sáhtát čorget ja
sirret dieđuid jus galggat ráhkadit omd. čujuhuslisttu, girjearkiivva, gálvolisttu dahje
sátnegirjji.
Rehkenastinárkka sáhttá muhtin muddui atnit diehtovuođđun ja nuppe guvlui, muhto lea
buoret jus leat sierra prográmmat dáidda doaimmaide.

Dátábásat eai láve leat mielde dábálaš kántorpáhkain, muhto muhtin stuora veršuvnnain lea
maiddái diehtovuođđu.
Muhtin diehtovuođut leat:
Linuxa várás: DbDesigner
Windowsa várás: Microsoft Access, Claris FileMaker, FoxPro, MS SQL
Sihke Linuxa ja Windowsa várás: Oracle, MySQL, PostgreSQL

(In dieđe ferte go leat eambbo databasaid birra dán girjjis, dat ii gula dasa maid dábálaččat
dárbbaša skuvllas)

 

10. GRÁFALAŠ PROGRÁMMAT
Gráfalaš prográmmat leat prográmmat mat vuosttážettiin gieđahallet govaid ja sárggosiid.
Ii leat álfarot earuhallat gráfalaš prográmmaid ja kántorprográmmaid. Muhtin čállin- ja
rehkenastinprográmmain leat maiddái gráfalaš doaimmat, omd. sáhtát sárgut veahá KWord:s
dahje MS Word:s ja ráhkadit diagrámmaid KSpread:s dahje MS Excel:s. 
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Presentašuvdnaprográmmat ja gráfalaš hábmenprográmmat (Desktop publishing) gieđahallet
sullii seamma muddui teavstta ja govaid ja eará gráfalaš ađaid. Ieš teaksta gieđahallojuvvo
maiddái gráfalaččat. Go hupmat "gráfalaš prográmmaid" birra jurddašit eanemusat
prográmmaid birra maiguin ráhkadit ja rievdadit sárggosiid ja govaid. 

10.1. GRÁFALAŠ FORMAHTAT
Gráfalaš fiillain lea máŋgalágan formáhtat, nu go *.bmp, *.gif, *.tif, *.dwg, *.pdf, *.jpg,
*png.

Leat guokte váldošlája: 

* Čuokkis-formáhtat (punktgrafikk). (Earret eará *.png *.bmp, *.gif, *.tif  ja .jpg) 
Dát leat ráhkaduvvon unna čuoggáiguin, ja jus stuoridat gova oainnát čuoggáid
njeallječiegadin:
  

Jus unnidat čuokkisgráfalaš formáhtaid sáhttet bienat jávkat ja govva rievdat.
Álkes sárgonprográmmat leat Paint, mii gávdno buot Windows-veršuvnnain ja KPaint, mii
gávdno KDE vuolde. 

Digitála govat, skánnen ja govvagieđahallanprográmmat leat huksejuvvon čuohkisgráfihkas.
Digitála govvenapparáhtaide lea nammaduvvon galle piksela sáhttá leat ovtta govas, omd. 4
megapiksela, dahje 4 miljovna čuoggá. Veardideapmái biilagovas dás bajabealde leat sullii
1200 piksela. Dat mii mearrida gova kvalitehta lea čuokkiscoahku (oppløsning, resolution),
dahje galle piksela leat dumás. Sáhtát lohkat eambbo čuokkiscoahku ja govvagieđahallama
birra kapihtalis 10.2 - GIMP.

* Vektor - formáhtat. (Earret eara *.dwg, *.cdr)
Vektor-formáhtas ii mihkkege jávkka go stuoridat dahje unnidat gova. Teknihkalaš
sárgunprográmmat atnet vektor-grafihka. Ovdamearkkat lea AutoCad Windows várás ja
Linux várás: Karbon14, Sodipodi ja Qcad. Qcad lea čilgejuvvon kapithalis 10.2.

10.2. GOVVAGIEĐAHALLAN
Linuxas leat moadde govvagieđahallanprográmma, nugo GIMP, PhotoGenics ja
Imagemagic. Dát vástidit sullii Windows-prográmmaid nugo Adobe PhotoDeluxe,
IPhotoPlus, CorelDraw dahje Micrografx Picture Publisher. Muhtin dáin prográmmain sáhttá
maiddái geavahit skánnemii, ee. GIMP. KDE:s lea govvagieđahallanprográmmaid lassin
sierra prográmma erenoamážit skánnemii ja optalaš teakstadovdamii, Kooka.

KUICKSHOW
KDE:s lea prográmma mii vuostážettiin galgá čájehit govaid šerbmii, Kuickshow. Dáinna
sáhttá geahččat buot govaid muhtin ozus unnagovažin ja de válljet ovtta ja ovtta maid čájeha
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olles searpmas. Sáhttá maiddái vuojahit čuovgagovačájeheami mas lea automahtalaš dahje
manuála govvamolssun buot ozu govvafiillaide. Sáhttá máiddái muhtin muddui rievdadit
govaid, omd. čuovga ja kontrásta. 

GIMP 
GIMP, dahje GNU Image Manipulation Program, lea hui máŋgabealat prográmma
govvagieđahallama ja skánnema várás. Das leat hui ollu doaimmat, muhto dás áigut dušše
čilget oktageardánis govvagieđahallama.

Mii čájehit dan ovdamearkkain, mii lea govva digitála govvenapparáhtas, muhto
sáhtášit seamma bures geavahit govaid mat leat skánnejuvvon dahje maid leat ožžon
diskeahtas, CD:s dahje gávdnan interneahtas.  

Vuosttaš háve go mii álggahit GIMP, bohtet máŋga unna láseža šerbmii. Muhto álggos
sáhttit gokčat earáid ja bargat dáinna:   

Mii mannat dohko File > Open ja viežžat gova garraskearrus, diskeahtas dahje CD-ROM:s.
Dán háve lean leamaš Várjját sámi museas ja govvidan 4000 boares veaikeniibbi, mii lea
boarráseamus metálladiŋga mii lea gávdnon Norggas. Sáhtát dál viežžat iežat gova ja dahkat
sullasaš dainna. 

Go viežžá gova, de dat ihtá iežas láses šearpmas ja oidno ná:
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Muhto mun dárbbašan dušše gova ieš niibbis, ja dan áiggun geavahit guovtti láhkái: Galgá
prentejuvvot čáhppes-vilges govvan, ja galgá álmmuhuvvot interneahtas ivdnegovvan.  

Vuosttaš maid dahkat lea čuohpat oasi maid dárbbaša. Neavvolinjás válljet govastata
mii lea áibbas gurutbealde, vai čuohppat njeallječiegaga (rektangel). Mii mannat de
sáhpánčujuheddjiin govvii, válljet saji gos háliidit ođđa gova čiega, deaddilit gurut
sáhppánboalu ja doallat dan vuollin dan botta go geassit njeallječiegaga nu stuoris go háliidit
dan. De luoitit boalu. Jus eat leat duhtavaš čuhposiin, čujuhit govvii, deaddilit olgeš
sáhppánboalu ja mannat dohko: Edit > Undo. Go mii leat ožžon gova maid háliidit, deaddilit
fas olgeš sáhppánboaluin ja válljet Edit > Copy. De fas Edit > Paste as new. Dál ihtá ođđa
gova sierra lásen. Berre vurket dan dakkaviđe, ja addit dan eará nama go originála.
Gieđahalladettiin govaid mii dávjá dahkat máŋga dievdadusa ja sáhttá leat buorre beassat
mannat ruovttoluotta ovdit veršuvdnii. Danin mii čujuhit govvii fas ja olgeš sáhppánboaluin
mii mannat dohko: File > Save as ja vurket gova rievttes ohcui . 

Vurkedettiin sáhttá dáhpáhuvvat ahte oaččut dieđu: Your file should be exported....
Coahkkal dalle Export. De oaččut skovi Save as JPEG. Doppe sáhtát stállet kvalitehta.
Geahččal stellet dan bajás ja vulos. Oainnat ahte šaddi kvalitehtain šaddá maiddái gova
sturrodaga KB:n. Dán háve bidjat alimus kvalitehta, 1.
 

Dá lea «beallebuvttadas», govva cukniv2.jpg:

 

Fálus (maid mii oba áigi gávdnat olgeš sáhppánboaluin) mii mannat dohko: Image > Mode
ja válljet Grayscale. Fáhkkestaga lea govva čáhppat-vielgat ja dál ii leat šat vejolaš oažžut
govaid ruovttoluotta. Danin lea buorre ahte vurkiimet gova dalle gos das ledje ivnnit. 
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Mana dohko: Image > Scale image. De oaččut dán sullasaš láse:

Dá oainnát makkar sturrodat ja makkar čuohkkiscoahku oaččut govas, jus dohkehat dan
evttohusa. Dá lea viidodat ja allodat mihtiduvvon pikseliin (px) ja dumáin (in - inches). Sáhttá
leat vuohkaset jus rievdadit dumaid millimehtarin. Coakkil boalu mas lea in ja vállje mm.
Dál mii oaidnit ahte gova govdadat šaddá 400 mm, mii midjiide lea beare ollu. Nuppi bealde
oaidnit ahte dán govdodaga oažžut dušše čuokkiscoahkku (oppløsning, resolution) 72 piksela
dumás. Dat lea beare roaves čuokkiscoahkku jus mii galgat prentet gova báhpárii. Buorre
prenten girjekvalitehtas ii berre čuokkiscoahkku leat unnit go 300. Muhto dán mii sáhttit
rievdadit. Rievddat Resolution X (govdodat) 300:i. Dalle rievdada maiddái automáhtalaččat
Y (allodat). 

Nugo čilgiimet kapihtalis 10.1. leat govat huksejuvvon máŋga unna čuoggáin dahje
pikseliin. Muhtin govas lea vissis čuohkkishivvodat. Dan sáhttá unnidit, muhto ii fal bajidit.
Mii sáhttit regulere galle piksela galgá leat dumás, muhto go bajida čuokkiscoahku, de mii
seammás unnidit gova maksimala sturrodaga. 

Go dán gova čuokkiscoahkku lea 300 šaddá maksimala govdodat 95mm ja allodat
22 mm. Dát sáhttá leat veahá unnit go leimmet plánejuvvon, muhto dás ii sáhtte oažžut sihke-
ja. Danin mii vurket gova ná, namain cukniv3.jpg ja jurddašit ahte boahtte háve go govvedit
museain ferte mannat lagabui dahje geavahit zoom. 
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De mis galgá leat gova maid bidjat internehtii. Dál mii rahpat fas govva cukniv2.jpg.
Coahkkal olgeš boaluin gova ala ja mana dohko: Image > Scale image. Dán háve mii galgat
diktit čuohkkiscoahku leat 72. Dát lea fiidnamus čuohkkiscoahkku maid dihtoršearbma sáhttá
čájehit, ja danin lea joavdelas stuoridit dan. Muhto mii eat hálit gova nu govdda go 400 mm
ja rievdadit dan vai šaddá 200 mm. Oainnán ahte allodat čuovvu mielde ja šaddá 56 mm.
Vurke dan namain cukniv4.jpg. Vurkedettiin oainnát gaskavuođa kvalitehta ja stuorrudaga
gaskkas. Jus govat interneahtas šaddet beare stuorat, mihtiduvvon KB:n, šaddet lossat ja
váttis rahpat. Váldonjuolggadus lea ahte intreneahttagovva ii berre leat eambbo go 30-40
KB. Jus govva lea stuorit, berre unnidit govdodaga/allodaga, čuohkkiscoahku dahje bajidit
komprešuvnna (guoská govaide jpg-formáhtas). 

GIMP:s leat vel máŋga doaimma maid eat leat čilgen dás. Sáhttit namuhit muhtin dain
ja čájehit gos gávdnant daid fálus. Visot gávdná go deaddila olgeš boalu gova ala.
Rievdadit čuovgga dahje kontrástta: Image > Colors > Brightness - Contrast
Rievdadit ivnniid: Image > Colors
Jorgalit gova: Image > Rotate
Retušeret ja sárgut: Tools > Paint tools
Skrive på bileta: Tools > Text

Jus mana váldofállui, man gova oainnát dán kapihtala álggos, ja doalat sáhpánčujuheaddji
muhtin ikona ala, ihtá teaksta mii muitala makkár doaimmaid sáhttá válljet das.

Govvagieđahallama sáhttá dušše fal oahppat geahččaleami bokte. Muitte álo vurket
originálagova ja atte gova mainna eksperimenteret ođđa nama ovdal go rievdadat. Lea hui
álki rievdadit gova, muhto sáhttá leat áibbas veaddetmeahttun mannat ruovttoluotta originálii.

10.3. SNAPSHOT 
Smiehtát go mo mii leat ožžon buot govaid dihtorprográmmain dán girjái? Govat eai leat
govviduvvon govvenapparáhtain, muhto prorgámmain man namma lea KSnapshot, maid
gávnnat Skuvlalinux-CD:s. Gávnnat dan K-fálus dás: Grafikk > Andre programmer. Dán
oktavuođas lea dehálaš álkit beassat prográmmaide, danin mii bidjat KSnapshot
čállinbeavdái, jus ii leat doppe juo. Geahča čilgehusa kapihtalis 8.1. Snapshot lea /usr/bin
vuolde, ja das lea iežas govastata maid sáhttá bidjat čállinbeavdái: 

Ovdal go mii álggahit Ksnapshot fertet gozihit ahte dan maid áigut govvedit lea šearpmas. De
coahkkulit Knapshot ja oažžut dákkár gova:
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Vuollin láse oaidnit Snapshot delay. Jus dat lea stellen 0:i, de mii govvedit šearbma juste
dalle go coahkkulit boahtet govvii. Sáhttá leat buoret jus mis lea veahá vuordináigi, vai
sihkkarastit ahte oažžut rievttes gova. Dan vuolabealde oainnát ruvttu ja Only grab the
window containing the pointer. Jus mii bidjat ruossa dohko, de mii sáhttit geavahit
vuordináiggi coahkkulit šerpmii vissis láses. Dan mii leat dahkan vai oažžut bajábealde
gova, dárbbaškeahttá mannat govvagieđahallanprográmma bokte. 

Jus mii geavahit bajábealde stellemiid, coahkkulit New snapshot ja mis leat 5
sekundda čájehit makkár gova mii háliidit. Oanehis áigi maŋŋil ihtá govva unna šerbmii
Snapshot-láses. Jus mii leat duhtavas govain, coahkkulit Save snapshot ja vurket dan
garraskerrui. Jus galggat váldit máŋga gova dihtoršearpmas berret ráhkadit sierra ozu(id)
daidda.  

Snapshotat vurkejuvvojit govvafiilan formáhtas .png, ja dát fiillat mii sáhttit čálihit,
bidjat sisa teakstagieđahallanprográmmii dahje gieđahallat viidáseappot
govvagieđahallanprográmmas. Dávja mii eat hálit gova olles šearpmas  ii ge iolles láses.
Dalle fertet geavahit GIMP dahje eará govvagieđahallanprográmma čuohppat oasi maid
háliidit ja vurket dan sierra fiilan.  

10.4. TEKNIHKALAŠ SÁRGUN
Teknihkalaš sárgumii sáhttit geavahit prográmma Qcad, mii lea Skuvlalinux-CD:s ja muđui
sáhttá viežžat dás: http://www.ribbonsoft.com/qcad.html. Veršuvnnas mii čuovvu
Skuvlalinux ii leat veahkkedoaibma. muhto gávdno vuđolaš instrukšuvdna eŋgelasgillii dán
siiddus: http://www.ribbonsoft.com/qcad/manual_reference/index.html   

Dát instrukšuvdna eaktuda ahte don buorre muddui dovddat teknihkalaš sárguma lianttain ja
báhpáriin, muhto it dárbbaš leat sárgon dihtoriin ovdal. Jus ovdal leat sárgun omd.
Autocad:in, gávnnahat ahte Qcad lea oalle earálágan, ja danin sáhttá leat buorre čuovvut dan
oanehis kurssa ovdal go geahččalat viidáseappot iešheanalaččat. 

FÁLUT JA SÁRGUNGIETTIT
Go rabat Qcad, oainnát stuora sárgungietti, mii sáhttá leat dievva rukses čuoggain. Dat lea
gitter, mii sáhttá leat ávkkalaš go sárgu. Jus baicce háliidat áibbas guorus sárgungietti, sáhtát
váldit dan eret dus deaddilat boalu mas leat 9 čuoggá neavvolinjás.
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Sárgongietti gaskamuttos oaidnit sárgonárkka. Dát ii leat absoluhta rámmat sárgomii,
muhto go jurddaša ahte galgá sáhttit čálihit bohtosa báhpárii, de ganneha sárgut dušše dan
rámma siskkobealde. 

Sárgungietti bajábealde mii oaidnit oalle dábálaš fálu, mas sáhttit rahpat ja ráhkadit fiillaid,
stuoridit ja unnidit gova, čuohpat ja liibmet jna. Dađi mielde mii galgat oaidnit ahte dás leat
maiddái muhtin áibbas erenoamáš doaimmat sárgonprográmma várás. Sárgongietti gurut
bealde oaidnit sárgongovastataid: 

Dás sáhtát čoaggit sárgonneavvuid maid háliidat, nugo linjá, gierdu ja teavstta ja doaimmaid
nugo mihtideami ja suiven. Jus coahkkulat gurut boaluin muhtin dáin boaluide, bohtet ođđa
govastatat dahje gažaldagat. Mii nappo eat sáhte sárgut njuolga daiguin govastataiguin,
muhto doaimmaiguin mat leat daid vuolde. 

FRIDDJAGIEĐASÁRGUN SÁRGUNAĐAIGUIN
Álggos mii galgat sárgut muhtin njulges linjáid. Coahkkal linjágovastata mii lea bajimusas
olgeš bealde (Lines). Fálus mii dalle boahtá ovdan válljet linjá baimusas gurut bealde (Create
lines).

Dál sáhtát mannat sáhpániin sárgongieddái ja sárgugoahtit linjáid. Coahkkalat gurut boaluid
doppe gos áiggut álgit, geasat sáhpána dohko gosa háliidat ja coahkkalat fas. Dál oainnát
ahte ođđa linjá álgá doppe gos ovddit linjá loahpahuvvui. Nu joatká dassái go coahkkalat
olgeš boaluin vai beassat luovus. 
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De mii geahčadit eará linjágovastataid dán fálus. Daiguin sáhttit oažžut linjáid vissis čiegas,
ceahkku ja vealu linjáid. Dát linját mannet miehtá árkka ja jus háliidit ráddjet daid, fertet
čuohpat eret oasi maŋŋil. Dát doaibma lea ee. ávkkálaš go ráhkadit guovddášlinjaid ja eará
veahkkelinjáid. 

Mii mannat ceahki vulos ja gávdnat njeallječiegada (rektangel). Maŋŋil go leat
coahkkalan dasa, de mii sáhttit bidjat čuoggá sárgunárkii. Dat šadda dalle čiehka, mas mii
sáhttit geassit njeallječiegada man háltái ja nu guhkas go mii háliidit. 

Dál mii mannat ruovttoluotta sárgunfállui, dainna ahte coahkkulit olgeš boaluin
muhtin govastatii. De mii válljet gierdogovastata. Álggos oažžut golbma ođđa
gierdogovastata. Jus mii válljet olgeš bealde govastata, sáhttit bidjat gierdu guovddáža
sárgongittii ja geassit gierddu nu stuoris in go háliidit. Geahččal dan ja mana de gurut
govastatii. Dá fertet addit  radiusa mm:n. Čále radius omd. 30 ja ráhkat gierdduid dainna.
Mana de dávgagovastatii ja geahččal guokte bajimus vuogi ráhkadit dávgga.

Ovdal go mannat viidáseappot sáhtát vurket sárgosa. Jus it leat vel dahkan dan,
ráhkat sierra ozu garraskerrui sárgosiid várás. Vurket dábálaš vuogi mielde; coahkkalat
diskeahttagovastata.  

Dál mii leat geahččalan deháleamus sárgonneavvuid teknihkalaš sárgumii; njulges
linjáid, dávggaid, gierdduid ja njeallječiegagiid. Muhto jus galgá leat albma teknihkalaš
sárggus, de dárbbašit eambbo. Vuosttačettin mii fertet máhttit mearridit linjášlája,
sárgoneáđaid sturrodaga ja sárgosa mihttomeari. 

SÁRGUNÁRKKA KOORDINÁHTAT 
Nugo eará teknihkalaš sárgonprográmmain lea Qcad:s nu ahte juohke čuoggás sárgonárkkas
lea iežas sajádat, mii muitala gos čuokkis lea X-ávssas (vealu) ja Y-ávssas (ceakku). Dát
gohčoduvvojit maiddái koordináhtan. Mii lávet čállit koordináhtaid nie: X,Y, omd. 74,-23.

Vuollin gurut bealde šearpmas oaidnit koordináhtaid omd. ná:
Abs: X: 158 mm / Y: -26 mm
Rel: X: 58 mm / Y: -226 mm
Abs lea absoluhtta koordináhtat, dat mearkkaša ahte mii mihtidit muhtin čuoggá sajádat
muhtin bistevaš nullačuoggá ektui. Dát čuokkis gohčoduvvo origo dahje 0,0.
Rel lea relatiiva koordináhtat, dát mearkkaša ahte muhtin čuoggá sajádat addojuvvo dan
ovddit čuoggá ektui, gos mii leat leamaš.
Earuhan dihtii daid, čállit mii relatiiva koordináhtaid ovddabealde @-mearkka, ná: @54,23.
Jus loguid ovddabealde ii leat @, sáhttá jáhkit ahte lea sáhka absoluhtta koordináhtain.

Go mii álgit ođđa árkka lea origo (0,0) sajáiduvvon sárgunárkkas vuollin gurut
čielgas. Maŋŋil sáhtit sirdit dan gosa háliidit, ja dalle koordináhtat addojuvvojit ođđa origo
ektui. Standard sárgunárka lea ceakku A4, ja jus mii bidjat mearkka bajimusas olgeš čihkii,
de oaidnit ahte dan koordináhtat leat X = 210 mm ja Y = 296 mm. 

Álggat ođđa guorus sárgunárkka. coahkkal boalu mas leat golbma čuoggá bajimusas
gurut bealde sárgunfálus ja de boalus mas lea okta čuokkis. Bija čuoggá gos nu sárgunárkii.
Divtte čujuheaddji leat dán čuoggás. Dalle oainnát ahte absoluhtta koordináhtat addet gaskka
origos, ja relatiiva koordináhtat fas leat @0,0. Doalvvu čujuheaddji bajás ja olgeš guvlui. Mii
oaidnit dál ahte absoluhtta ja relatiiva koordináhtat lassanit seamma ollu. Bija ođđa čuoggá
árkii, olgeš ja bajábealde ovddit čuoggá. Relatiiva koordináhtat šaddet fas @0,0, muhto
absoluhtta eai rievdda. Mana gurut guvlui. Oaidnit dál ahte relatiiva X-koordináhta šaddá
negatiiva, ja jus mii mannat vulos, šaddá maiddai Y-koordináhta negatiiva. Absoluhtta
koordináhtat leat positiiva nu guhká go mii leat sárgonárkkas, dat šaddet negatiiva easká jus
mii mannat árkka olggobealde gurut bealde dahje vuollin.  
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Mii galgat dál dahkat unna hárjehusaža mii čájeha absoluhtta ja relatiiva
koordináhtaid geavaheami. Dan mii dahkat dainna ahte sárgut oktageardanis hámu;
njuolgačiegat golmmačiegaga mas leat siiddut 30, 40 ja 50 mm.

Mii geavahit álggos absoluhtta koordináhtaid: Mii sárgugoahtit čuoggás 50,50.
Coahkkal ovdimus sárgunfálu linjágovastatii, de bajimus gurut bealde linjágovastatii. Mana

de boallui mas leat X- ja Y-koordináhtat: 

Oaččut dán unna láseža, masa bijat goappašiid koordináhtaid 50:i ja Mode galgá leat abs.   

Coahkkal gurut sáhppánboaluin vaikko gosa sárgunárkii. Oainnát ahte dál ihtá rukses
čuokkis 50,50:i. Go mis galgá leat vealu sáhcu das, mii galgá leat 40 mm, ferte X lassanit
40:in. Bija danin X 90:n (50+40). Juohke háve go mii leat addán ođđa koordináhtaid, fertet
coahkkalit gurut boaluin sárgunárkii doaimmahit dan. Dál galgá leat sáhcu árkkas. De mis
galgá leat ceakku sáhcu 30 mm bajás. Rievddat Y 80:n (50+30). Loahpas rievdadit
koordináhtaid ruovttoluotta 50,50:i, ja njeallječiegat lea gárvis.

Ovdamunni absoluhtta koordináhtaiguin lea ahte mii álo diehtit gokko sárgunárkkas
mii leat. Nuppi bealde fertet bidjat loguid oktii juohke háve. Galgat sárgut seamma hámu
relatiiva koordináhtaiguin. Geavahit seamma árkka, muhto muđui álggahat ođđasit,
coahkkalettiin linjagovastaga (Lines – Create lines) ja koordináhtaboalu (Input
coordinates). Geavat álggus absoluhtta koordináhtaid ja bija mearkka čuoggái 80,100. Dál
mi molsut relatiiva koordináhtan. Go vuosttaš sáhcu dušše galgá mannat X-guvlui, de addit
X=40, Y=0. Juohke háve go leat addán ođđa koordináhtaid, coahkkalat oktii gurut
sáhppánboaluin. Jus coahkkalat moadde háve oaččut ain ođđa linjáid seamma guvlui. De lea
Y mii galga lassanit. Atte relatiiva koordináhtaid @0,30. Loahpas galgat ruovttoluotta ja
čállit @-40,-30 ja golmmačiegat leat gárvis.

SÁRGUNNEAVVUID HEAIVEHEAPMI
Ovdal go mii sáhtit ráhkadit albma teknihkalas sárgosa, fertet oahppat sárgunárkka ja
sárgunáđaid heiveheami birra. Heiveheapmi maid ráhkadat báhcá vaikko álggahat ođđa
árkka dahje manat olggos prográmmas ja jaddadat dihtora. Dat lea čadnon du
geavaheaddjinammii, eará geavaheaddjit seamma dihtoris sáhttá leat eará heiveheapmi. Omd.
šaddet mekanihkarat ja snihkkarat geavahit iešguđetge mihttomeriid ja mihttoovttadagaid. 

Álggat ođđa guorus sárgunárkká ja mana dohko: Options > General preferences
Das galgat geahčadit muhtin molssaeavttuid. 
Language: Dán kurssas mii leat geavahan eŋgelasgiela. Sáhtát válljet suomagiela, muhto
dađe bahábut ii leat vel (2005 geassi) Qcad jorgaluvvon sámegillii, dárogillii ii ge ruoŧagillii.
Jus lea jorgaluvvon ovdal go logat dán, sáhtát iskat dás:
http://www.ribbonsoft.com/qcad.html 
Jus lea, sáhtát viežžat giellafiila prográmmii.
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Apperarance: Dá vállje makkár fonttat galget geavahuvvot čállosiidda. Charset ferte leat
Unicode jus galgá sáhttit čállit sámegiel bustávaid. Eará it dárbbaš rievdadit.

Grid: Dát muitala man dárkkil sáhttá leat go sárgu, muihttiduvvo millimehtariin. Bija dan
álggus 1:n, sihke X- ja Y-guvlui.

Dimension: Dárkkis ahte Unit lea millimeter ja Format lea Decimal. Álggus áiggut sárgut
olles millimehtariin, ja danin bidjat Exactness 1:n sihke dimenšuvnna ja čiega (angle) hárrái. 

Eará sáhttá báhcit nugo leat. Coahkkal OK. Oaččut dieđu ahte rievdadusat eai boađe johtui
ovdal go leat álggahan prográmmaid fas. Govčča danin prográmma ja álggat dan fas. 
FUOM! It dárbbaš álggahit fas dihtora, dušše prográmma Qcad.

LINJÁŠLÁJAT JA DÁSIT
Dán rádjái lea visot maid mii leat sárgon leamaš heiltrukne asehis linjáiguin. Teknihkalas
sárgosis geavahit iešguđetge linjášlájaid; oidnosis ja oaidnemeahttun kontuvrat,
mihtidanlinjáide ja guovddášlinjáide. Dan mii sáhttit maiddái dahkat dihtoriin. 

Dasa lassin sáhttit bidjat iešguđetge linjášlájaid dahje sárgosa iešguđetge osiid
iešguđetge geardái, maid mii sáhttit jaddadit dahje vuolggahit dárbu mielde. Dat vástida dasa
jus mis čuovgaárkačájánii bidjat moadde čuovgaárkka badjelagaid, omd vuosttaš árkkas leat
gážaldagat mas lea sadji vástádussii ja nuppi árkkás leat vástadusat. Mii áigut dás čájehit
goappašiid molsašuhttiid oktanaga.

Olgeš bealde šearpma galgá leat Layer List, ja dan vuolde moadde govastaga. Jus dát ii
oidno, fertet vuos mannat dohko: View > Show/hide Layer List. Layer List:s coahkkalat +
(Add layer). Gohčut gearddi oidnosis, vállje čáhppes ivnni, govdodat 2 ja divtte stiila leat
heiltrukken linje.
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Coahkkal OK ja sárggu vealu linjá árkka bajimusas dáinna.

Seamma láhkái mannat fas  +:i, ja lasihit eanet gerddiid. Juohke háve sárggut linjá árkii vai
oainnat ahte šaddá riekta. 
Mis galget leat dát gearddit: 
• Oaidnemeahttun: ruškat, govdodat 2, stiila ceahkessárgon linjá - - - - - - 
• Guovddaš: ruoná, govdodat 1, stiila galgá dál leat čuokkis-sáhco-linjá  - .- .- .- .- 
• Mihttu: alit, govdodat 1, olles linjá ___________
• Suiven: ranesruoná, govdodat 1, olles linjá ________

Dát heiveheamid gusket dušše dán sárgonárkii. Vai ii galgga dárbbašit heivehit dáid gerdiid
ja linjášlájaid juohke háve, sáhtát vurket dán fiilla standardfiilan, maid viežžat juohke háve
don galggat álggahit ođđa sárgosa. 

Álggos válddát linjáid eret árkkas nie: Sárgunfálus válljet EDIT-boalu, dan maŋŋil govastaga
mii lea measta vuollimusas:  

De coahkkalat juohke linjái maid háliidat sihkkut. Oaidnit ahte linját mat leat merkejuvvon
sihkumii rievdadit ivnni ruoksadin. Go visot lea merkejuvvon coahkkalat boalu mii dál lea
ihtán seamma sihkun-govastagain, dušše veahá stuorit boallu. 
Go buot linját leat sihkkon ja árka guorus, vurket dan fiilanamain standard.dxf. Juohke háve
go áiggut sárgut ođđa sárgosa, vieččat dan fiila ja vurket dan eará namain ovdal go
sárgugoađát. 

TEKNIHKALAŠ SÁRGUN - HÁRJEHUS
Dál galgá leat gárvvis ráhkadit albma teknihkalaš sárgosa. Mii galgat sárgut gearssi
bajábealde govadahkan ja siiddus čuohpastahkan ja bidjat mihtuid dasa. Čuovo fal mielde,
de mii čilget eanaš teknihkalaš sárguma váldodoaimmaid.

Vuosttaš háviid go ráhkadat teknihkalaš sárgosiid dihtorii, de lea buoremus álggos
ráhkadit roavva sárggosa báhpárii, nu ahte oainnát man ollu saji dárbbašat. Berret maiddái
mihtidit ađa ja čállit deháleamus mihtuid báhparii. De berret plánet mo galggat álgit. 

Dá oainnát ađa maid áiggut sárgut  – stállegearsi mas gásku lea ráigi bohcci várás ja dan
birra njealje skruvvaráiggi. 
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Raba fiilla standard.dxf ja vurke dan namain gearsi.dxf. 
Vállje gearddi oidnosis. Mana sárgunfálus boaluide Lines – Create lines – Input
coordinates ja bija álggahančuoggá 50,150. Molssu relatiiva koordináhtan ja čále X=100,
Y=0. Joatkka dáiguin: @ 0,100, @ -100,0 ja @ 0,-100. Dál dus galgá leat njeallječiegat. Go
leat geargan dainna coahkkalat olgeš boalu.  

De mii ráhkadit ráiggi mii lea gasku. Mana geardogovastahkii ja vállje gierddu
radiusain. Bija radius = 20 ja koordináhtaid @ 50,50. Jus gierdu šaddá riekta, de dohkkehat
dan dainna ahte coahkkulat sárgosii. 

De sárgut skruvvaráiggiid. Vuosttas ráigái attat relatiiva koordináhtaid das gos ledjet
maŋimusas. Jus dat lei stuora ráiggi guovddážis, sáhtát geavahit @ 35,35. Dan maŋŋil
máŋget gierdduis eará čiegaide dáiguin koordináhtaiguin: @ -70,0, @ 0,-70 ja @ 70,0. Rohtte
luovusin olgeš sáhpánboaluin ovdal go šaddet vel eanet ráiggit. 

Gearssu čiegat eai galgga leat bastilat, muhto jorbejuvvon 15 mm radiusain. Dan mii
dahkat ná: Valdosárgonfálus válljet EDIT ja dan maŋŋil dán govastaga:     

Atte radius 15. Mana sárgosii ja merke maŋalagai guokte siiddu man gaskkas galggat jorbet
čiega. Oainnát dalle rukses asehit gierdu dán čiegas. Coahkkal go gierdu lea gearserávdda
siskkobealde. De dagat seammaláhkai eará čiegaide. Dál mii leat geargan oidnosis
kontuvrraiguin oidnon bajábealde. 

Boahtte ceahkki lea bidjat guovddášlinjáid ráiggiide. Mii bidjat daid iešguđetge gierddu 5 mm
olggobeallái. Vállje gearddi man namma lea guovddaš. Rukses čuokkis, mii lea  relatiiva
koordináhtaid vuođđu galgá dál leat gasku vuolimus olgeš skruvvaráiggi. Dán ráiggi vealu
guovddášlinjá galgá dalle mannat @-10,0 rajes gitta @20,0 rádjái, ceakku linjá fas @-10,-10
rájes @0, 20 rádjái. Sáhtát ieš geahččalit gávdnat eará ráiggiid guovddášlinjáid
koordináhtaid. Muitte ahte vuolggahansadji lea alo rukses čuokkis.

De galggat bidjat mihtuid. Mihtolinjáid gávdnat gearddus mihttu. Sárgunfálus gávdnat dán
govastaga: 

 

Dan vuolde gávdnat ee válljemiid horisontala (vealu) dahje vertikala (ceakku) mihttobidjama,
radius ja diamehtar. Galgat dađistaga geavahit buot njealje.  
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Álggos mii bidjat vealut olles gearssi mihtu. Coahkkal vealu mihttonjuollabollui ja
dan maŋŋil govastahkii badjin gurut bealde, Snap to endpoints. Dalle oaččut mihtu dárkilit
gežiin ja rievttes bealde. Doalvvu čujuheaddji dassái go oaččut unna rukses rieggá doppe gos
njulges siidu rievda dávgin, čoahkkal ja mana nuppi beallái ovdal go coahkkalat sullasaš
sadjái. Dál galggat sáhttit oaidnit mihtidanlinjá šearmmas. muhto dat ii leat vel sájaiduvvan.
Doalvvu dan vuogás sadjái, jus vejolaš ieš hámu olggobealde, ja coahkkal dohko. Jus
mihtidanlinjá bajabealde dál oainnát logu 100 de don leat bargan riekta. 

Daga seammaláhkái eará vealu ja ceakku mihtuiguin maid dárbbašat. Ale bija eanet
mihtuid go dárbbašlaš. Bija mihtu stuora ráigái ja ovtta unna ráiggážii. Vállje diamehtar.
(Sárgudettiin fertiimet geavahit radiusa, muhto son gii galgá bovret dán gearssu sárgosa
mielde dárbbaša báicce diamehtara.) 

Go leat ožžon dán skovi bajimusas sárgungietti gurut čiegas, dárkkistat ahte lea válljejuvvon
diamehtar nu go čájehuvvon. Dalle oidno sárgosii ahte lea sáhka diamehtarmihtus. Deaddi
gierdodávgái ja oaččut mihtidankinjá maid sáhtát bidjat gosa heive. 

Fertet maiddái mihttobidjat čiegaid radiusaid. Dan mii dahkat boaluin radiusa
mihttobidjama várás. Go leat dahkan dan, de leat geargan gearssu govastagain.

Mis leat ain guokte gearddi ja linjášlája maid eat lean geavahan. Dál mii áigut geahččat masa
mii sáhttit dárbbašit daid. Mii jurddašit ahte čuohppat gearssi guovtti oassái, ja ráhkadit das
čuohpastaga. 

Álgge linjáin absoluhtta koordináhtas 50,100 relatiiva koordináhtii @100,0,
viidaseappot @0,15, @-100,0 ja @0,-15. Dalle mis galgá leat gearssu ravdasáhcu oidnon
čuohpastahkan gurut bealde. Go čuohppá rastá, de oaidnit ráiggi gasku, mii dalle sárgojuvvo
oidnolas kontuvran. Sárggu linjáid @30,0 rájes @0,15 rádjái ja @40,0 rájes @0,-15 rádjái.
Unna ráiggážat eai oidno dán cuohpadagas, ja dat galget danin sárgojuvvon oaidnemeahttun
kontuvran. Mana geardái oaidnemeahttun. Sárggu olgeš bealde ráiggi oaidnemeahttun
kontuvran @10,0 rájes @0,15 rádjái ja @10,0 rájes @0,-15 rádjai. De sárggut gurut bealde
ráiggi seammaláhkái. 

Dál áiggut suivet čuohpadaga. Dalle válljet suivengovastaga ja markeret gos
suivehusa rájit galget leat. Suivengovastat lea álki dovdat. Dán vuolde válljet
njuollamearkka, (Un-)tag single elements. De coahkkalat linjáide mat ráddjet guovllu mii
galgá suivejuvvot ja dan maŋŋil suivengovastaga, mii dál lea sárgonfálu vuollin. Dalle ihtá
láse gasku šearpma teavsttain Create hatchings. Dás galggat válljet galle gráda
skraverenlinját galget leat vinjut ja man guhkas galgá leat dáid gaskkas. Vállje 45 gráda ja
1.0 gaskan ja coahkkal OK. Dál galgá oassi du sárgosis leat suivejuvvon.

De ráhkadit ráiggiide guovddášlinjáid. Čuohpadagas eat dárbbaš go ovtta mihtu;
gearssu govdodaga. Dál sárggus galgá leat gárvis ja sullii dákkár: 
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11. DIHTORGULAHALLAN
Dihtora bokte sáhtát gulahallat máŋgaláhkai, olbmuiguin ja dihtoriiguin mat leat nuppi lanjas,
nuppi viesus dahje velá nuppe bealde máilmmi ge. Dál lea váttis earuhit gulahallanvugiid, go
muhtin biergasis sáhttá leat máŋga doaimma. Dás mii eat áiggo geahččalit ge čilget buot
vejolašvuođaid, dušše moadde vuđolaš doaimma.

Linux lea álggu rájes jurddašuvvon gulahallama várás, sihke báikkálaš fierpmádagain
ja gáiddusfierpmádagain. Lea hui ollu bálvvát mat geavahit Linuxa hálddašit gulahallama
dihtoriid gaskkas.  

11.1. FIERPMÁDAGAT

Fierpmádat mearkkaša čatnat moadde dahje máŋga dihtora oktii nu ahte dat sáhttet
ávkkaštallat oktasaš ressursaid; vuorkejuvvon dieđuid, prográmmaid ja/dahje
periferiovttadagaid nugo čálána, modem jna. Buot ovttadagat mat leat čadnon fierpmádahkii
gohčojuvvojit nodan. Čatnan dáhpáhuvvá johtasiiguin ja / dahje fierpmehis signálaiguin. 

Fierpmádagat sáhttet leat báikkálaččat (LAN – Local Area Network) kántuvrra, skuvlla
dahje bargosaji siskkobealde ja gáidožat (WAN – Wide Area Network). 
Báikkálaš  fierpmádagas sáhttet dihtorat juohkit ovtta dahje eanet doaimmain nugo
garraskearru, CD-stašuvdna, čálán, modem ja fáksa. 

Sihke báikkálaš ja gáiddus fierpmádat gávdnojit guovttelágan struktuvrras:
Guoimmis guoibmái (Peer to peer): Moadde dihtora leat čatnan oktii seamma dásis.
Buohkain leat seamma vuoigatvuođat ja ii oktage dihtoris leat erenoamáš doaibma bálván.
Go dihtorat gulahallet de dat doibmet vuoruid mielde bálván ja klientan.  
Bálvá - klienta (Server - client): Fierpmádagas lea guovddáš dihtor mii gohčoduvvo bálván
(server, tjener), ja mas sáhttá viežžat dieđuid buot dihtoriin. Oktavuohta olggobealde
dihtoriiguin (omd. interneahtta) manná dán bálvvá bokte. 
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Báikkálaš fierpmádagain, omd. skuvllas dahje bargosajis, lea dábálaččat bálvá, mii bálvá
dihtoriid dahje bargostašuvnnaid (workstation). 

Bargostašuvnnat sáhttet leat guovttilágán: 

1. Dábálaš dihtorat, main leat iežas garraskearru gos deháleamus prográmmat leat
vurkejuvvon. Muhto geavaheaddjit eai vurke iežas dihtora garraskearrui, muhto bálvái, iežas
guvlui. Muhtin prográmmat sáhttá maiddái doaimmahit njuolgá bálvvás. Dakkár dihtor
gohčoduvvo assas klienta (thick client). 

2. Dihtor mas lea dušše boallobeavdi, šearbma ja muitu, muhto ii dárbbaš iežas garraskearru.
Dat váldá buot prográmmaid bálvvás. Dakkár dihtor gohččoduvvo ásehis klienta (thin client).
 
Jus du dihtor skuvllas dahje bargosajis lea oassin fierpmádagas, fertet dábálaččat čállit
geavaheaddjinama ja beassansáni (passord, password) ovdal go beasat geavahit bálvvá
bálvalusaid. 

Bargobihttá: Mo lea du bargosajis dahje skuvllas? Lea go dihtor maid don geavahat čadnon
eará dihtoriidda? Jus lea, man láhkai?

________________________________________________________________________

Ollu fierpmádagain sáhttá juohke dihtoris geavahit prográmmaid ja eará fiillaid mat leat
bálvvás. Dalle sáhttá iskadeaddjiprográmmas (omd. Konqueror dahje MS Explorer)
geahččat mii bálvvá garraskearrus lea. Jus vurket fiilla bálvái, sáhtát viežžat dan juohke
dihtoris mii lea čadnon dán fierpmádahkii. Bálvvás lea dábálaččat garraskearru dahje oassi
garraskearrus mii lea rabas buot geavaheddjiide, ja eará oassi gos dušše
dihtorovddasvástideaddji beassá vurket ja sihkut. Sáhttá máid leat oassi mii lea rabas dušše
eaŋkil geavaheaddjái. 
Dihtoriidda  mat leat čadnon fierpmádahkii dárbbašit fierpmádatkoartta (network card) vai
besset gulahallat bálvváin dahje eará dihtoriin.

MO GULAHALLAT?

 Jus áigu gulahallat olbmuiguin geat leat guhkkin eret, leat máŋga vejolašvuođa.
Signálat sáhttet mannat telefunlinjá, sierra johtasa mielde dahje radiobáruid bokte. Ferte
čatnat dihtora oktii modemain, ISDN-koarttain dahje fierbmádatkoarttain. Muhtin
mobiltelefuvnnat leat ráhkaduvvon nu ahte sáhttá sáddet ja oažžut dieđuid liigebiergasiid
haga.
Modem lea "dulka" mii dahká vejolažžan sáddet ja oažžut dieđuid dihtoriid gaskkas. 
Dábálaš "boaresmálle" telefuvnnat ja telefunlinját eai geavat seamma gulahallanvuogi go
dihtorat. Sáhttá lohkat ahte dain ii leat oktasaš giella. Telefuvdna doaibmá analogalaččat8 ja
dihtor fas digitálalaččat. Go sádde dieđu muhtin dihtoris nuppi dihtorii dákkár telefunlinjá
bokte ferte leat muhtinlágan "dulka" mii jorgala digitálagielas analogagillii ja nuppi geahčen
linjás fas dulka mii jorgala analogagielas digitálagillii. Modema leaktu váikkuha man jođánit
sáhtát sáddet dieđuid. Dál (2004) dábálaš modem sáhttá sáddet 56 kbits/s, muhto
praktihkalaččat ii dávjá mana nu jođánit.

8 Analoga: signálat molsašuvvet oktilaš skála mielde
Digitala: cehkiid mielde, . 

85 85



Gávdnojit sierra modemat mat sáhttet atnit mobiltelefuvnna. Muhtin mobiltelefunnain lea
iežas modem. Earát doibmet dan láhkai ahte ferte váldit mobiltelefuvdnakoarta eret
telefuvnnas ja bidjat dan modema sisa.
 
ISDN (Integrated Services Digital Network)lea vuogádat mii dagaha ahte sáhttá sáddet
dieđuid digitála hámis dulkka haga. Modema sádjái ferte leat ISDN-koartta, maid dábálaččat
bidjá dihtora sisa. Leaktu lea gitta 64 dahje 128 kbits/s ISDN:in. ISDN-abonnemeanttas leat
2 dahje 3 telefonlinjá, vai sáhttá hupmat telefuvnnas seammás go dihtor lea čadnon
internehtii.
Govdabáddi (breiband, broad band) lea teknologiija, mainna lea vejolaš bajidit leavttu
issorasat, gitta moadde milliovnna signála sekunddas dahje Mbits/s rádjái. Dát mearkkaša
ahte sáhtát álkit viežžat stuorra fiillaid ja ahte ii leat nu ollu vuordináigi interneahtas. Jagis
2004 dat ii leat vel olamuttus buot sajiin, muhto lea šaddame oalle dábálaš skuvllain ja
fitnodagain. Govdabáddi sáhttá juogo leat fiberoptihkalaš johtasiin, atnit
elrávdnjefierpmádaga, kabel-TV, radio- dahje TV-signálaid.
ADSL (Asynchronous Digital Subscriber Line) lea govdabáddefálaldat, mii sáhttá geavahit
dálá telefunlinjáid. Dasa dárbbašuvvo sierra abonnementa, ADSL-modem, fierpmádatkoartta
ja nu gohčoduvvon «splitter» mii earuha interneahta ja telefundoaimmaid. Leaktu olggoš lea
sullii seamma go ISDN, muhto sisa manna ollu jođánebbo. Telenor fállá ADSL linjáid main
leat 384 - 1024 kbit/s. 
 

11.2. DATAFAKSA  
 Modema dahje ISDN-koartta bokte sáhtát sáddet telefavssa. Gávdnojit máŋga

datafaksprográmma. KDE:s lea prográmma man namma lea KDEprintFax. 
Muhtin teakstagieđahallanprográmmain sáhtát čállit reivve ja de válljet  datafaksprográmma
čálánin. Dalle boahtá ruvtto gosa sáhtát čállit telefaksnummira ja sáddet. 

11.3. INTERNEAHTTA
Interneahtta lea fierpmádat man bokte dihtoriiguin sáhttá gulahallat miehtá máilmmi. Leat
máŋga bálvvá mat leat čadnon oktii, ja diehtu sáddejuvvo elektrovdnalaš signálan bálvvás
bálvii ja du dihtoris ja dihtorii dan bálvvá bokte masa dihtor lea čadnon. 
Interneahta bokte sáhtát gulahallat máŋgaláhkai. Deháleamus gulahallanvuogit leat: 

Máilbmefierpmádat
(World Wide Web,
www)

Máilbmefierpmádat lea dihtorfiillat mat leat čatnon oktii ng. hyperteavstta bokte.
Dain lea dihtorgiella (kodenvuohki) html, Hyper Text Markup Language ja
sáddenvuohki lea http, Hyper Text Transfer Protocol

E-poasta (e-mail) Sáddet reivve interneahta bokte jugo eaŋkilolbmui dahje poastalistui (mailinglist)
Telnet Telnet lea vuohki maiguin sáhttá geavahit bálvvá prográmmaid. Dán sáhtát atnit

dušše jus dus lea šiehtadus bálvváin mii fállá Telnet-oktavuođa. Telnet sáhttá
maiddái geavahuvvot gulahallamii báikkálaš fierpmádagain Linuxas sáhttá
geavahit telnet konsollas.

Usenet Usenet dahje newsgroups lea ságastallanforumat gos sáhtát ságastallat earáiguin
geain lea seamma beroštupmi. Lea vejolaš gávdnat joavkkuid vaikko man fáttá
birra. Gávdnojit máŋga duháhiid dákkár joavkkut. Muhtin joavkkut gáibidit
beassansáni. (Samenet:s lea ee. Usenet-doaimmat.) Muhtin epoastaprográmmat ja
fierpmádatloganat sáhttet maiddái geavahuvvot ođasjoavkkuide. 
KDE:s sáhttá geavahit prográmma Knode, K > Internett > Knode. 
Eará prográmma Linuxa várás lea Pan.

FTP (File Transfer
Protocol)

FTP lea vuohki mainna čanat njuolgga muhtin eará dihtorii. Don sáhtát lohkat mii
dan dihtoris lea, sáddet fiillaid dohko ja viežžat fiillaid. Geavahuvvo ee. jo bidjá
fierbmesiidduid iežas dihtoris bálvái. KDE:s sáhtát gevahit Konqueror dása,
muhto gávdnojit maiddái sierra FTP-prográmmat
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Čat (chat) Go guokte dihtorgeavahaeaddji leaba čadnon fierpmádahkii oktanaga, ja sudnos
lea čattenprográmma, de sáhttiba čállit njuolga nuppis nubbái. Nubbi oaidná dan
dakkaviđe ja sáhttá vástidit. Gávdno maid prográmmat maiguin sáhttá hupmat,
muhto dat gáibida liigebierggasiid. KDE:s sáhtát geavahit čattenprorgámma
Kvirc. Eará prográmma Linuxa várás lea X-Chat

Kazaa Fiillaid lonuhallan, erenoamážit geavahuvvon jietna- ja videofiillaide

Nettverksspel
Telefon (VoIP) Muhtin sájiin gávdno fáláldaga geavahit telefuvnna interneahta bokte, mii lea

erenoamáš gannehahtti go galgá čuojahit eará riikkaide.

Dás mii čilget dárkilit dušše máilbmefierpmádaga ja e-poastta.
Bargobihttá: Geahččal gávnnahit makkár gulahallanvugiin sáhtát geavahit Samenet bokte.

11.4. E-POASTA 
 Jus dus lea iežat internetdoallan oaččut dábálaččat e-poastaprográmma ja iežat e-

poastačujuhusa. It dárbbaš iežat internetdoallama it ge iežat dihtora vai sáddet ja oažžut e-
poastta. Sáhtát oažžut nuvttá e-poastačujuhusa ja geavahit dan bargosajis, olbmáid luhtte
dahje internetkafeas.
E-poastačujuhus huksejuvvo dábálaččat ná:
geavaheaddjinamma@domenanamma.riikkakoda, omd. per.eira@same.net dahje
ravdna.sara@trollnet.no. Muhtin internetbuktit gesset nama čoahkkái, nu ahte Inger
Persenis sáhttá leat čujuhus ingpers@online.no.
Leat máŋga prográmma maiguin sáhtát čállit ja lohkat e-poastta., ee.:
Linuxa várás: KMail, Ximian Evolution, Mozilla Mail
Windowsa várás: Microsoft Outlook Express, Eudora.
Sihke Linuxa ja Windows: Opera, Netscape Messenger, Pine
Prográmmain Mozilla, Opera ja Netscape leat sihke fierpmádatlogan ja epoastadoaibma.

Dás mii čájehit KMail, mii lea oassin KDE:as ja Skuvlalinuxas. Eará prográmmain leat
sullasaš doaimmaid. 

KMail gávnnat KDE:as vuolimus linnjás, go deaddilat dan govaža: 
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Fierpmádagaid bokte leat máŋgalágan gulahallanvuogádagat, muhto dás áigut čilget dušše
dat guokte mat buohkat dárbbašit; e-poastta ja máilbmefierpmádaga (www).

HEIVEHEAPMI
Ovdal go sáhtát sáddet dahje vuostáiváldit reivve, fertet heivehit KMail iežat konto ektui.
Manat dalle dohko: Heivehusat > Heivet KMail:a. Dieđut iežat ja du konto birra fertet
bidjat  Identitehtat ja Fierpmádat vuollái. Juste maid galggat čállit deike eat sáhte muitalit,
go dat sáhttá molsašuvvat du interneahttabonnemeantta ja interneahttaoktavuođa mielde. Dás
berret jearrat hálddašeaddjis dahje iskat interneahtabuvtti čilgehusa. 

Dá gávnnat ollu eará mii lea ávkkálaš. Berret ee. mannat dohko: Fárda > Fonttat ja
cealkit ahte du reivvet galget čállojuvvon Unicode:s. Dát lea erenoamáš dehálaš jus čálát
sámegillii. 

ČÁLLIT JA SÁDDET REIVVE

Go deaddilat dán mearkka, ihtá reiveskovvi:

Dás fertet deavdit:
Vuostáiváldi: e-poastačujuhus gosa áiggut čállit, omd. anneolsen@online.no
CC: Dása deavddat jus áiggut sáddet reivve maiddái eará olbmuide.
Fáddá: Mottiin sániin man birra čálát.
De sáhtát čállit reive dan stuora vilges gieddái.
Go leat geargan de sáhtát deaddilit sáddenboalu:  dahje Reive > Sádde. 

Sáhtát maiddái viežžat reivve maid don juo leat čállán muhtin eará prográmmas, omd.
KWord dahje Kate. Jus áiggut kopieret eará fiilla deike, mana dan čállinprográmmii, raba
fiilla ja máŋge dan. Mana KMail:ii, oza doaimmat ja fas liibme. Du teaksta ihtá fas, ja sáhtát
deaddilit sádden-boalu.  

Jus háliidat ahte son geasa sáddet reivve galgá oažžut dan juste dan hámis maid don leat
čállán, de sáhtát sáddet olles fiilla mielddusin, Mielddus > Bija fiilla fárrui. Go dán
deaddilat beasat ohcat fiilla maid áigut sáddet ja merket dan. Mielddusin sáhtát sáddet
buotlágan fiillaid: teakstafiillaid, govaid ja prográmmaid, muhto fiillat eai berre leat beare
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stuorat. It berre sáddet fiillaid mat leat stuorat go 1 MB, šiehtatkeahttá vuostiváldiin
ovdalgihtii. Jus sáddet mildosa galggat álo čállit oanehis teavstta maiddái reiveskovis, vai
vuostáiváldi diehtá mas lea sáhka ovdal go rahpá mildosa. Jus vuostáváldi galgá beassat
lohkat ja geavahit fiillaid, de sus berre leat vuogas prográmmaid dasa. Jus it dieđe mii sus
lea, lea buoremus vurket teakstafiilla maid áigut sáddet formáhtas *.rtf dahje *.txt.

Sáhtát čállit reivviid gárvvisin ovdal go čanat internehtii, vai it dárbbaš máksit eambbo go
dan áiggi ovdas mii manná sáddet reivviid. Sáhtát dalle vurket dan álgoevttohusmáhppii
(Reive > Vuorkke Álgodivodusat-máhppii). Go čánát internehtii, rahpat dan fas ja saddet. 

Bargobihttá: Dál sáhtát čállit ja sáddet reivve. Sáhtát omd. čállit dán girjjáža čállái, vai
oainnán gávdno go olbmot geat geavahit dan. Čujuhus leat sveilund@online.no. Sáhtát CC
vuolde čállit iežat čujuhusa. Dalle oaččut ieš kopiija reivves. Dát sáhttá leat ávkkalaš jus
háliidat iskat ahte e-poastta doaibmá.

OHCAT REIVVIID

 

Go leat čádnon internehtii deaddilat dán boalu (Iskka boastta dáppe). Lea vejolaš ahte fertet
čállit beassansáni ovdal go beasat viidáseappot ja muhtin áiggi maŋŋil ihtá šerbmii diehtu lea
go reive dutnje. 
Jus lea poasta dutnje boahtá ovtta linjá guđege reivve birra: Dás láve leat fáddá, geas reive
lea, goas lea sáddejuvvon ja man stuoris reive lea. Jus deaddilat dan linjá boahtá olles reive 
šerbmii.
 

VÁSTIDIT REIVVE   
Jus háliidat vástidit, deaddil dán boalu  (Vástit). Álggahuvvon reive ihtá, mas lea

olles teaksta maid don leat ožžon ja du čujuhus ja vuostáválddi čujuhus lea gárvvis.
Teavsttas maid don leat ožžon álgá juohke linjá ">"-mearkkain. De sáhtát kommenteret
reivve ja sihkut osiid maid it áiggo kommenteret. 
Jus reive maid don leat ozzon maiddai leat sáddejuvvon máŋga earáide ja don háliidat sáddet

vástádusa buohkaide, deaddilat baicce dan boalu:  (Reply to all)

ČÁLLIT / LOHKAT SÁMEGIEL E-POASTTA 
Jus ovdal leat bargan eará operatiivavuogádagaiguin dahje boares Linux-veršuvnnain,
soaittát fuomašan váttisvuođaid go galgá sáddet ja lohkat e-poasta sámegillii. Jus dus lea
Skuvlalinux dahje eará ođđa Linux-veršuvdna, mas lea unicode vuođđun, de sáhtát seamma
álkit čállit sámegillii go eará gielaide. Muhto jus it dieđe makkár prográmma vuostáiválddis
lea, sáhtat sihkarvuođa dihtii maiddai sáddet reive mildosin. Dalle lea unnit vejolašvuohta
ahte sámegiel bustávat rivdet rievssatgazzan. 

11.5. MÁILBMEFIERPMÁDAT
Máilbmefierpmádat dahje eŋgelasgillii World Wide Web lea dego elektrovdnalaš
heavdnefierbmi, gos sáhtát mannat ruossut rássut fiillaid gaskkas, mat gávdnojit bálvváin
miehtá máilmmis. Vuohki mii dahká dan vejolažžan gohčoduvvo hyperteakstan, ja juohke
fiilla dahje siidu mii gávdno máilbmefierpmádagas lea čadnon eará siidduide, mat sáhttet leat
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seamma fierpmádatbáikkis (nettsted, website), eará fierpmádatbáikkis seamma domenas
dahje áibbas eará domenas dahje velá riikkas. 
Jus dus lea lihkku, buorit dihtorbierggasat ja prográmmat ja buorre oktavuohta bálvváin
sáhttá mannat oalle jođánit viežžat siiddu maid don ožat. Muhto dávjá ferte vuordit muhtin
áiggi, erenoamážit jus fierpmádatsiiddus leat ollu govat. Danin lohket muhtumat ahte www
mearkkáša World Wide Waiting, dahke máilbme guhkás vuordin.
NUgo mii áigut oaidnit mail lea áigi mii afjána ráhpat muhtin siidu ollu dan duohken mo dat
lea ráhkkaduvvon.

FIERPMÁDATLOGANAT
Go galggat gávdnat dieđuid máilbmefierpmádagas dárbbašat fierpmádatlohkanprográmma.
Eŋgelasgillii gohčoduvvo browser, dárogillii nettleser ja sámegillii sáhttá gohčodit dan
fierpmádatloganin dahje golgadanprográmman. Dakkár prográmmat leat ee.: 
Linux: Konqueror, Mozilla, Galeon
Windows: Microsoft Internet Explorer
Linuxa ja Windows: Netscape Navigator, Mosaic, Opera, Lynx

Golgadanprográmmain leat sullii seamma doaimmat, muhto hápmi sáhttá leat oalle
iešguđetláganat. Siddjiide geat ráhkadit fierpmadatsiidduid lea danina dehálaš geahcadit daid
moadde fierpmadatloganis.

Linuxa várás leat guoktelágan fierpmádatloganat: 
1. Prográmma mii ovttastáhttá fierpmádatlogana ja epoastadoaimma: Opera, Netscape,
Mozilla
2. Prográmma mii ovttastáhttá fierpmádatlogana ja fiilagieđahalli: Konqueror.

ČUJUHUSAT
Juohke siidu interneahtas lea iežas čujuhus (adress). Fierbmesiiddu čujuhus gohčoduvvo
maiddái URL, Uniform Resource Location. Jus dovddat interneahtačujuhusa, sáhtát čállit dan
čujuhusgieddái (vilges gieddi mii eanaš fierpmádatloganiin lea badjin šearpmas) ja deaddilit
Enter-boalu.

Mii galgat geaččat mo dakkár čujuhus lea huksejuvvon ja maid ieŋguđetge oasit
mearkkašit. Ovdamearkan mii váldit siiddu http://www.davvi.no/sami/nyheter.html. Álggos
lea http://. Dat lea oanádus mii muitala ahte gulahallanvuohki lea Hypertext Transfer
Protocol. Eanaš siiddut mat leat interneahtas leat http, muhto vissis doaimmaide mis leat eará
protokollat, nugo ftp://.

Oassi mii boahtá ovdal boahtte vinjusázu mii gohčudit domenačujuhusa. Domena mearkkaša
aiddonassii sierra bálvá, (server), muhto duohta dilis máŋggas leat sierra domena vaikko sis
ii leat iežaset bálvá (gohčoduvvo virtuála bálván). Álggos dán domenačujuhusas boahtá
“www”, mii mearkkaša ahte dát lea čujuhus Máillmmefierpmádagas (World Wide Web). Hui
ollu čujuhusain leat www, muhto eai fal buohkain. Dávjá mii sáhttit vealtit dan, muhto ii fal
álu.  (Geahččal čállit dušše http://davvi.no ja geahča mii dáhpáhuvvá.)

Boahtte oassi lea dávjá fitnodaga, searvvi dahje ásahusa namma, dahje dan nama
oanádus dahje variánta. Čujuhusas  www.davvi.no mii oaidnit ahte Davvi Girji ii leat
geavahan olles fitnodaga namma. Eatnasat háliidit oanehis nama, seammas go galgá leat álki
muitit ja dovdat. Eará ovddamearkkat leat www.nsr.no , www.samediggi.fi ja
www.same.net.  

 Loahpas lea koda, mii juogo muitala man riikkas dát čujuhus gullá dahje man lágan
fierpmádatsiidu dat leat. Riikkakodat leat omd. no = Norga, se = Ruoŧŧa, fi = Suopma, ru =
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Ruošša ja dk = Dánmárku. Leat maiddái moadde iešstivrejeaddji guovllu main leat iežaset
riikkakodat, nugo gl = Kalaallit Nunat /Ruonaeatnan ja fo = Fearsullot. Kodat com, net ja
org sáhttet leat vaikko gos máilmmis. Interneahta álggii USA:s, ja danin doppe dábálaccat
eai ane riikkakoda us, muhto riikkaidgaskkasaš kodat ja sierra kodat nugo gov, edu ja mil. 
Muhtin riikkain sáhttet maiddái kombineret dákkár kodar ja riikakoda, nugo com.pl ja co.uk.

Go čálát dákkár čujuhusa boađát domena váldosiidui dahje ruovttosiidui. Das galgá
leat namma index.html dahje index.htm, muhto dan ii dárbbaš čállit go čállá čujuhusa.
Domenanamma maŋŋil boahtá muhumin siiddu namma, omd.:
http://www.samisk.vgs.no/mekanisk.htm 

Domenas leat fierpmádatsiiddut dábálaččat vurkejuvvon ozuide. Ohcut sáhttet omd.
leat ordnejuvvon giela mielde, nugo Davvi Girjjis: www.davvi.no/sami lea ohcu mas leat
sámegiel dokumenttat, ja www.davvi.no/norsk fas leat dokumeanttat dárogillii ja
www.davvi.no/english      eŋgelasgillii. Dábálaččat lea juohkin fáttáid mielde, ja earát fas juhket
dokumeanttait jagi dahje mánu mielde go dat leat ráhkaduvvon. 

Fierpmádatbáikkiin main eai leat nu ollu siiddut, sáhttet vurket daid njuolga ohconama
vuollái, ozuid haga. Eará fierpmádatbáikkiin, main leat ollu siiddut, geavahit sihke ozuid ja
vuolleozuid, nugo dát čujuhus:
http://www.saamiweb.org/saami/news/2004/01/776118.html 
Eanaš siiddut interneahtas leat goargu *.html dahje *.htm. (Gávdnojit maiddái eará
fiilašlájat, nugo *.shtml ja *.php) 

Fitnodagain ja serviin leat dábálaččat iežaset domena. Priváhta olbmuin fas leat dávjá
sierra fierpmádatbáiki, muhto sierra domena haga. Jus dus lea dábálaš interneahttadoallan, de
dus lea dávjá vuoigatvuohta bidjat iežat fierpmádatsiidduid interneahttabukti bálvái. Dalle
oaččut čujuhusa, mas álggos boahtá bukti domena, de vinjusázu maŋŋá du namma dahje
geavaheaddjinamma. Dát šaddá dalle ozu namma bukti bálvvás. De čujuhus joatká ozuiguin
ja fillanamaid nugo čilgejuvvon. Muhtin siiddu namma sáhttá dalle leat omd. dakkár:
http://home.online.no/~sveilund/sami/inetsas2.htm

LEAŊKKAT
Measta juohke internetsiiddus leat sánit dahje cealkagat mat leat vuolláisárgojuvvon ja/dahje
čállojuvvon alit bustávaiguin. Go sirddát seavána dohko dat dábálaččat rievdá giehtan.
Doppe lea leaŋka maid sáhtát deaddilit, ja de beasat ođđa siidui (áiggi mielde, jus dus lea
lihkku). Dávjá rievdá leaŋkka ivdni maŋŋil go leat leamaš doppe, nu ahte sáhtát oaidnit man
siidduin leat leamaš.  Dát lea diehtu mii vurkejuvvo du dihtorii, nu ahte sáhtát dan boahtte
háve go manat dán siidui. Leaŋka sáhttá maiddái leat govva dahje eará mearka. Jus jođát
seavániin miehtá gova ja oainnát ahte seaván rievda giehtan, dieđát ahte dat lea leaŋka ja
ahte sáhtát deaddilit dasa. 
Leaŋka sáhttá mannat eará siidui seamma fierpmádatbáikkis dahje eará fierpmádatbáikái.
Measta juohke fierpmádatsiiddus leat moadde leaŋkka nu ahte sáhtát čuovvut daid ja joatkkit
nie siiddus siidui ja golgadit dahje surfet miehtá interneahta.

GIRJEMEARKKAT
Jus áiggut fitnat seamma siiddus máŋgii, it dárbbaš čállit čujuhusa juohke háve. Go leat dán
siiddus maid háliidat, deaddilat Girjemearkkat (muhtin prográmmain gohčoduvvo
Bokmerke / Bookmark dahje Favoritter / Favourites). Dađistaga go oaččut ollu
girjemearkkaid sáhttá leat buorre čorget daid ozuide. Girjemearkkaid vuolde gávnnat
doaimma man namma lea Doaimmat girjemearkkaid dahje sullasaš
Bargobihttá: Mana fas muhtin daid siidduide maidda leat čállon čujuhusaid dás bajábealde
ja ráhkat daidda girjemearkkaid. Ráhkat daidda ozuid.
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OHCANBÁLVALUSAT 

     

Jus háliidat dieđu muhtin fáttá birra, muhto it dieđe gos gávdnat dan, de sáhtát atnit
ohcanbálvalusaid (søketjenester, søkemotorer, search engines). 

Leat máŋgalágan ohcanbálvalusat. Váldošlajat leat: 
- Bálvalusat mat ohcet buot interneahta siidduin gávdno go sátni dahje doaba maid ozat.
Ovdamearkkat: Alta Vista (http://www.altavista.com), Euroseek (http://www.euroseek.net),  
Fast (http://www.alltheweb.com) ja Google (http://www.google.com)
- Bálvalusat mat leat ráhkaduvvon fierpmádatsiidduid fáttáid mielde.
Ovdamearkkat leat Kvasir (http://kvasir.sol.no) ja Yahoo (http://www.yahoo.com)

1990-loahpas, bargadettiinan «Mu unna dihtorgirjjáža» vuosttaš veršuvnnain, ožžon nugo
vuolábealde govva čájeha, 4230 deaivama sánis "Finnmark". Go geahččalin fas 2004
juovlamánu, ožžon iešguđetge ohcanmohtoriin gaskal 150000 ja 1800000 deaivama! Dat
čájeha man ollu dieđut interneahtas lea lassán sullii viđa jagis. 

Go ohcanmohtor lea gávdnan muhtin siiddu mii sisttisdoallá vissis sáni dahje dajaldaga,
ráhkada čoahkkáigeasu, mas boahtá siiddu tihtal ja vuosttáš sániid dahje oassi teavsttas mas
dát sánit leat mielde. Dá lea ovddamearka mii bođii go ozaimet «Finnmark».

Lea čielggas ahte it sáhte geahčadit duháhiid siidduid. Fertet danin gávdnat vuogi ráddjet
ohcama. Sáhtát kombineret ohcansániid dahje čállit dajaldaga mas leat moadde sáni. Dás
leat veahá erohus iešguđetge ohcanmohtoriid gaskkas. Jus čálát guokte dahje eanet sániid,
oaččut juogo fiillaid main buot sánit leat mielde, dahje sáhtát oažžut buot deaivvamiid main
lea muhtin dain sániin. Muhto dalle oaččut álggos deaivamiid main leat buot sánit. 
 
Muhtin ohcanmohtoriin sáhtát čállit & dahje + ohcansániid gaskkas. Dajaldagaid sáhttit
bidjat áisttonmearkkaid sisa, omd. "Finnmárkku fylkkadiggi" addá dušše deaivama jus lea
čállon juste nie, siiddut mat sisttisdollet goappašiid sániid eai čájehuvvo jus sánit eai boađe
maŋŋálágaid nuste nie. 
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Eanaš ohcanbálvalusain sáhtát gávdnat čilgehusa mo ohcat jus deaddilat Avansert søk,
Advanced search dahje sullasaš. Dalle sáhtát dávjá maiddái válljet giela, nu ahte oaččut
dušše siidduid mat leat čállon dan gillii maid haliidat. Dađe bahábut ii leat vel oktage
ohcaaanmotoris vejolaš válljet sámegiela. 

Dan dihte go sámi bustávat eai leat álo čállon riekta interneahtas, berre go ohcá sámi
sániid ohcat sihke sámi bustávaiguin ja daid haga, omd. sihke "Sápmi" ja "Sapmi", sihke
"Beaivváš" ja "Beaivvas". 

Bargobihttá: 
1. Aviisa lea čállán juoidá mapuche-álbmoga birra. Muhto mii álbmogiid dat lea ja gos sii
orrot? Ane ohcanbálvalusa ohcat dieđuid mapuche-álbmoga birra. Geahččal 4 ohcanbálvalus
ja geahča lea go stuora erohus dáid gaskkas. 
Man riikkain oaččut dieđuid? Man gillii oaččut dieđuid?
Sáhtát go gávdnat manin gohčodit mapuche-álbmoga giela?

2. Dán maŋŋil sáhtát ohcat iežat ruovttobáikki seammaláhkai. Jus dat báikkis lea sihke
sámegiel ja dárogiel nama, sáhtát geahččalit goappašiid. Maid muitala boađus?

GIELLAKODEN
Go rabat muhtin siiddu interneahtas, soaittát oaidnit ahte buot bustávat eai boađe oidnosii
rievttes láhkai. Dát guoská sihke sámegillii, dárogillii ja eará gielade mat gavahit bustávaid
mat eai leat eŋgelasgiel alfabehtas. 

Interneahtas leat máŋga giela ja alfabehta. Jus galggat beassat lohkat muhtin giela
rievttes láhkai, dat lea sihke dan duohken mo siidu lea ráhkaduvvon, makkár
operatiivavuogádat ja golgadanprográmma dus lea, ja mo don ieš leat dárkkistan
prográmma. 

Čáliimet kapihtalis 3.4. kodatabeallaid birra. Otne measta buot sámegiel siiddut leat
ráhkaduvvon Unicode:s, muhto dárogiel, ruoŧagiel ja suomagiel siidduide lea ain dábáleamus
geavahit ISO-8859-1 dahje windows-1252. Jus siidu lea kodejuvvon rievttes láhkái, galget
eanaš fierpmádatloganiid automahtalaččat sáhttit gávdnat rievttes kodema. Muhto dát ii
doaimma álo. Sáhtát dalle geahččalit heivehit dan ieš. (Čájet > Bidjat kodema.) Sáhtát
geahččalit unicode (utf-8) ja ISO 8859-1. Jus ii goappage dain čájeha dán giela sierra
bustávaid riekta, sáhttá leat meattáhus juogo fierpmadatloganis dahje siiddu kodemis. 

Sáhtát mannat siiddu gáldui ja geahččat leat go das dieđut dan birra man kodatabealla
lea geavahuvvon. (Čájet > Čájet dokumeáldu / Vis > Kjelde / View > Page source)
Dokumeantta álggos galgá leat "charset=" ja dan kodatabealla namma man mielde siidu lea
ráhkaduvvon. Jus lea «windows-1252» dahje «ISO-8859-1», de lea 8-bihtá-vuogádat. Jus
teavsttas leat kodar nugo <font face= «sam times w2»> dahje sullasaš, de lea maiddái 8-
bihtá. Muhto jus oainnát charset=UTF-8, de lea unicode. Jus sámi bustávat šaddet
gažaldatmearkkaid, de lea siidu čállon unicode:s, muhto du fierpmádatlogan lea heivehuvvon
8-bihtá kodemii. Jus sámi bustávat šaddet eará rievssatgazzan de lea jáhkkehahtti ahte siidu
lea čállon 8-bihtá-kodii.

Muhtin boares sámegiel siiddut leat ain kodejuvvon muhtin 8-bit-tabealla mielde,
omd. WS2 (Levi) dahje ISO-IR-197. Jus galggat sáhttit lohkat daid riekta, de dus ferte leat
installerejuvvon sámi fonttat dán kodatabealla várás. Dakkár siiddut šaddet dađistaga
ođasmáhttojuvvon dahje jávket, danin ii oro šat leame nu stuora dárbu installeret dákkár
fonttaid dihtorii mii muđuid geavaha unicode.  

Leat leamaš, ja leat ain ollu sámegiel siiddut mat eai leat konsekveanta kodejuvvon,
dan dihte go sii geat leat ráhkadan siidduid eai leat diehtán doarvái kodema birra.
Ovdamearka lea dát siidu (mii dál, 2005, orru leame jávkán):
http://www.samediggi.fi/psaame/su1.htm. Dás čállo álggos ahte mearkaráidu lea windows-
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1252 (oarjeeurohpalaš 8-bihtá), maŋŋil leat čállon ahte fonttat leat Sam Times W2 (eará 8-
bihtá koda, WS2 dahje Levi2), muhto duohta dilis sámi bustávat teavsttas leat kodejuvvon
unicode:s. 

KONQUEROR FIERPMÁDATLOGÁNIN

Mii leat juo čájehan 8. kapihtalis mo geavahit Konqueror fiilagieđahallin. Dás mii čájehit dan
fierpmádatloganin. Seammás mii čujuhit dasa mo eará fierpmádatloganat doibmet.
  

Sáhtát čállit vilges gieddái dan fierpmádatčujuhusa maid háliidat oaidnit (omd.
http://www.kde.org) ja coahkkalit Enter. Seammaláhkái go fiilagieđahallamis geavahat
neavvolinjá golmma njuola go navigeret fierpmádatsiidduid gaskkas. Jos háliidat máhcat
ovddit fierpmádatsiidui, coahkkalat njuola ala mii manná gurutguvlui.

Go oktii leat čállán ovtta čujuhusa ja ožžon siiddu oidnosii, sáhtát ráhkadit girjemearkka.
Mana dohko Girjemearkkat > Lasit girjemearkka / Bokmerke > Legg til bokmerke.
Mana fas Girjemearkkaide, vai oainnát mo dát siidu lea čállon du listui. Lea muhtin linjá
siiddu html-kodas mii mearrida mii galgá boahtit ovdan dás, muhto buohkat geat ráhkadit
fierpmádatsiidduid eai fuola ahte dát linjá addá ávkkálaš dieđuid. Sáhtát ieš rievdadit dieđuid
girjemearkkas. Mana dohko Girjemearkkat > Doaimmat girjemearkka / Bokmerke  >
Rediger bokmerke. Coahkkal olgeš boaluin linjái maid háliidat rievdadit ja dan maŋŋil
dasa:  Rievdat nama / Endra namn. Dál sáhtát čállit čoavdasániid mat heivejit dutnje nu
ahte álkkit gávnnat fas dán siiddu. 

Go leat ožžon ollu girjemearkkaid, sáhttá leat váttis gávdnat rievttes giejemearkka
fas. Dalle sáhtát  čorget daid. Mana Girjemearkkat > Ođđa girjemearkamáhppa, čále
máhpa nama ja deaddil OK. Go leat ráhkadan máhpaid maid háliidat, deaddilat
Girjemearkkat > Doaimmat girjemearkkaid ja hoigat girjemearkkaid sáhpániin rievttes
máhpaide. 
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11.6 RÁHKADIT FIERPMÁDATSIIDDUID

DIHTORGIELLA HTML
Máilbmefierpmádaga vuođđun lea dihtorgiella HTML - Hyper Text Markup Language.
Kodat leat ráhkaduvvon standárdda mielde vai buot fierpmádatlohkkit galget sáhttit lohkat
daid sullii seamma láhkai. HTML lea standardiserejuvvon W3C  (WWW Consortium)
mearrádusaid bokte. Das leat mielde sihke stáhtat ja stuorimus dihtorfitnodagat. 

Mii earuhit stáhtalaš ja dynámalaš fierpmádatsiidduid. Stáhtalaš siidu báhcá nugo
buvttideaddji lea ráhkadan dan. Dynámalaš siidu ráhkaduvvo bálvvas, lohkki gohččumiid
mielde. Ovdamearka lea ohcanmohtoriin ohcama bohtosiid. Eai leat buot bálvvát mat fállet
dynámalaš siidduid, go dat gáibbadit ollu návccaid bálvvás. Mii áigut dás dušše čilget
stáhtalaš siidduid. 

Ovdal go ieža čálligoahtit, de mii galgat geahččat mo fierpmádatsiidu lea
huksejuvvon. Álggat Konqueror dahje eará fierpmádatlogana ja rabat muhtin
fierpmádatsiiddu. Jáhkimis oainnát čáppa siiddu mas leat máŋgalagan čálamearkkat (fonttat),
govat ja ivnnit. Muhto dál mii áigut geahččat mii lea dán duohken, mo dákkár siidu oidno go
lea kodejuvvon html-hámis. Deaddil: Čájet >  Čájet dokumeantadieđuid (View > Page
source). Dál don leat html-hámis. Oainnát šearpmas teavstta mas buot mearkkain lea
seammá stuorrudat ja hápmi. Teavstta lassin maid oidnet ovddit govas leat dievvá kodat. Dát
kodat mearridit mo siidu šaddá go mii oaidnit dan muhtin fierpmádatloganiin. 

FIEPMÁDATSIIDDUID ČÁLLINPROGRÁMMAT
Leat máŋgalágan prográmmat maiguin sáhtát ráhkadit fierpmádatsiidduid. 
Sáhttit juohkit daid njeallje joavkui: 

A. Teakstaeditor mas ieš fertet čállit buot html-kodaid:
KDE:as leat golbma dákkár prográmma: KEdit, KWrite ja Kate. Sullasaš Windowsa várás
leat NotePad ja NoteTab. 

B. HTML-editor mii ieš muhtin muddui ráhkada kodaid, oainnát kodaid čálidettiin. 
Linuxa várás leat máŋga dákkár prográmmat, ee. CoffeeCup, Bluefish, Quanta+, Screem,
August ja Ginf.
Sullasaš Windowsa várás leat ee. DiDa ja Hotdog. 

Sihke A ja B-editoraid ovttas fertet geavahit fierpmádatlogana vai oainnát mo siidu šaddá.

C. Grafalaš html-editorat. 
Don oainnát siiddu nu go šaddá, it oainne html-kodaid ovdal go manat html-modusii. Berret
čorget html-modusis loahpas.
Ovdamearkkat Linuxa várás leat Mozilla Composer ja Netscape Composer.
Sullasaš Windowsa várás leat Frontpage ja Dreamweaver. 
D. Teakstagieđahallanprográmma mas lea vejolašvuohta vurket html-hápmái.
Dán sáhtá Linuxas dahkat prográmmain KWord ja Open Office, nugo Windowsas
MSWord:s.

Dát lea hui álki, muhto mielddisbuktá ahte ráhkada issoras ollu dárbbašmeahttun
kodaid, mii dagaha ahte siiddut váldet stuora saji ja lea maiddái váttis doaimmahit siidduid
maŋŋil. Teakstagieđahallanprográmmat Linuxa várás leat dán dáfus buoret go MSWord,
muhto mii eat sáhtte ávžžuhit dan vuogi.
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Mii čilget dás fierpmádatsiidoráhkadeami go ieš čálát kodaid. Jus mii ieža ráhkadit kodaid de
ipmirdit ollu buorebut. Maŋŋil sáhttit ovttastahttit daid guokte vuogi. 

Bargadettiin dus berre leat sihke teakstagieđahallanprográmma ja fierpmádatlogan
rabas oktanaga, vai álkit sáhtát molsut daid gaskkas ja oaidnit mo du siidu šaddá. 

Mii čilget dás barggu prográmmaiguin Kate ja Konqueror, muhto eará prográmmat
doibmet sullii seamma láhkái. 

Ovdal go čálligoađát berre dárkkistit ahte dus lea sámegiel boallobeavdi jođus ja ahte
dus lea rievttes kodatabealla, nu ahte oaččut buot sámegiel bustávaid riekta. Sihke Kate:s ja
Konqeror:s galggat deaddilit Čájet > Bidjat kodema ja merket Unicode (UTF8). Dalle
galget sihke sámegiel, dárogiel ja ruoŧagiel/suomagiel bustávat doaibmat bures. Sihkarvuođa
dihtii mii bidjat geahččaleami vuosttáš siidui maid ráhkadit.  

MII KODET HTML:S
HTML-kodat leat eŋgelasgillii ja čiegaid siste. Kodat leat ovdal ja maŋŋil bihtá mii galgá leat
formaterejuvvon muhtin láhkai. Kodat leat roahkkarođuid < tags> siste vai earuhit kodaid ja
teavstta. </ muitala ahte dát koda lea dán rádjái.

Juohke html-dokumeantta ferte álgit kodain <html> ja loahpat kodain </html>. Dáid
gaskkas leat guokte váldooasi; oaivi ja rumaš. Oaivi lea oassi mii ii oidno teakstan
šearpmas, muhto mii lea dárbbašlaš vai du siidu galgá leat vejolaš gávdnat. Go jorgala
eŋgelasgillii de mii oažžut dáid kodaid:
oaivi:  <head></head>
rumaš: <body></body>

Oaivvi siste lea deháleamus oassi dokumeantta namma dahje tihttela: <title></title>.
Tihttal geavahuvvo ohcamii ja čorgemii, ja dat berre muitalit oanehaččat dan siiddu sisdoalu
birra. 

De mii čálligoahtit:  Raba Kate ja álggat ođđa dokumeantta. Čále vuođđokodaid, mat fertejit
leat mielde juohke siiddus:
<html><head><title></title></head><body></body></html>

De čálát siiddu nama <title> ja </title> gaskii ja oanehis teavstta, <body> ja </body>
gaskii, ná: (Bija ieš rievttes namaid dohko gosa galgá) 
<html>
<head>
<title>Mu vuosttáš fierpmádatsiidu </title>
</head>
<body>Bures! Mu namma lea (ovdanamma) (goargu). Mun lean oahppin
(skuvlanamma), (luohkkánamma). Dál lean geahččaleame ráhkadit fierpmádatsiiddu.
Mii dárkkistit ahte sámegiel, dárogiel ja ruoŧagiel/suomagiel bustávat šaddet riekta:
áčđŋšŧžæøåäö. </body>
</html>

Vurke fiilla, namain siidu1.htm. 

Go mearidat fiilanamaid lea dehálaš leat konsekveanta. Ávžžuhit geavahit dušše fal unna
bustávažat. Windows sáhttá lohkat unna ja stuora bustávaid seamma bustávan, muhto Linux
earuha daid. Goargun galggat geavahit juogo dušše .htm dahje dušše .html. Jus geavahat
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prográmma mii addá goarggu automahtalaččat, fertet rievdadit daid jus eai šatta seamma
maid don leat geavahan ovdal.  

Mana Konquerorii ja raba fiilla vai geahčat maid don leat čállán:
Dál oainnát dušše teavstta maid leat čállán <body> ja </body> gaskii. It oainne kodaid.
Tihttal oainnát bajimusas tihttallinjás ovttas fierpmádatlogana namma, omd. ná: 

Raba Konqueroras html-modusa: Čájet > Čájet dokumeantagáldu
Dál oainnát fas olles teavstta nugo don leat čállán dan.

Mana fas Kate:ii. 
Mii áigut geavahit tihttala maiddái bajilčálan teavsttas. Mearkke teavstta Mu vuosttaš
fierpmádatsiidu sáhpániin ja deaddil Ctrl+C. Mana <body> maŋŋái ja deaddil Ctrl+V. 
Bajilčálas galgá leat stuora ja buoiddes bustávat. Html-as leat definerejuvvon moadde
bajilčállaga (headlines), ja mii válljet dás stuorimus. Čále <h1>ovdal ja </h1> maŋŋil
bajilčállaga. 
Merkejuvvon bajilčála šaddá automáhtalaččat sierra linjás. Muhto jus háliidat ođđa linjá
dábálaš teavsttas, ferte kodet dan maid. Ii abut geavahit Enter-boalu html-modusas. Čále
<br> go háliidat ođđa linjá dahje <p> go maiddai háliidat guorus linja ovdal go boahtte
bihttá álgá. 

Dál sáhtát bidjat sisa linjámolssuma ja bihtáid ná: 

<html>
<head>
<title>Mu vuosttáš fierpmádatsiidu </title>
</head>
<body>
<h1>Mu vuosttáš fierpmádatsiidu </h1>
Bures!<p>
Mu namma lea (ovdanamma) (goargu). <br>
Mun lean oahppin (skuvlanamma), (luohkkánamma). <p>
Dál lean geahččaleame ráhkadit fierpmádatsiiddu.<br>
Mii dárkkistit ahte sámegiel, dárogiel ja ruoŧagiel/suomagiel bustávat šaddet riekta:
áčđŋšŧžæøåäö.
</body>
</html>

Geahča fas fierpmádatloganis mo du siidu šaddá dál. 
Jus dus leat váttisvuođat lohkat erenoamáš bustávaid riekta, iskka vuos ahte sihke
čállinprográmma ja du fierpmádatlogan lea stellen unicode:i. Sihkkarvuođa dihtii berret addit
lohkkái dieđu ahte du siidu lea čállon unicode:s. Danin ávžžuhit ahte álggát juohke siiddu na:
<!doctype html public "-//w3c//dtd html 4.0 transitional//en">
<HTML>
<HEAD>
<META http-equiv="Content-Type" content="text/html; charset=utf-8">
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Deháleamus lea maŋimus, charset. Dat muitala makkar koden galgá leat. Go galgá leat
unicode, de mii čállit utf-8 (čilgejuvvon kapihtalis 3.4.) Muđui it dárbbaš ipmirdit buot dáid
kodaid. Čále fal olles ráidu ja máŋge buot siidduide maid ráhkadat. 

ČÁLLINSTIILLAT
Leat máŋga vuogi mo sáhtát rievdadit teavstta, dá leat deháleamus:
- BAJILČÁLLÁGAT HEADLINE <h1></h1>, <h3></h3>
- Buoiddes bustávat: bold <b></b>
- Vinju bustávat: italic <i>

- Stuorit dahje unnit bustávat: <font size= +1></font>, <font size=-2></font>

Ja mii háliidit deattuhit moadde sáni, ja čállit du nama stuora bustávaiguin, skuvla- ja
luohkkánama vinju bustávaiguin ja geahččaleame buoides bustávaiguin. Dan mii dahkat ná:
Mu namma lea <font size= +1>(ovdanamma) (goargu)</font>. <br>
Mun lean oahppin dás: <i>(skuvlanamma), (luohkkánamma)</i>. <p>
Dál lean <b>geahččaleame</b> ráhkadit fierpmádatsiiddu.<br>
Mii dárkkistit ahte sámegiel, dárogiel ja ruoŧagiel/suomagiel bustávat šaddet riekta:
<b>áčđŋšŧžæøåäö</b>.
 

IVNNIT JA GRAFIHKKA
Siidu maid leat ráhkadan dán rádjái leat dušše čáhppes bustávat vilges duogážis. Mii sáhttit
bidjat ivnniid sihke tekstii ja duogážii. Muhtin ivnnit leat ovdalgihtii mearriduvvon
eŋgelasgiel kodaiguin , omd. <red>, <yellow>, <blue>. Dáid sáhtát geavahit jus háliidat
sierra ivnni omd. bajilčállagis, nie: <h1><font color=green>Bajilčála</font><h1>

Jus háliidat eará duogášivnni go vielgat, čálát álggos <body> sadjái omd. nie: <body
bg color=yellow>. Dát vuogi ii atte go 14 vejolaš ivnniid, muhto gávdno eará vuogi, mainna
sáhttá válljet buot ivnniid gaskkas maid sáhtát oaidnit šearpmas. Dalle fertet geavahit
heksadesimala vuogádaga maid čilgiimet kapihtalis 3.4. Buot ivnnit mat čájehuvvojit
šearpmas leat ráhkaduvvon vissis hivvodagain rukses, ruoná ja alit ivnniin. Iešguđetge
vuođđoivnnái mii addit guokte heksadesimala logu, nu ahte ii oktage ivdni lea 00 ja olles
ivdni lea FF. Jus buot vuođđoivnniin lea FF, šaddá vielgat, jus buot ivnniid lea 00, šaddá
čáhppat. Jus mii áigut koden siiddu nu ahte duogáš šaddá čahppat, sáhttit čállit:
<body bg=color=#000000>. Seamma láhkái šaddá áibbas ruoná ivdni #00FF00. 

Atte iežat siiddu koda <body bg=color=#F26722> Makkár ivdni dat šaddá? Sáhtát
áinnas eksperimenteret ivnniiguin, muhto fuomaš ahte šaddá buorre kontrásta teavstta ja
duogáža gaskkas. Leage erenoamáš várrogas alit duogážin, go dat sahttá dagahit ahte lea
váttis lohkat leaŋkkaid. 

Go áiggut bidjat gova sisa siidui geavahat koda <img src=govvanamma.fiilaformáhta>,
omd du iežat govva: <img src=mun.jpg>. Fuomaš ahte dát kodas ii leat loahppa nugo
teakstakodain leat. Govat interneahtas berre leat čoakkiscoahkku 72 pikselat dumás,  ja
áinnas formáhtta jpg. Geahča muđui kapihtala 10.2. govvagieđahallama birra.
Sáhtát maiddái kodet gova sturrodaga ja sajádaga, bidjat teavstta gova ala jna. 

MO GÁVDNAT DU SIIDDUID?
Go leat bidjan du siidduid internehtii, de sávat dieđusge ahte ollu olbmot gávdnet ja lohket
daid. Muhtin olbmuide sáhtát čállit dahje riŋget ja muitalit ahte mus leat fierpmádatsiiddut, ja
dá lea čujuhus, muhto jus čálát dakkár áššiid birra mas máŋggas beroštit, de lea dehálaš ahtel
ohcanmohtorat gávdnet daid. Dat ohcet erenoamážit čoavdasániid, ja don sáhtát ieš mearridit
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teavstta mii galgá boahtit ovddan go ohcanmohtor presentere du siiddu. Dán sáhtát
sihkkarastit ná: Bija dáid linjáid dokumeantta oaivái: 
<META NAME="Keywords" CONTENT="Čoavdasánit">
<META name="description" content="Oanehis čilgehus">
De fertet dieđusge lonuhit "Čoavdasánit" ja "Oanehis čilgehus" dakkariin mii heive juste dán
siidui. 
Sáhtát ieš mannat ohcanmohtoriida ja registreret du fierpmádatbáikki doppe. Dađe eanet
siiddut main leat leaŋkkat du siidduide, dađe eanet olbmot šaddet gávdnat daid. Danin lea
buorre soabadit olbmáiguin geain leat fierpmádatsiiddut ahte ráhkadehpet leaŋkkaid
gaskkaneaset. 

LEAŊKKAT
Dál galggat oahppat ráhkadit leaŋkkaid guovtti siiddu gaskkas. Danin fertet vuos ráhkadit vel
ovtta siiddu. Vurke fiilla siidu1.htm eará namain: siidu2.htm. De rievdadat tihtala ja
bajilčállága vai šaddá Mu nubbi fierpmádatsiidu, ja ovddit teavstta sadjái muitalat veahá
iežat birra. Čále 5-6 linjá ja geavat <br> ja <p> kodaid go háliidat ođđa linjá dahje bihtá.

Dál mii áiggut ráhkadit leaŋkkaid daid guokte siiddu gaskkas. 
Fiillas siidu2.htm čálát loahpas:
<a href=”siidu1.htm”>Vuosttaš fierpmádatsiidui</a>
Geahča fierpmádatloganiin mo oidno. Dát cealkka galgá leat alit ja vuolláisárggon. Deaddil
dan alit linjá. Galggat beassat nuppi fiillii. De dagat seammaláhkai dokko; 
<a href=”siidu2.htm”>Nuppi fierpmádatsiidui</a>. 
Dál sáhtát molsut daid fiillaid gaskkas, ja don dieđát mo ráhkadit leaŋkkaid fiillaide mat leat
seamma katalogas. Jus áiggut bidjat leaŋkkaid fiillaide mat leat eará katalogas dahje juo leat
máilbmefierpmádagas, fertet čállit olles čujuhusa, omd jus áiggut bidjat leaŋkka Sámedikki
siidduide: <a href="http://www.samediggi.no">Sámediggi</a>.

RÁHKADIT STANDARDSIIDDU
Dál jurddašat ahte sihkkarit ahte lea beare ollu bargu čállit buot dáid kodaid juohke háve go
ráhkadat ođđa siiddu, ja dus lea dieđusge riekta. Danin sáhtát ráhkadit ovtta standardfiilla,
maid gohčodat omd. standard.htm. Ja juohke háve go ráhkadat ođđa siiddu, de rahpat dan
ja ovdal go rievdadat maidege, de vurket dan fas ođđa namain.

Dá lea ovdamearka mo standardfiila sáhttá leat. Buot teaksta mii lea sámegillii galggat
lonuhit iežat teavsttain juohke fiillas.

<!doctype html public "-//w3c//dtd html 4.0 transitional//en">
<html>
<head>
<meta http-equiv="content-type" content="text/html; charset=utf-8">
<meta name="keywords" content="Čoavdasánit">
<meta name="description" content="Oanehis čilgehus">
<title>Siiddu namma </title>
</head>
<body>
<h1>Bajilčála</h1>
Teaksta
<p>
<hr>
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<a href=”../index.htm”>Mu ruoktosiidu</a><br>
<a href=”mailto=geavaheaddjinama@domena.riika”>Čále munnje</a>
</body>
</html>

Dál máhtát juo vuođđodoaimmaid. Leat máŋga doaimma html:s ja guđetge editorain, maid
sáhtát oahppat dađistaga go dárbbašat daid. Sáhtát omd. lohkat html-kurssa dán čujuhusas:
http://home.enter.vg/html
Das sáhtát ee. oahppat mo ráhkadit tabeallaid, rámmáid ja bidjat govaid sisa. 

Máŋga fierpmádatčeahppi (webmaster) háliidit ráhkadit buotlágan somás ja «kuuuula»
doaimmat, muhto dás šaddá dávjá moivi, ja ádjána guhká rahpat siidduid. Dasa lassin
gáivbidit dakkar doaimmat dávjá ahte lohkkis leat installeren vissis liigeprográmmaid. Ii leat
somá go ohcá juoidá interneahtas ja oažžu dieđu ahte it sáhte rahpat siiddu dan dihte go dus
váilu muhtin Shock Flash Wave prográmma. Effeavttat maid bijat iežat siidui galgá dahkat
álkibun, lohkkiide fuomašit sisdoalu. Jus dattetge háliidat dakkar doaimmaid, fuomaš ahte
dus lea dan duohken teakstaveršuvdna maid buohkat sáhttet lohkat. 

BIDJAT SIIDDUID INTERNEHTII
Ovdal go jurddašat ge almmuhit du fiillaid leat moadde ášši maid berrejit leat ortnegis.
1. Dus berre leat sierra ohcu iežat garraskearrus gos DUŠŠE leat fiillat maid áiggut almmuhit
iežat fierpmádatbáikái. Dán ohcui berret maiddái álggu rájes leat vuolleozut mat vástidit
fáttáide man birra áiggut čállit. Álgosiiddu (ruoktosiiddu) bijat njuolgá fierpmádat-ozu
vuollái. Das galgá leat namma index.htm, ii mihkkege eará.  
2. Iskka du fierpmádatbáikki dárkkilit. Geahčal golggadit buot siidduid gaskkas ja dárkkis
ahte buot leaŋkkat doibmet. Dárkkis maiddái ahte buot sámegiel bustávat leat riekta. Lea
buorre geahččalit moadde fierpmádatlogana. Skuvlalinuxas sáhtát geahččalit Konqueror,
Opera ja Mozilla. Bija olles du fierpmádat-ozu diskehtii ja geahčal lohkat dan muhtin dihtoris
mas lea Windows, omd MS Internet Explorer ja Netscape. Buorre fierpmádatsiidu galgá leat
seamma buorre beroškeahttá operatiivavuogádagas ja fierpmádatloganis. Easká go dát lea
ortnegis sáhtát jurddašit álmmuheami birra. 

Dus ferte leat muhtin báiki gosa bidjat daid, du iežat fierpmádatbáiki. Sáhttá leat
veahá iežalágan bálvválid gaskkas, mii čájehit dás ovdamearka jus dus lea fierpmádatbáiki
Telenoras. 

Kapihtalis 11.3. čáliimet FTP birra. Jus leat ovdal geahččalan bidjat fiillaid internehttii
Windowsas, leat varra fuomášan ahte dárbbašat sierra FTP-prográmma (omd. WS_FTP).
Gávdnojit maiddái Linuxa várás sierra FTP-prorámmat (omd. gFTP), muhto sáhtát maid
geavahit Konqueror dasa. 

Raba Konqueror ja juoga šearpma guovtti lášii.(Lássa > Ludde čájeheami gurut /
olgeš)  Čujuhuslinnjás čálát du fierpmádatbálvvá ftp-čujuhusa, omd.
ftp://home.online.no/geavaheaddjinamma  ja deaddilat Enter (dáhje sullasaš, iskka du
bálvváin). Go oaččut gažaldaga, čálát iežat geavaheaddjinama ja beassansáni. Dál galggát
oaidnit du ozu bálvvás ja go deaddilat dan fiillaid mat leat biddjon dasa.

Mana dál šearpma nuppi oassái ja raba iežat garraskearrus ozu mas leat iežat
fierpmádatfiillat. Dál sáhtát sirdit fiillaid dáid ozuid gaskkas dainna ahte geasat daid
sáhppániin. Muhto leage várrugas, lea álki láhppat fiilla boastu sadjái. Ja muitte ahte galggat
máŋget fiillaid, it ge sirdit daid. (Sáhtát maiddái máŋget fiillaid álggos ja de liibmet daid sisa
maŋŋil). Go leat máŋget visot maid galggat, čálát iežat fierpmádatčujuhusa ja geahččat mo
dat doaibmá. Lihku bárgguin!
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12. EARÁ ÁVKKALAŠ PROGRÁMMAT 
12.1. MIDNIGHT COMMANDER
Midnight Commander lea fiilagieđaheaddji maid sáhttá geavahit buot lágán Linuxain ja eará
Unix-sullasaš operatiivavuogádagain. Eará operatiivavuogádagain leat sullasaš prográmmat,
nugo Windows Commander / Total Commander ja Norton Commander.

Dađe bahábut Midnight Commander ii čuovu Skuvlalinux, muhto sáhtát gávdnat dan
Debian-páhkas dahje interneahtas, ja lea álki ieš installeret dan, geahča kapihtalis 7.8.
Dárbbašat golbma páhka: mc, mc-common ja gpm. Go prográmma lea installerejuvvon,
sáhtát konsollas dušše čállit mc ja deaddilit Enter.

Midnight Commander:s lea navigeren ja fiilamerken veahá earálágán go dan maid dábálaččat
geavaha prográmmain mat leat Windows dahje KDE vuolde. Sáhtát geavahit sihke sáhpána
(dušše fal gurut boalu) ja njuollaboaluid navigeret ozuid ja fiillaid gaskkas. Jus galggat
merket ovtta dahje moadde ozu dahje fiilla, omd maid galggat sirdit dahje sihkkut, geavahat
Insert-boalu boallobeavddis. Jus galggat merket buot fiillaid muhtin ozus geavahat boalu *
numeralaš boallobeavddis.

Stuorimus gieddi (dábálaččat alit ivnnis) gohččoduvvo ohcopanelan. Leat guokte rabas
panela oktanaga, nu ahte mii sáhttt omd oaidnit guokte ozu sisdoalu. Go álggát čájehuvvo du
ruovttoozu, dahje  /root jus don leat loggen sisa ruohtasin.

Bajimus lea fállolinjá, mas lea Left – File – Commands – Options – Right. 
Fálut Left ja Right vuolde leat seammalaganat ja gusket váldogietti gurut ja olgeš govaide.
Fállu File vuolde guoská doaimmaide maid sáhtát dahkat merkejuvvon fiillain. Commands
ja Options vuolde gávnnat doaimmat mat leat beroškeahttá dan mii oidno ohcopanelain. 

Ohcopanelaid vuolde lea vilges linjá, mii lea skálžžu gohččunlinjá, ja dat álgá
dábálaččat dáinna: <geavaheaddjinamma>@<dihtornamma>:

Vuolimusat leat doaimmat merkejuvvon 1 - 10. Daid sáhttá geavahit juogo sáhpániin
dahje boaluiguin  F1-F10. Muhtumin dát boalut molsot sisdoalu, nu ahte jo leat álggahan
ovtta doaimma, oaččut gitta 10 ođđa molsaeavttuid. 
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MC sáhttá geavahit máŋga doaimmaide, mii galggat dušše namuhit moadde váldodoaimma:

Ráhkadit ozuid
Mana sáhppániin dahje njuollaboaluiguin +Enter dassái go čuoččut dan ozus masa áiggut
ráhkadit vuolleozu. Coahkkal 7Mkdir (Make directory = Ráhkadit ozu) dahje F7. Oaččut dál
dieđu Enter directory name, ja čálát ozu nama ja duođastat dan go coahkkalat OK dahje
Alt+O.

Sirdit fiillaid
Go galggat sirdit fiillaid muhtin ozus nubbái, gozihat ahte ohcu masa galggat sirdit leat rabas
nuppi ohcopanelas. Nuppi panelas merket fiilla(id) mmaid galggat sirdit ja coahkkalat 5Copy
jus galggat máŋget dahje 6RenMov jus galggat sirdit.

Čihkkon fiillat
Oassi dihtora fiillain øeat dábálaččat čihkkon midjiide. Sivva lea ahte dat leat vuogádatfiillat
mat leat dárbbašlaččat vai prográmmat galget doaibmat, muhto dábálaččat mii eat berre
rievdadit daid.  Jus mii dattetge háliidit ahte dát fiillat galget oidnot ohcopanelas, mana
dohko: Options > Configuration > Panel options ja merke show Hidden files ja deaddil
OK. Geahča dál doaibmi ohcopanelii. Dál sáhttá leat ihtán muhtin fiillat, main leat čuokkis
ovdal fiilanama. Dat leat čihkkon fiillat. Sihkareamus lea diktit daid leat sihkkon, dalle eat
nu álki ribahit rievdadit dahje sihkkut daid. Mana danin ruovttoluotta ja válde eret merkema
mii diktá min oaidnit čihkkon fiillaid. 

Geahčadit ja doaimmahit fiillaid
Linuxas gávdno ollu fiillat mat addet gohččumiid ja «oppsett» dasa mii galgá oidnot
šearpmas, čatnan olggoldas ovttadagaide jna. Muhtumin mii dárbbaeit geahčadit ja
doaimmahit daid. Álkimus vuohki maid dahkat dan lea geavahit Midnight Commander.
Merke fiilla maid áiggut geahčadit ja coahkkal 3View ju dušše áiggut oaidnit ja 4Edit jus
áiggut doaimmahit. 

Rievdadit fiilaattribuhtaid
Iešguhtege fiilii lea čadnon vissis geavahannjuolggadusat, bnu gohčoduvvon attribuhtat. Mii
sáhttit mearridit geat galget beassat lohkat ja/dahje rievdadit fiilla; dušše oamásteaddji, vissis
joavku dahje buohkat. Atribuhtaiguin sáhttit mearridit galgá go fiila leat vuojehahtti, dahje
doaibmat prográmman. (Dán láhkái lea Linux áibbas earálágán go Windows, mas
prográmmafiillain fertejit leat sierra goarggut nugo *.exe, *.bat dahje *.com. Linuxas sáhttá
velá *.txt-fiila leat prográmmafiilan jus mii mearridit dan attribuhtain.)

MC:s sáhttit gávdnat ja rievdadit fiilattribuhtaid ná: Merke fiilla maid áiggut
geahčadit. Mana fállolinjás dohko: File  > cHmod. Permission vuolde oainnát máŋga
attribuhta, ja lea jáhkehahtti ahte muhtin dain lea merkejuvvon ruossain. Dát muitalit ee. geain
lea vuoigatvuohta lohkat fiilla ja čállit dasa. Jus oamásteaddji galgá sáhttit rievdadit dan,
ferte leat merkejuvvon write by owner. Jus mii háliidit ahte earát galget beassat rievdadit dan
fiilla, ferte leat merkejuvvon write by group, dahje write by all. Jus leat máŋgen iežat ohcui
fiilla muhtin CD:s, lea stuora vejolašvuohta ahte dat lea «read-only», mii mearkkaša ahte it
sáhtte rievdadit dan. Dalle sáhtát válljet cHmod ja merket write by owner. 

Jus lea merkejuvvon execute/search balddas, de fiila sáhttá pronsihpas geavahuvvot
prográmmafiilan. (Eai buot fiillat leat prográmmafiilan vaikko merkejuvvo danin). Dákkár
fiillat šaddet ohcopanelas ihtit sierra ivnniin ja * ovdal fiilanama. Sáhttá merket moadde fiilla
ja rievdadit daid attribuhtaid oktanaga. Fiillat mat leat importerejuvvon Windowsas, ja
maiddái páhkkejuvvon fiillat (zip, tar.gz) šaddet dávjá merkejuvvon dego prográmmafiilan,
ja dalle ferte váldit eret dan merkema ovdal go sáhttá dahkat juoidá dáiguin fiillaiguin.
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Rahpat pahkkejuvvon fiillaid
Pahkkejuvvon fiillaid (zip, tar.gz) sáhttit rahpat ná: Merke fiilla mii galøgá rahppojuvvot ja
deaddil Enter. Dalle oainnát  fiillaid mat leat páhkkejuvvon fiilla siste. De coahkkalat 5Copy
ja máŋget daid eará ohcui. Doppe dát fiillat doibmet dábálaš páhkkekeahtttes fiillan.
Páhkkejuvvon fiillat mat bohtet Windowsas sáhttet leat merkejuvvon dego prográmmafiilan
ja dán merkema ferte váldit eret ovdal go sáhttá rahpat páhka. 

12.2. CD-BOALDIN
X-CD-Roast lea prográmma boaldin dihtii CD ja DVD-aid, data ja musihka várás.  Dat lea
prográmma mii lea erenoamážit ráhkaduvon Linuxa várás. 

X-CD-Roast ii leat mielde Skuvlalinux-páhkas, muhto oaččut dan jus oastát olles
Debian-páhka. Sáhtát maiddái viežžat dan interneahtas, čujuhusas http://www.xcdroast.org.
Go lea installeren prográmma, ferte heivehit veahá, ee, root:as ferte cealkit man
geavaheddjiin galgá leat vuoigatvuođa boaldit CD:aid ja gosa gaskaboddosaš fiillat galget
vurkojuvvot. Prográmma vurke gaskaboddosaččat garraskerrui dan maid áiggut boaldit, ja
danin dus ferte leat doarvái guorus garraskearrosadji. 

Ovdal boaldima berret organiseret dan maid áiggut boaldit, mnu ahte dat lea
vurkojuvvot sierra ozuin. Dalle sáhtát boaldit olles ozuid, it dárbbaš čoaggit ovtta ja ovtta
fiilla. 

Sáhttá geavahit prográmma máŋga láhkái, ee. máŋget olles CD:id. Dát istrukšuvdna
čilge dušše álkkimus, maid eanaš olbmot dárbbašit: Vurket data garraskerrus CD:ii, nu ahte
boaldá visot oktanaga.

Dán álgofálus válljet Create CD, ja dalle oaččut dán šearbmagova:
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Gurut bealde fálus válljet Master tracks. 
Go coahkkalat File > Directory View beasat oaidnit garraskearru ozuid.

Merke ozuid maid áiggut máŋget CD:i ja deaddil Add. Dalle ihtá láse tihtaliin  Adding path
to master directories. Dás válljet makkár fiilastruktruvrra háliidat CD:s. Dábálaččat lea
doarvái váldit mielde ozu nama, dahje bálgá maŋimus oasi. Dalle válljet Add with last path
components dahje Add with path component: /home/... removed. De deaddilat OK. ozut
ihtet dál lásii Session view. 

Badjin olgeš bealde válljet dál Create session / image. Šearbmagovas mii dál ihtá
berret dárkkistit guokte ášši: 
Dárkkis Session information vuolde man stuora sadji váldet ozuid maid leat válljen:
 

Jus dát lea eambbo go sadji mii lea CD:s (sullii 6-700MB), fertet váldit juoidá eret fas. 
Dán olgešbealde leat moadde válljenvejolašvuođa. Dárkkis ahte II galgga leat

merkejuvvon Create multi-session CD, go dalle sáhttet šaddat čuolmmat maŋŋil.
Vuolemusas šearpmas válljet dál Master to image file. Jus juo leat boalden CD:aid

dán prográmmain, oaččut gazaldaga áiggut go badjelčállit boares luottaid. Dan sáhtát
dorvolaččat dahkat, jus it áiggo ráhkadit eanet CD:aid seamma sisdoaluin go ovddit háve.
Vállje danin Continue anyway.

Dál oaččut láse mas oainnát ahte ozut ja fiillat vurkejuvvojit gaskaboddosaš vurkii
(Mastering data track). Oanehis áiggi maŋŋá galgá boahtit Mastering successful ja sáhtát
deaddilit OK.

Manat dál fas šearpma gurut beallái ja válljet Write Tracks. Mana dohko: Layout
tracks. Image Information vuolde oaččut dál luottaid maid sáhtát boaldit. 
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Vállje All, ja de Add. Dát ihtá dalle gurut bealde lásii; Tracks to write. Coahkkal fas All ja
Accept track layout. Oaččut seamma ozuid Tracks to write - ruktui, ja vilges gietti vuolde
válljet vuos All, de Accept track layout ja Write tracks. Dál ihtá diehtu mii bivdá du bidjat
guorus CD stašuvdnii. Daga dan ja deaddil OK. Dál galggat oaččut dákkár láse, mii čájeha
boaldinproseassa:

Jus manná bures boahtá moadde minuhta geahčen CD iešálddis olggos CD-stašuvnnas ka
šearpmas sáhtát lohkat Tracks successfully written. Deaddil OK, Back to main menu ja
mana olggos prográmmas.
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GIRJJÁLAŠVUOHTA 
A. GIRJJIT
Sámegillii: 
Dán rádjái (2005 čakčamánu) ii leat čállon go okta girji dihtorbarggu birra, ja dat lei
Windowsa várás:
Svein Lund: Mu unna dihtorgirjjáš, Sámedikki oahpahusossodat 1999, 2002

Dárogillii:
Gávdnojit oalle máŋga girjji dihtorbarggu birra, muhto ii vel nu ollu Linuxa birra, ja in leat
gávdnan maidege Debiana birra.
David Elboth lea čállán 3 girjji, maid IDG Norge Books lea almmuhan, ja mat leat boahtán
jámma ođđa veršuvnnain:
- Boken om Linux
- Linux - installajon og konfigurasjon
- Linux - server og utviklingsmiljø
Dáid gaskkas lea dušše Boken om Linux mii heive dábálaš geavadeddjiide. Earát leat eambbo
sidjiide geat galget hálddašit fierpmádaga. Su girjjiin lea Red Hat vuođđun ja visot ii heive
eará distribušuvnnaide. 
2003 bohte guokte ođđa girjji mat Gyldendal forlag lea almmuhan ovttasbargguin Høgskolen
i Sør-Trøndelag:in
Geir Maribu: Praktisk Linux. Vuođđun lea Linux-distribušuvdna Mandrake, muhto stuora
oassi girjjis heive maiddái sidjiide geain leat eará distribušuvnnat. Girji čilge sihke konsolla
ja KDE, ja lea álkkit lohkat go ollu eará dihtorgirjjit.
Nubbi lea Mads E. Eilertsen ja Arne B. Mikalsen: Linux tjenestedrift, mii lea jurddašuvvon
sin várás geat galget hálddašit fierpmádaga.
Eará dehálaš girji dárogillii lea: Borgesen: Linux som informasjonstjener.

Eŋgelasgillii: 
Moadde oppalaš girjji Linuxa birra leat:
Ellen Siever m.fl.: Linux in a Nutshell, lágádus O'Reilly
Roderick Smith: Linux Power Tools
Muđuid sáhttit namuhit moadde girjji erenoamážit Debiana birra.  
Bill McCarty: Learning Debian GNU/Linux. O'Reilly 1999 
Steve Hunger: Debian GNU/Linux Bible. Hungry Minds. 
Sáhttá gávdnat eanet dieđuid Debian-girjjiid birra das:
http://www.debian.org/doc/books.no.html 

B. INTERNEAHTTA
Interneahtas ii leat vel baljo mihkkege gávdnomis sámegillii ii ge Linuxa ii ge oppalaš
dihtoroahpu birra, erret moadde aviisaartihkala ja ságastallan dihtorgažaldagaid birra
Samenetas.

Dárogielas leat oalle ollu. 
Skuvlalinux lea ráhkadan iežas dokumentašuvnna
http://www.skolelinux.org/no  > Dokumentasjon
Dás gávnnat sihke instrukšuvnnaid ja kurssat. Ávžžuhit vuosttážettiin válljet:
Dábálaš geavaheddjiide: Skuvlalinux på arbeidsflaten
Vuogádathálddašeddjiide: Innføring i Skuvlalinux-systemet  
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Jus háliidat lohkat eambbo, sáhtát máiddái lohkat: 
Matt Welsh: Brukerveiledning for Linux. http://abel.hive.no/linux/manual. Dát lea
jorgaluvvon eŋgelasgiel girjjiis Linux Installation and Getting Started Guide. Dárogiel
veršuvdna gávdno dušše fierpmádagas. 

Dá leat moadde fierpmádatbáikki, ordnejuvvon dán girjji kapihtaliid mielde:

1. Dihtorgálvu
http://www.byggpc.tk 
http://www.pcworld.no

2. Dihtorhistorjá
http://www.zakon.org/robert/internet/timeline.html
http://home.online.no/~rkaste/dhindex.html 
http://heim.ifi.uit.no/~knuthe/db-historie/datahistorie.html
http://www.poppe.nu/GrunnleggendeOmDatamaskinen.pdf

3. Rehkenastinvuogit
http://www.poppe.nu/DesimaleHeksadesimaleTall.pdf 

4. Sihkarvuohta
http://www.pgpi.com 
http://www.norton.com
http://www.norman.com
http://www.zonelabs.com 

5. Vuoigatvuođat ja liseanssat
http://www.gnu.org

6. Operativvuogádat
http://www.microsoft.com
http://www.apple.com 

7. Unix ja Linux
http://www.unix.org
http://www.linux.org  .  
http://www.linux.no
http://www.linuxguiden.linpro.no
http://www.linuxbutikken.no  .   
http://www.linuxmagasinet.no
http://www.distrowatch.com
http://www.kernel.org
http://www.redhat.com 
http://www.fedora.com 
http://www.linuxmandrake.com 
http://www.suse.com 
http://www.debian.org 
http://www.slackware.org 
http://www.knoppix.com  
http://www.bitmaster.no
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http://www.skolelinux.org/no
http://www.xfree86.org
http://www.linux.tucows.com

8. KDE
http://www.kde.org 

9. Kántorprográmmat
http://www.openoffice.org 
http://www.koffice.org
http://corefonts.sourceforge.net
http://www.hah.net/fonts 

10. Gráfalaš prográmmat
http://www.ribbonsoft.com/qcad.html
http://www.gimp.org 

11. Dihtorgulahallan
http://www.3wc.org
http://www.altavista.com 
http://www.euroseek.com   
http://www.alltheweb.com 
http://www.google.com 
http://www.kvasir.no 
http://  www.  yahoo.com   
http://home.enter.vg/html
http://www.opera.com

12. Eará ávkkálaš prográmmat
http://www.ibiblio.org/mc
http://www.xcdroast.org

Sámegiela birra dihtoris:
http://www.samit.no
http://hum.uit.no/sam/giellatekno
http://home.online.no/~sveilund/sami/inetsas1.htm
http://www.samediggi.no

SÁNIT JA OANÁDUSAT

SÁTNELISTU ČILGEHUSAIGUIN
Sámegillii Dárogillii Eŋgelasgillii Čilgehus
alfanumeralaš alfanumerisk alphanumerical mii sisttisdoallá bustávaid, loguid ja sierramearkkaid, muhto ii omd. gráfalaš mearkkaid
álggahandiskeahtta oppstartdiskett boot disk diskeahtta mas lea dieđut mat leat dárbbašlaš vai sáhttá álggahit dihtora
analoga analog analogue signálaid birra: mii sáhttá rievdaduvvot ceahkehis skála mielde
áššehas klient client terminal, bargostašuvdna dahje PC mii fierpmádaga bokte lea čadnon bálvái.
asynkruvdna asynkron asynchronous mas lea dássehis intervallat
árkaleavga arkfane
báldalaslakta parallelt grensesnitt parallell interface lakta mas dieđu sirdimii geavahuvvo 8 dahje eanet bihta oktanaga, baldalagaid
bálggis søkevei path fiilla olles nama, mii čilge gokko skearrus fiila lea, buot katalogat ja vuollekatalogat 
bálstá, spálta spalte column oassin tabeallas,  ruvttot leat badjelagaid
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bálvá tjener, nettverkstjener server fierpmádaga váldodihtor 
beassansátni passord password mearkaráidu mii suddje dieđuid dahje prográmmaid: dan galgá diehtit ovdal suddjejuvvon dieđuid

beassá geavahit 
bihttá bit bit dieđu ovttadat, bihta árvu lea okta dahje nolla
biire krets circuit oassi dahje ovttadat dihtoris,  mas el-rávdnji ollášuhttá dihto doaimma
binára binær binary guoktelohkovuogádaga mielde; sáhttet leat dušše guovtti dilis, ovtteš dahje nolla
bitmap-grafihkka bitmap-grafikk bitmap graphics grafihkka mii lea ráhkaduvvon čuoggáin (piksels) mat čorgejuvvojit ráidduin ja kolonnain
boallobeavdi tastatur keyboard dábáleamos bierggas mainna dihtor stivrejuvvo
coahkkalit klikke click deaddilit sáhppánboaluin go seavan lea vissis sajis šearpmas
čáláhus utskrift printout báhpirii čállon diehtofiila
čálán skriver printer čállinbierggas mii lakto dihtorii; čállá báhpirii maid dihtora prográmmat mearridit
čálihit skrive ut, ta utskrift print bidjat dihtora buktit barggu bohtosiid čálánii
čállinsuodji skrivebeskyttelse write protection lasihuvvo skerrui vai dan sisdoallu ii sáhte nuppástuhttit, diekeahtas lea ceahkis mii gokčojuvvo
čat chat chat internetdoaibma mii dagaha ahte guokte geavaheaddji sáhttet "humadit" njuolga dainna ahte čálliba

boallobevddiin 
čatnat montere mount
čiehkamuitu hurtigbuffer cache sierra johtilis muitu dahje guovddášmuittu oassi masa lohkkojuvvon dieđut vuos mannet nu ahte ođđa

dieđuid beassá fas dalán lohkat, geavahuvvo dávjá diskka ja guovddášmuittu gaskkas
čuohpusgirji utklippsbok, utklippstavle clipboard muittu oassi dahje eará báiki masa dieđut vurkejuvvojit go daid áigu sirdit prográmmas nubbái
diehtovuođđu,
databasa

database database datačoakkaldat mii lea čorgejuvvon nu ahte lea álki viežžat dieđuid maid dárbbaša. Diehtovuođus leat
poasttat ja giettit

digitála digital digital diehtu binára lohkovuogádaga , 0 ja 1 vuođul
dihtor datamaskin computer mašiidna mii bargá muhtin prográmmerengiela gohččumiid mielde
doaimmár prosessor processor dihtora siskkimuš man birra olles bierggas lea ráhkaduvvon
domenanamma domenenavn domain čujuhus mii identifisere muhtin interneahtta-bálvvá. Domenenamas leat unnimusat guokte oasi. Gurut

bealde oasi lea fitnodaga, ásahusa dahje searvvi namma. Olgeš bealde oassi lea oanádus mii muitala man
riikkas dat lea, dahje makkár ásahus. 

dovdan føler sensor ovttadat mii registrere fysalaš rievdadusaid ja nuppástuhttá daid digitála diehtun
duohpat nedlaste, laste ned download sirdit dieđuid nuppi dihtoris dan dihtorii mainna lea bargame
e-poasta,
elektrovnalaš poasta,
šleađgapoasta

e-post, elektronisk post e-mail dieđut ja dokumeanttat mat lonohuvvojit fierpmádaga ja/dahje telefonfierpmi bokte

fállu meny menu das oidnojit dat vejolašvuođat main galgá válljet ovtta vai dihtor bargagoahtá ovddosguovlluid
fierpmádat nettverk network dihtorat ja eará ovttadagat mat leat čadnon oktii nu ahte sáhttet gulahallat gaskaneaset
fierpmádatčeahppi vevmester webmaster olmmoš geas lea ovddasvástádus ráhkadit ja almmuhit muhtin fierbmebáikki siidduid
fierpmádatkoarta nettverkskort network card koarta mii installerejuvvo dihtorii vai dat sáhttá doaibmat fierpmádagas
fierpmádatlogan
golgadanprográmma

nettleser, vevleser, web-
leser

web-browser prográmma mii geavahuvvo ohcat ja čájehit fierpmádatsiidduid mat leat html-formáhtas

fiila, vuorká fil file dieđut mat leat čoggojuvvon ja vurken digitálalaččat ovtta nama vuolde. Fiila sahttá leat prográmma,
govva, čálus jna.

fonta font, skrifttype, typesnitt font dakkár dihtohámat mearkkaid čoahkkáldat mat geavahuvvojit oktanaga ja maid sáhttá njuolga gohččut
sudjosii dahje čálihit báhpárii

formateret formattere format diskeahtat ja diskkat gaget formaterejuvvot ovdal go daid sáhttá geavahit; formateretnprográmma
ráhkada daidda vuođđoiešvuođaid mat mearridit man olu ja sajiide daidda sáhttá dieđu vurket

gálgat avmontere unmount
garraskearru harddisk, platelager hard disk skearroovttadat man dávggasmeahttun skearru ii leat dábálaččat bođđemis; das lea stuorra kapasitehtta ja

dieđuid sáhttá boaibmut jođánit
gaskaboallu mellomromstast space bar guhkes boallu boallobeavddis, mainna ráhkada gaskka ja muhtin prográmmain vissis gohččumiid
geavahanlakta brukargrensesnitt user interface prográmma mii dahká álkibun bargat dihtoriin, doaibmá geavaheaddji ja geavahanvuogádaga gaskkas ja

čájeha fáluid maid geavaheaddji vállje (omd. Windows)user interfacebrukergrensesnittgeavahanlakta
gieddi felt field diehtovuođus koartta oassi mii lea várrejuvvon dihtolágan dieđuid, omd. čujuhusa dahje agi várás, lea

juohke koarttas seamma sajis
gilkor, goargu filending, tillegg,

etternavn
extension fiilanama oassi mii boahtá čuoggá maŋŋil ja mii dábálaččat addá dieđu fiilla šlájas

gohččun kommando command instrukšuvdna mii prográmmain dahje boallobevddiin addo dihtorii , vai dihtor čađaha muhtin doaibma 
govdabáddi breiband broadband diehtosirdanvuohki mainna sáhttá sirdit oktanaga máŋga kanálas
govvačuokkis piksel, bildepunkt pixel digitála govaid unnimus ovttádat
govvalohkki skanner, bildeleser scanner bierggas mainna govaid sáhttá lohkat dihtora muitui
grafihkka grafikk graphics govalágan minstarat maid dihtor sárgu šerbmii dahje báhparii
gulahallan,
kommunikašuvdna

kommunikasjon communication dieđut sáddejuvvo elektrovnnalaš signálan dihtoriid gaskkas 

heivehus innstilling setting
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heksadesimála heksadesimal hexadesimal 16-vuogádat mas nummiriid lassin geavahuvvojit bustávat A-F, dárbbašlaš mašiidnagielat prográmmain
integrerejuvvon biire integrert krets integrated circuit elektrovnnalaš biire mii sisttisdoallá ollu transistoriid ja earálágan osiid
jietnakoarta lydkort sound card viiddidankoarta mii dagaha ahte dihtor sáhttá gieđahallat ja sáddet jiena
kataloga mappe, katalog folder, directory ovttahat dihtorprográmmas mainna čorge fiillaid, fiillat mat gusket seamma fáddái sáhttet leat ovtta

katalogas 
koarta, goarta kort card 1) duolbbus masa leat čohkkejuvvon dihtolágán elektrovnnalaš komponeanttat; laktejuvvo dihtora eará

osiiguin, nahkehuvvo dábálaččat eadnedulbosa (váldokoartta) koartasadjái
2)kartotehkavuorkká oassi masa ovtta áššái gullevaš dieđut leat čoggejuvvon; 

koda kode code 1)njuolggadusat maid mielde dieđut almmuhuvvojit dihto mearkkaiguin
2)njuolggadusaid mielde almmuhuvvon diehtu, omd. prográmma oktan hámiinis

kodatabealla tegntabell, kodetabell code page tabealla mii čájeha mo guđetge mearkkat kodejuvvojit  
lágasfierpmádat lokalt nettverk local area network báikkálaš elektrovnnalaš jođasfierpmádat dieđuid sirdima várás
lakta grensesnitt interface biergasa oassi masa sáhttá laktit juoga eará biergasa, dábálaččat johtasiin
láse vindu window šearpma ráddjejuvvon oassi mii doaibmá sierra ja mas sáhtá čájehit omd. eará fiilla dieđuid go šearpma

eará osiin
leaŋka link, hyperlink, peker link, hyperlink čujuheaddji fierbmesiiddus, jus deaddila dan fievrriduvvo nuppi fierbmesiidui
linjámolsunboallu retur enter boallu boallobeavddis mainna sáhttá molsut linjá ja álggahit gohččumiid 
čuokkiscoahkku oppløsning resolution man galle čuoggá sáhttá leat juohke guhkodatovttadagas, dábalaččat dumás dahje šearpmas. 
máilbmefierpmádat verdensveven world wide web elektrovnnalaš fierpmádat, gos sáhtát mannat ruossut rássut 

miehtá máilmmis
máŋget kopiere copy
maŋŋálaslákta seriekopling, serielt

grensesnitt
serial interface lakta gokko diehtu sirdása ovtta geainnu mielde nu ahte bihtat leat maŋŋalagaid, RS232

mašiidnagálvu,
garragálvu

maskinvare hardware biergasat, omd. ieš dihtor, dan oasit ja dasa laktojuvvon biergasat

mearka tegn, teikn character uhcimus ovttadat mainna dieđu sáhttá olggosbuktit; mearka lea unnimus 8 bihta guhku
modema modem modem bierggas mainna dihtora sáhttá laktit telefonfierpmi bokte eará dihtoriidda 
molsunboallu skift-tast shift boallobeavddis boallu mainna molsu unna ja stuora bustávaid ja vuolit ja bajit mearkkaid gaskkas
muitu minne memory dihtora oassi mas dieđut gieđahallojit ja prográmmat doibmet (siskkaldas muitu, RAM/ROM) dahje

masa prográmmat ja dieđut leat vurkejuvvon (diskeahtat / garraskearrut)
navdinárvu standardverdi,

forhåndsinnstilt verdi
default value dat árvu, man prográmma addá dihto molsašuddái, muhto man sáhttá nuppastuhttit 

njuollaboalut piltaster arrow keys boallobeavddi boalut maiguin stivret seavána šearmmas.
ođasmahttit oppdatere update lonuhit fiilla, prográmma dahje dihtora oasi ođđaset veršuvnnain
ohcanbálvalus søketjeneste, søkemotor search engine bálvalus maiguin ohcá interneahtas dieđuid muhtin fáttá birra
oktiiheivolaš kompatibel compatible guokte dihtora leat oktiiheivolaččat jus dat sáhttet vuodjit seamma prográmmaid ja oažžut seamma

bohtosa
operatiivavuogádat,
geavahanvuogádat

operativsystem operative system dihtora vuođđoprográmma mii dikšu boallobeavddi, šearpma, skearroovttadagaid ja laktabiergasiid
ovttasbarggu ja vuođđodoaimmaid

partišuvdna partisjon partition garradiskka oassi man váldoozu sáhttá oažžut hávil oidnosii šerbmii ja man geavahanvuogádata hálddaša
oktan ovttadahkan

prográmma program program dihtorgillii čállon doaibmabijuid ráidu man dihtor ollašuhttá
prográmmagálvu,
dipmagálvu

programvare software gohččunčoakkáldat mii dárbbašuvvo oažžut dihtora čađahit doaimmaid.

ráidu rad row veallut oassi tabeallas, mas leat ruvttot baldalagaid
rámma ramme frame njeallječiegat guovlu mii sáhttá sisttisdoallat teavstta dahje grafihka; html:s oassi fierbmesiiddus mii

sisttisdoallá sierra dokumeantta
rávdabierggas periferienhet, ekstern

enhet
peripheral device dihtorii laktojuvvon bierggas, omd. čálán

rehketárka,
tabeallaluoitu

regneark spread sheat prográmma mas geavaheaddji sáhttá rehkenastit dainna ahte deavdá ruvttuid teavsttain, loguiguin ja
formeliiguin

ruohtas rot root hierarkalaš fiilastruktuvrra bajimus dássi
ruovttuluottaboallu tilbaketast backspace boallobeavddi boallu mainna sihkku maŋosguvlui, merkejuvvon gurutguvlui njuolain
ruovttusiidu hjemmeside home page fierbmebáikki váldosiidu, siidu mii vuos ihtá
sáhpán mus mouse dihtora stivrenbierggas mainna seaván dahje eará áhta mii lihkada sudjosis, sáhttá sirddašuvvot ja

sierralágán doaimmat biddjojuvvot johtui
salladihtor bærbar datamaskin notebook, laptop,

portable computer
dihtor mas leat buot dihtoroasit ovtta unna bovssažis.  

sárggon plotter plotter bierggas mii sárgu sazuid ja sojuid ja eará govadagaid oktilis sárgáiguin báhpirii
seaibealfa,
bussáseaibi

krøllalfa at @, mearka mii geavahuvvo e-poastačujuhusain
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šearbma, suojus skjerm screen, monitor,
display

ovttadat mii čájeha gova maid dihtor lea genereren

seavan markør cursor dábálaččat seavvi njeallječiehka, sárggis dahje eará mearka mii čájeha gokko čállinmearka ihtá sudjosii
sirdin overføring transfer, transmit dataid sádden / vuosttaiváldin guovtti dihtora gaskkas
stiilaárka stilark style sheet fierbmesiidduid ovdalgihtii mearriduvvon formáhta
stivrensággi styrespak joystick sággi maid sáhttá botnjat guđege guvlui ja dainna lágain addit gohččumiid dihtorii, erenoamážit spealus
synkruvdna synkron synchronous sirdin mas lea rievdameahtun áigi databihtáid, mearkkaid dahje dáhpahusaid gaskkas
teakstagieđahallan tekstbehandling word processing čállin dekstoriin dahjege sátnedoaimmáriin; teaksta oidno sudjosis ja dan sáhttá doaimmahit ja divvut

ovdal go čáliha báhparii
teakstagieđahallan-
prográmma, dekstor
sátnedoaimmár, 

tekstbehandler,
tekstbehandlingsprogram

text manager, word
processor

prográmma mii geahpida čállinbarggu ja dahká vejolažžan dikšut teavstta loahpalaš hámi máŋgga láhkái

terminála terminal terminal bierggas mainna geavaheaddji sáhttá leat oktavuođas dihtoriin ja mas lea šearbma ja boallobeavdi 
váldokoarta,
eadneduolbbus

hovedkort motherboard vuođđoduolbbus dihtora siste mas lea dábálaččat doaimmár oktan eará vealtameahttun osiiguin ja masa
biiregoarttat coggojuvvojit

vektorgrafihkka vektorgrafikk vector graphics grafihkka mainna sáhttá stuoridit ja unnidit govaid bilitkeahtá buorrevuođa. 
virus virus virus prográmma mii njoammu suoli dihtoris nubbái; sáhttá vahágahttit dihtora fiillaid ja doaimmaid
vurket lagre save, record váldit vára prográmmaid ja dieđuid nu ahte daid sáhttá maŋŋil geavahit ođđasis 

OANÁDUSAT
ADSL Asymmetric Digital Subscriber Line teknologiija mainna sáhttá sirdit ollu dieđuid dábálaš telefonlinjáiguin
BBS Bulletin Board System elektrovnnalaš almmuhantávval. BBSat leat jávkame maŋŋil go interneahtta šattai dábálaš
BIOS Basic Input/Output System oassi dihtoris, sisttisdoallá ee. prográmmakoda mii álggaha operatiivavuogádaga
CAD Computer Aided Design teknihkalaš sárgonprográmma
CC Carbon Copy e-poasttas ahte sádde kopiija earáide, váldovuostáiváldi lassin
CD-R Compact Disk - Recordable CD-skearru masa sáhttá čállit oktii.
CD-ROM Compact Disk - Read Only Memory CD-skearru masa ii sáhte čállit 
CD-RW Compact Disk - Rewriteable CD-skearru masa sáhttá čállit vaikko man galle geardde
CNC Computer Numerical Control vuohki mo dihtoris sáhttá stivret mašiinnaid, nugo várvvi ja jurssana.
CPU Central Processing Unit
DNS Domain Name Server internetbálvalus mii jorgala domena-namaid IP-čujuhussan 
DVD Digital Versatile Disk vurkenmedium mii geavaha optalaš skearruid masa sáhttá vurket ollu eambbo go CD
FTP File Transfer Protocol interneahttadoaibma mii addá vejolašvuohta sirdit fiillaid dihtoras dihtorii
HTML Hypertext Markup Language dihtorgiella mas ráhkaduvvo máilbmefierpmádaga dokumeanttat.
HTTP Hypertext Transfer Protocl njuolgadusat mat geavahuvvo máilbmefierpmádaga sirdimii.
ISDN Integrated Services Digital Network telegulahallanstandard mainna sirdit jiena, govaid ja data digitála linjáid mielde. 
ISO International Organisation of Standardisation riikkaidgaskasaš standardiserenorganisašuvdna
LAN Local Area Network báikkálaš elektrovnnalaš jođasfierpmádat dieđuid sirdima várás
RAM Random Access Memory lohkan-čállin-muitu
ROM Read Only Memory lohkanmuitu
RS232 Serial interface maŋŋálaslákta, seriekopling
URL Uniform Ressource Location interneahta dokumeanttaid adresserenvuohki

Loahppa / The End
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